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Preface

Welcome to the Geneticist Assistant User’s Manual. The purpose of the Geneticist Assistant 
User’s Manual is to answer your questions and guide you through the procedures necessary 
to use Geneticist Assistant efficiently and effectively.

Using the manual
You will find the Geneticist Assistant User’s Manual easy to use. You can simply look up the 
topic that you need in the table of contents or the index. Later, in this Preface, you will find a 
brief discussion of each chapter to further assist you in locating the information that you 
need.

Special information about the manual
The Geneticist Assistant User’s Manual has a dual purpose design. It can be distributed 
electronically and then printed on an as-needed basis, or it can be viewed online in its fully 
interactive capacity. If you print the document, for best results, it is recommended that you 
print it on a duplex printer; however, single-sided printing will also work. If you view the 
document online, a standard set of bookmarks appears in a frame on the left side of the 
document window for navigation through the document. For better viewing, decrease the 
size of the bookmark frame and use the magnification box to increase the magnification of 
the document to your viewing preference.

If you do print the document using a single-sided printer, you might see a single 
blank page at the end of some chapters. This blank page has been added solely to 
ensure that the next chapter begins on an odd-numbered page. This blank page in 
no way indicates that your book is missing information.
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Conventions used in the manual
The Geneticist Assistant User’s Manual uses the following conventions:

• Information that can vary in a command—variable information—is indicated by 
alphanumeric characters enclosed in angle brackets; for example, <Gene ID>. Do not type 
the angle brackets when you specify the variable information.

• A new term, or term that must be emphasized for clarity of procedures, is italicized.

• Page numbering is “online friendly.” Pages are numbered from 1 to x, starting with the 
cover and ending on the last page of the index.

• This manual is intended for both print and online viewing.

• If information appears in blue, it is a hyperlink. Table of Contents and Index entries 
are also hyperlinks. Click the hyperlink to advance to the referenced information.

Assumptions for the manual
The Geneticist Assistant User’s Manual assumes that:

• You are familiar with windows-based applications and basic Windows functions and 
navigational elements.

• References to any third party standards or third party software functions were current as 
of the release of this version of Geneticist Assistant, and might have already changed. 

Organization of the manual
In addition to this Preface, the Geneticist Assistant User’s Manual contains the following 
chapters and appendices:

• Chapter 1, “Getting Started with Geneticist Assistant,” on page 13 details the installation 
requirements and installation procedure for Geneticist Assistant. It also explains how to 
open and log into Geneticist Assistant and it provides an overview of the major 
navigational elements on the main window for Geneticist Assistant, including the main 
menu, the toolbar, the tabs display area, and the status bar.

• Chapter 2, “Geneticist Assistant Setup and Maintenance,” on page 49 details the objects 
that are available in Geneticist Assistant and how you can add, edit, or delete values for 
these objects. It also details the various settings (reference directory, pathogenicity colors 
coverages, and so on) that you can specify for your Geneticist Assistant installation. It 

Although numbering begins on the cover page, this number is not visible on the 
cover page or front matter pages. Page numbers are visible beginning with the 
first page of the table of contents.
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also details how to use the Workflow Builder, which you can use to build models of the 
workflows that are used for your lab’s NGS analyses. Finally, it explains how to back up 
the Geneticist Assistant database.

• Chapter 3, “Geneticist Assistant User Management,” on page 81 details how to manage 
users and groups in Geneticist Assistant, including adding new users and groups, deleting 
users and groups, and managing the permissions for users and groups.

• Chapter 4, “Managing Panels and Subpanels,” on page 99 details the management of your 
Geneticist Assistant panels, which includes, adding, editing and deleting panels, and 
reviewing panel statistics, and adding, editing, and deleting subpanels.

• Chapter 5, “Managing Patients and Runs,” on page 121 details the management of  
patients. It also details how to add and carry out runs in Geneticist Assistantt.

• Chapter 6, “Geneticist Assistant Data Review - Runs Tab,” on page 177 details all the 
options that are available to you from the Runs tab for reviewing the data that is generated 
by a run.

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 203 details all the 
options that are available to you from the Run tab for reviewing the data that is generated 
by a run.

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 243 details all the 
options that are available to you from the Sample tab for reviewing the data that is 
generated by a run.

• Chapter 9, “Geneticist Assistant Data Review - Cases Tab,” on page 279 details the 
creation of a case, which is used to group and track related data, in your Geneticist 
Assistant database. It also explains the Cases tab, which displays a full record of each case 
that has been created in your Geneticist Assistant database.

• Chapter 10, “Geneticist Assistant Data Review - Variant Tab,” on page 291 details all the 
options that are available to you from the Variant tab for reviewing the data that is 
generated by a run.

• Chapter 11, “Geneticist Assistant Reports,” on page 313 details the generation of the six 
standard reports that are available in Geneticist Assistant. It also details how to generate 
a custom report, which includes only the data that you select. Finally, it details the custom 
report template which you can use not only to specify the data that Batch PDF or PDF 
reports are to contain, but also the layout of the reports.

• Chapter 12, “Geneticist Assistant Tools,” on page 333 details the various tools that are 
available in Geneticist Assistant to assist you with setting up, running, and analyzing 
sample data.

• Chapter 13, “The Geneticist Assistant Customer Portal and Submissions,” on page 351 
details the Geneticist Assistant customer portal, which is a web-based platform that serves 
as a dedicated hub for tracking and managing your organization’s patient and sample 
information and the tests that have been carried out for each patient/sample combination 
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(a submission). It also describes the Submissions tab, which displays a full record of every 
submission that any user has ever made through your organization’s secure access point 
to the Geneticist Assistant customer portal. 

• The Glossary on page 363 provides detailed definitions of specialized terms for Geneticist 
Assistant. 
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Chapter 1
Getting Started with Geneticist 
Assistant

Geneticist Assistant is a web-based tool for the control, visualization, interpretation, and 
creation of a historical knowledge base of next generation sequencing data. This data is used 
to identify potentially pathogenic variants that are associated with specific conditions such as 
hereditary colon cancer. This chapter details the installation recommendations for Geneticist 
Assistant and how to install Geneticist Assistant. It also explains how to launch Geneticist 
Assistant and provides an overview of the major navigational elements for the application, 
including the menu bar, the toolbar, and the main window tabs.

This chapter covers the following topics:

• “Geneticist Assistant System Recommendations” on page 15.

• “Installing the SoftGenetics License Server” on page 16.

• “Installing Geneticist Assistant on a Windows OS” on page 17.

• “Installing the Geneticist Assistant Database Server on a Linux OS” on page 19.

• “Starting and Logging in to Geneticist Assistant” on page 21.

• “Upgrading Geneticist Assistant” on page 27.

• “The Geneticist Assistant Main Window” on page 28.

• “Setting Display Preferences in the Geneticist Assistant Main Window” on page 31.

• “Searching the Geneticist Assistant Database” on page 44.

• “Updating References” on page 46.

• “Reviewing the Database Log” on page 48.
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Geneticist Assistant System Recommendations
You must have Administrator rights for the computer on which you are installing Geneticist 
Assistant.

Table 1-1: Geneticist Assistant Recommended Hardware Specifications

Client and/or Server

Operating System • Windows 7, 8, or 10 64 bit (Recommended)

• Windows Vista (64 bit)

• Windows Server 2008 (64 bit)

• Windows Server 2012 (64 bit)

Processors Two cores (64 bit)

RAM • 8 GB (Client)

• 4 GB (Server)

Minimum: 2 GB for client and server

Hard Drive • Solid State Drive

• 100 GB (Minimum)

Note: Virtual Machines are supported.

Table 1-2: Geneticist Assistant Data Specifications

Database Client

• 4 GB disk space (Minimum) • 50 GB space for reference and annotation data

• Starts at 15 MB and grows slowly • BAM files - Ca. the same size as raw FASTQ data

• Backup with mysqldump

• Low IOPS

Table 1-3: Geneticist Assistant Software Details

Server Client

• Apache 2.2 (Latest) • Qt 4.84

• mod_wsgi (Latest) • Bamtools 2.1.1

• OpenSSL (Latest) • Zlib 1.2.8

• MySQL 5.6 (Latest) • Qjson 2.1

• Python 2.7 (Latest) • OpenSSL 0.9.7

• Django 1.6 (Latest)

• South (Latest)

• Setuptools (Latest)

• MySQLdb (Latest)
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Installing the SoftGenetics License Server
Before you install Geneticist Assistant, if you have a purchased version of Geneticist 
Assistant, then you must install the SoftGenetics license server. The license server is a 
central location either locally or on a network where software application licenses are stored 
and can be accessed by users of the application. After you install and open Geneticist 
Assistant for the first time, you will be prompted to configure Geneticist Assistant to connect 
to the SoftGenetics license server so that you can use Geneticist Assistant. The executable to 
install the SoftGenetics license server is named SrvSetup_<>_exe and it is available from 
SoftGenetics’s ftp site. Contact SoftGenetics for assistance in obtaining this file. 

If you are running a trial version of Geneticist Assistant, then you do not need to 
set up the SoftGenetics license server. You can simply indicate that you are 
running a trial version after you log in to Geneticist Assistant.
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Installing Geneticist Assistant on a Windows OS
SoftGenetics provides a single standard executable file – Geneticist AssistantSetup< >.exe – 
for the installation of both the Geneticist Assistant client and the database server. You must 
have Administrator rights on the computer(s) on which you are installing Geneticist 
Assistant. You can install the client and the database server on the same computer or on 
different computers. When the installer first opens, Server is not selected and Client is 
selected. 

• If you are installing the client and database server on the same computer, then you must 
select Server before you click Install. 

• If you are installing the client and database server on different computers, then:

• When you run the installer on the computer on which you are installing the Geneticist 
Assistant client, you must leave the Server option cleared and the Client option 
selected. 

• When you run the installer on the computer on which you are installing the database 
server, you must select the Server option and clear the Client option.

Figure 1-1:  Geneticist Assistant Installation wizard, Client/Server options

When you install Geneticist Assistant, you are prompted to create the Administrator role for 
the installation. By default, the Username is set to Administrator, but you can always enter a 
different value. The password cannot contain any spaces. If you intend to implement 
additional password requirements, then the password must also adhere to these planned 
requirements. Figure 1-2 on page 18 shows the requirements that you can specify for user 
passwords after Geneticist Assistant is installed. (See “To specify the Geneticist Assistant 
password requirements” on page 66.)
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Figure 1-2:  User password requirement options

The email address is the address that is linked to the Administrator account.

Figure 1-3:  Administrator Setup dialog box

The Geneticist Assistant client is installed in C:\Program Files\Softgenetics\Geneticist 
Assistant and you cannot change this location. The Apache HTTP server is installed in the 
directory C:\Program Files (x86)\Apache2.2_forGA and you cannot change this location. 
The Python programming language is installed to a directory on your hard drive with the 
version number embedded. For example, version 2.7 of Python is installed in C:\Python27.

The Geneticist Assistant executable is configured to look for any available local 
port during installation; however, if an error message is displayed that the Apache 
service could not be started, you might have a conflict with an application that is 
already using the selected port such as Skype. Contact SoftGenetics for assistance.
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Installing the Geneticist Assistant Database 
Server on a Linux OS

To install Geneticist Assistant database server on a Linux OS, you must do the following:

• Create the Geneticist Assistant database.

• Set up the Geneticist Assistant database server.

• Create and migrate the initial database contents.

• Configure Apache2.

• Test the installation.

To create the Geneticist Assistant database
1. If it is not already installed, install OpenSSH.

2. Verify that python2.7 is installed.

3. Install the following components in the order indicated:

4. Create the database, and then replace the username and password with the password that 
you created during the mysql-server setup. 

     

You must still install the Geneticist Assistant client on a Windows OS. See 
“Installing Geneticist Assistant on a Windows OS” on page 17.

Component Installation

apache2 sudo apt-get install apache2

libapache2-mod-wsgi sudo apt-get install libapache2-mod-wsgi

mysql sudo apt-get install mysql-server mysql-client

pip sudo apt-get install python-pip

Django 1.6.11 sudo pip install Django==1.6.11

South sudo pip install south

python-mysqldb sudo apt-get install python-mysqldb

There is no space after -u and -p: 
mysql -u<username> -p<password> -e "create database softgenetics”
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To set up the Geneticist Assistant database server
1. Download the Geneticist Assistant database server.

2. Extract the Geneticist Assistant server.

3. Move the Geneticist Assistant server to the installation location: 
sudo mv ga_server_<version number> /opt/

4. Change the permissions:  
sudo chown -R www-data:www-data /opt/ga_server_<version number>/

5. Change the directory: cd /opt/ga_server_<version number>

6. Edit the settings: sudo vi ga/settings.py, and then in the DATABASES section, configure 
the mysql user and password that you created during the mysql-server setup.

To create and migrate the initial database contents
1. Create the initial database contents: python manage.pyc syncdb, and then configure the 

administrator username, password, and email address for Geneticist Assistant.

2. Migrate the database: python manage.pyc migrate

To configure Apache2
1. To set up the Install/Create keys: 

sudo openssl req -x509 -nodes -days 3650 -newkey rsa:2048 -keyout /etc/apache2/
server.key -out /etc/apache2/server.crt

2. Configure Apache2:

• sudo cp softgenetics.conf /etc/apache2/site-available/

• sudo a2ensite softgenetics.conf 

• sudo a2enmod ssl

• sudo service apache2 restart

To test the installation
Test the connection to the database server from a client with the following credentials:

• Server: https://<hostname>

• Username: <created during install>

• Password: <created during install>

Contact SoftGenetics for the most recent version.
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Starting and Logging in to Geneticist Assistant
After you install Geneticist Assistant, a shortcut icon for the application is placed on the 
desktop. An option for the application is also available from the Start menu. After Geneticist 
Assistant is installed and you open Geneticist Assistant for the first time, you must specify 
the URL for the database server.

Figure 1-4:  Geneticist Assistant desktop icon

1. Double-click the desktop icon to launch Geneticist Assistant, or select the option from 
the Start menu (Start > All Programs > SoftGenetics > Geneticist Assistant).

The Geneticist Assistant Login dialog box and a Geneticist Assistant Debug window 
open.

Figure 1-5:  Geneticist Assistant Login dialog box and Debug window

     

Before you log in to Geneticist Assistant, you can click Proxy Settings to open the 
Proxy Settings tab on the Settings dialog box. If your organization uses a proxy 
server for external connections, then to view data from the external databases 
OMIM or LOVD in Geneticist Assistant, you must configure the settings for the 
proxy server on this tab. See “To configure proxy server settings” on page 57.
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2. If this is the first time that you are logging in to Geneticist Assistant, then do the 
following; otherwise, go to Step 4.

• In the Server field, enter the URL for the Geneticist Assistant database server:

• In the Username field, enter your username, and then in the Password field, enter 
your password, and then click OK.

3. Continue to one of the following:

• If you are running a trial version of Geneticist Assistant, continue to “To run a trial 
version of Geneticist Assistant” on page 23.

• If you are running a purchased version of Geneticist Assistant, continue to “To run a 
purchased version of Geneticist Assistant” on page 24.

4. If needed, in the Username field, enter your username, and then in the Password field, 
enter your password, and then click OK. One of the following happens:

• If your login is successful, then the Geneticist Assistant Login dialog box closes, 
“Success” is displayed in the Debug window, and the Geneticist Assistant main 
window opens. The Debug window remains open.

• If your login is not successful, then the reason for the failure is displayed in the 
Debug window. If you are unable to resolve the login issues based on the messages 
in the Debug window, contact SoftGenetics for assistance. 

     

Installation Type Description

Local The database server is installed on the local computer. The URL for this is 
https://localhost.

Intranet The database server is installed on a different computer that is on your 
network. The URL must include the computer name or IP address.

Internet The database server is installed on a computer that has Internet access. 
The computer can be outside your local network. The URL must include 
the computer name or IP address.

Note: Geneticist Assistant uses SSL encryption to ensure the security of 
the data over the Internet.

For subsequent Geneticist Assistant sessions, the Username field is automatically 
populated with the username for the user who last logged in, and the Server field 
is automatically populated with the URL for the database server.

The Debug window displays the results after each step that you carry out in 
Geneticist Assistant. You must leave this window open for the duration of your 
session. If you close it, then you also close Geneticist Assistant.
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5. Continue to one of the following:

• If you are running a trial version of Geneticist Assistant, continue to “To run a trial 
version of Geneticist Assistant” below.

• If you are running a purchased version of Geneticist Assistant, continue to “To run a 
purchased version of Geneticist Assistant” on page 24.

To run a trial version of Geneticist Assistant
After you log into Geneticist Assistant, if you are running a trial version of Geneticist 
Assistant, then a Configure License message always opens.

Figure 1-6:  Configure License message

1. Click Run Trial.

The Configure License message closes. Two results are possible.

• If this is the first time that you are running the trial version, then a Reference 
Directory Not Found message opens. You must configure your reference directory 
before you can use the software. Continue to Step 2.

Figure 1-7:  Reference Directory Not Found message

• If this is not the first time that you are running the trial version, and the reference 
directory has already been configured, then the Geneticist Assistant main window 
opens. Continue to “The Geneticist Assistant Main Window” on page 28.

2. Do one of the following:

• To configure the reference directory now, click Configure Now to open the Settings 
dialog box, and then continue to “To configure the reference directory” on page 26.

• To configure the reference directory at a later date, click Skip Now.

The Reference Directory Not Found message closes and the Geneticist Assistant 
main window opens. Continue to “The Geneticist Assistant Main Window” on page 
28.

For detailed information about configuring the required reference directory at a 
later date, see “Specifying your Geneticist Assistant Settings” on page 55.
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To run a purchased version of Geneticist Assistant
If you are running a purchased version of Geneticist Assistant, then the first time that you run 
Geneticist Assistant, a Configure License message opens. You must configure Geneticist 
Assistant to connect to the SoftGenetics license server. After you configure the license 
server, this message does not open again.

Figure 1-8:  Configure License message

1. Click Configure Now.

The Settings dialog box opens. The License Settings tab is the only tab on the dialog 
box.

Figure 1-9:  Settings dialog box

2. In the server name, enter the fully qualified domain name (FQDN) for the server (where 
the license server manager is installed), or its IP address.

3. Leave the Port value set to the default value of 50000.

     

If the SoftGenetics license server is running on the same computer on which 
Geneticist Assistant is running, then you must enter 127.0.0.1. 
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4. Click OK.

The Settings dialog box closes, and a Reference Directory Not Found message opens. 
You must configure your reference directory before you can use the software. 

Figure 1-10:  Reference Directory Not Found message

5. Do one of the following:

• To configure the reference directory now, click Configure Now to open the Settings 
dialog box, and then continue to “To configure the reference directory” on page 26.

Figure 1-11:  Settings dialog box, General tab

• To configure the reference directory at a later date, click Skip Now.

The Reference Directory Not Found message closes and the Geneticist Assistant 
main window opens. Continue to “The Geneticist Assistant Main Window” on page 
28.

     

For detailed information about configuring the required reference directory at a 
later date, see “Specifying your Geneticist Assistant Settings” on page 55.
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To configure the reference directory

Before you run Geneticist Assistant for the first time, you must configure the reference 
directory. The reference directory contains the information for the reference that was used 
for aligning the data and/or detecting variants. References files are stored in their own 
folders in this directory. For example, if you are studying variants that are associated with the 
human genome, then you might create a Human folder in the Reference directory, such as 
C:\References\Human 37. 

1. Create your reference directory in a location that meets your business needs.

2. Click the Browse button  next to the Reference Directory field, and then browse to 

and select the Reference directory.

3. Click OK to close the Settings dialog box and return to the Geneticist Assistant main 
window.

4. Continue to “The Geneticist Assistant Main Window” on page 28.

To log out of Geneticist Assistant
To log out of Geneticist Assistant, on the main menu, click File > Exit.

After you specify the location for the reference directory, and submit data to the 
Geneticist Assistant database, you cannot change its location.

Although not required, SoftGenetics recommends that you create this directory on 
the same computer and drive on which you installed the Geneticist Assistant 
client.

The Debug window displays the results after each step that you carry out in 
Geneticist Assistant. You must leave this window open for the duration of your 
session. If you close it, then you also close Geneticist Assistant.
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Upgrading Geneticist Assistant
If you are upgrading to a newer version of Geneticist Assistant, then you do not need to 
uninstall the current version. After you have completed the upgrade, and then log in to 
Geneticist Assistant for the first time, an Uncompressed References Detected message 
opens, indicating that Geneticist Assistant first needs to compress all the associated reference 
files before you can work in Geneticist Assistant.

Figure 1-12:  Uncompressed References Detected message dialog box

1. Click Compress.

A dialog box opens, indicating the progress in compressing the reference files.

Figure 1-13:  Compressing reference files progress dialog box

2. After the Compression Progress dialog box indicates that the compression is 100% 
complete, click OK.

The Compression dialog box closes, and Geneticist Assistant is now ready for use.

This process can take anywhere from one to four hours based on your system’s 
available resources, and Geneticist Assistant is unavailable during this time. 
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The Geneticist Assistant Main Window
The Geneticist Assistant main window opens automatically after you successfully log in to 
Geneticist Assistant. 

Figure 1-14:  Geneticist Assistant main window

The Geneticist Assistant main window is your starting point for Geneticist Assistant. The 
window provides quick access to all of the Geneticist Assistant functions. From top to 
bottom, the Geneticist Assistant main window has five major components—the title bar, the 
main menu, the toolbar, the tabs display area, and the status bar.

Title bar
The name “Geneticist Assistant” is displayed in the title bar at the top of the Geneticist 
Assistant main window.

Figure 1-15:  Geneticist Assistant title bar

Main menu
The main menu is set up in a standard Windows menu format with menu commands grouped 
into menus (File, Panels, Tabs, Reports, Filters, Tools, Backup, and Help) across the menu 
bar. 

Figure 1-16:  Geneticist Assistant main menu
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Toolbar
The Geneticist Assistant main window toolbar is located below the main menu. It always 
contains a Refresh option, a Search feature, and Ref option. If the Runs tab or the Patients tab 
is open, it also contains options for limiting the display on the tab.

• You use the Refresh option to manually refresh a tab display after the tab opens in the 
main window and data is loaded, or after adding, editing, and/or deleting data on a tab. 
See “Main window tabs” below.

• You use the Search feature to search for samples, runs, panels, panel groups, sample 
groups, genes, or variants in your Geneticist Assistant database. See “Searching the 
Geneticist Assistant Database” on page 44.

• You use the Ref option to update any reference that has been downloaded to the Geneticist 
Assistant database to the most current version. See “Updating References” on page 46.

Figure 1-17:  Geneticist Assistant main window toolbar 

Figure 1-18:  Geneticist Assistant main window toolbar for the Runs tab

Main window tabs
When the Geneticist Assistant main window first opens, two tabs— Runs and Current 
Jobs—are displayed in the window. The Runs tab is the open tab. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants. The Runs tab has a single pane—the Runs pane. 

Figure 1-19:  Geneticist Assistant main window, Runs tab with Runs pane
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• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. You can limit the runs that are displayed by number and/or by a time and date range 
and you can also change the sort order of the data. 

• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. You 
can limit the runs that are displayed by number and/or by a time and date range and you 
can also change the sort order of the data. 

The Current Jobs tab displays the progress of a run, or any other process that is currently 
being carried out in Geneticist Assistant. The tab opens automatically after a run is started. 
After the run is successfully completed (a BAM and a VCF file are loaded and read, or a 
VCF file is loaded and read), the Current Jobs tab is cleared and remains blank. Other tabs 
are available in the display area of the Geneticist Assistant main window depending on the 
actions that you carry out.

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab display and 
the data column display. See “Setting Display Preferences in the Geneticist Assistant Main 
Window.”

Status bar
The Status bar is displayed at the bottom of the Geneticist Assistant main window. Summary 
information that is tab-specific is displayed in the left corner of the status bar. Release 
information (Version, Release Build, Revision, and Build Date) is displayed in the right 
corner of the status bar. This release information is identical to the release information that is 
displayed from the Help > About menu option.

Figure 1-20:  Geneticist Assistant main window, Status bar

If you close the Runs tab, you can open it again from the Geneticist Assistant main 
menu: File > Runs.
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Setting Display Preferences in the Geneticist 
Assistant Main Window

With the exception of the Current Jobs tab, every tab in Geneticist Assistant has at least one 
pane. The different panes display different information. Data is displayed in columns in the 
tab panes. A variety of options are available for setting preferences for the tab and tab pane 
displays and the data column display. You can:

• Navigate multiple open tabs/minimized window. See “To navigate multiple open tabs/
Navigate tabs with a minimized main window” below.

• Close multiple tabs in a single step. See “To close multiple tabs in a single step” on page 
32.

• Filter the data that is displayed in a tab pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

• Show/hide data columns in a tab pane. See “To show/hide columns in a tab pane” on page 
37.

• Manage tab pane configurations. See “To manage tab pane configurations” on page 39.

• Change the widths of a data columns. See “To change the widths of data columns” on 
page 42.

• Rearrange the order of data columns. See “To rearrange the order of data columns” on 
page 42.

• Change the sort order of data. See “To change the sort order of data” on page 42.

• Rename column headers. See “To rename column headers” on page 42.

• Select the data that is to be included in a custom report. See “To select data to be included 
in a custom report” on page 43.

Any preferences that you set for a tab display remain in effect regardless if you log out of and 
then log back into Geneticist Assistant. You can set the preferences for any Variants pane or 
tab, for example, the Sample Variant Data sub-tab on the Sample tab, and then apply these 
same settings to all the other Variants panes and tabs in Geneticist Assistant. You can also 
return the tab displays to their default displays (all tab panes shown, all data columns shown, 
and so on) in a single step. See “To apply shared preferences or to clear all tab preferences” 
on page 63.

To navigate multiple open tabs/Navigate tabs with a minimized 
main window

If you open multiple tabs, or if you have reduced the size of the main window, then you 
might not be able to see all the tabs at the top of the main window. The display options at the 
top of the Runs tab or the Patients tab might also be hidden. You can use the Back and Next 
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arrows  that are displayed in the top right corner of the main window to move through 
all open tabs and change the display focus, and/or view the hidden display options. 

To close multiple tabs in a single step
If you have opened multiple tabs, then you close each tab individually, or you can close all 
tabs in a single step, or you can close all tabs other than a selected tab in a single step. To 
close all tabs in a single step, right-click the title bar for any of the opened tabs, and on the 
context menu that opens, click Close All. To close all tabs other than a selected tab,  
right-click the title bar of the tab that is to remain open, and on the context menu that opens, 
click Close All Except This.

To filter the data that is displayed in a tab pane
By default, when a tab first opens, all data in all available panes is displayed. You can open a 
Table Filters pane for a selected tab pane which displays all the data (fields) for the pane, and 
then select from the fields that are listed to filter the pane display to only the data (fields) that 
meet specific criteria. You can specify the filters for the data that is displayed in a tab pane on 
a one time only basis, or you can save the filters to a template, and then load the template to 
filter the data that is displayed in the tab pane anytime as needed. You can also delete a saved 
filter template.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Table Filters pane opens to the right of the tab. The pane is docked to the right side 
of the Geneticist Assistant main window. The pane consists of two sub-panes. The left 
sub-pane displays all the fields for the selected tab pane. The right sub-pane is blank.

3. Repeat Step 2 as many times as needed to open multiple Table Filters panes for the tab.

Figure 1-21:  Multiple Table Filters panes opened for a tab
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4. Click and drag the field by which to filter the data from the list of available fields to the 
blank pane that is to the right of the list. 

An Edit Filter dialog box opens. The name of the selected field is displayed in the 
Column Name field on the dialog box.

Figure 1-22:  Edit Filter dialog box

5. On the Operator dropdown list, select the operator for the filter.

The Table Filters panes are docked from top to bottom in the order in which you 
opened them. Optionally, to make a Table Filters pane a floating pane, you can 
click the Undock icon in the top right corner of the pane (the icon to the left of the 
Close (x) icon), and then drag the pane. A floating pane is a pane that is visible in 
the Geneticist Assistant main window, but its location is not confined to a specific 
area of the window. Instead, you can independently change its size and/or 
position, including moving the pane outside the main window.To redock the Table 
Filters pane, click the Close (x) icon to close the pane, and then on the Geneticist 
Assistant main menu, click Filters and select the tab pane again.

The remainder of this procedure describes how to set up new a data filter. 
Optionally, below a Table Filters pane, you can click Load Filters to open the 
Load Filter Template dialog box and select from a list of saved filter templates for 
the pane. 

The Column Name is a dropdown list that contains all the available fields for the 
opened tab. You can always select a different field on this list before continuing to 
Step 5.

If you are filtering data based on a date/time field, then for additional information, 
see “To filter data based on a date/time field” on page 36.

The operators that are available on the Operator dropdown list are specific to the 
type of field that is selected - text, numeric, and so on. Not all operators are 
available for all field types. 

Filter Operator Description

= Equals. Must be an exact match to return data. 
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6. Do one of the following:

• In the Value field, enter the filter value or values. Use a comma to separate multiple 
values.

• Click Load Values to open the Open Text or CSV file dialog box, and then browse to 
and select the appropriate file.

7. Click OK.

The Edit Filter dialog box closes. The selected field, its operator, and its value are 
displayed in the right sub-pane. The filter is applied immediately to the pane.

     

≠ Does not equal. Only data that does not match the value specified is returned.

> Greater than. Only data that exceeds the value specified is returned.

< Less than. Only data that is less than the value specified is returned.

>= Greater than or equal to. Only data that is an exact match for or exceeds the 
value specified is returned.

<= Less than or equals to. Only data that is an exact match for or is less than the 
value specified is returned.

contains Returns data that not only contains the value specified, but also might contain 
other information. The search string is not case-sensitive.

does not contain Returns only the data that does not contain the value specified. The search 
string is not case-sensitive.

On Only data with a date stamp that is the same as the specified date is returned. 
Identical to the = operator, but used specifically for dates.

Earlier than Only data with a date stamp that falls before the specified date is returned. 
Identical to the < operator, but used specifically for dates.

Earlier than or on Only data with a date stamp that is the same as the specified date or that falls 
before the specified date is returned. Identical to the <= operator, but used 
specifically for dates.

Later than Only data with a date stamp that falls after the specified date is returned. 
Identical to the > operator, but used specifically for dates.

Later than or on Only data with a date stamp that is the same as the specified date or that falls 
after the specified date is returned. Identical to the >= operator, but used 
specifically for dates.

A text file contains a single value. A Comma-Separated Values (CSV) file contains 
multiple values that are separated by commas.

Filter Operator Description
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8. Repeat Step 4 through Step 7 for each field by which the data is to be filtered. When you 
filter the data by multiple fields, two options are possible:

• You can drag additional fields for filtering on top of an existing filter field to apply 
the filters on an “and” basis. For example, for the Sample Variant Data sub-tab on 
the Sample tab, you can add the filter for Coverage >= 300 and then drag the filter 
for Gene = MSH6 onto the Coverage filter. The results are filtered to show only 
those variants that have a coverage that is greater than or equal to 300 and that are 
found in the MSH6 gene. 

• You can drag separate additional fields for filtering into the blank pane to apply 
filters on an “or” basis. For example, for the Sample Variant Data sub-tab on the 
Sample tab, you can add filters for Coverage >= 300 and a filter for Gene = MSH6. 
The results are filtered to show those variants that have a coverage that is greater 
than or equal to 300 or variants that are found in the MSH6 gene.

Figure 1-23:  And and Or filters

9. Do any of the following as needed for a specific Table Filter:

• To highlight the results in bright yellow that pass the filtering criteria instead of 
removing data that fails the filtering criteria, select Highlight.

• The On/Off option is a toggle. 

• Click On/Off to remove the applied filters.

• Click On/Off again to apply all the filters and view the results onscreen. 
(“*Filters Applied” is displayed in the title bar of the affected tab pane.) 

     

If the results are not as expected, then this toggling allows you to make the 
necessary adjustments to a filter before saving it.

And filter

Or filter
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• Click Clear to remove all the filters that have been applied for the tab pane. The 
filters remain displayed in the Table Filters pane.

• Right-click any filter, and on the context menu that opens, click Edit to open the Edit 
Filter dialog box. Edit the filter (Column, Operator, and/or Value) as needed, and 
then click OK to close the dialog box and immediately save and apply the edited 
filter.

• Right-click any filter, and on the context menu that opens, click Remove to delete 
the filter. The pane display is immediately updated.

• Click Save Filters to open the Save Filter Template dialog box and save your filter 
settings. You can use this saved Filter Settings template to filter the data for this 
specific tab pane for another project based on the settings in the template. 

10. After you are done filtering the data, you can click Close (x) in the upper right corner of 
a Table Filter pane to close it.

To filter data based on a date/time field

If you are filtering data based on a date/time field, then an additional option, Relative, is 
displayed on the Edit Filter dialog box. You select this option to display data from a specified 
time period that is relative to the current date and time. For example, to display data that has 
been generated within the last 30 days of the current date and time, select the < operator, 
select Relative and then in the Relative field, enter -30 days. (You must enter the minus sign.)

Figure 1-24:  Edit Filter dialog box for a date/time field

     

To clear all filters for all tabs in a single step, on the Geneticist Assistant main 
menu, click Filters > Clear All Filters.
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To delete a saved filter template

You can delete filter templates that have been saved by any user for any tab pane.

1. Open the appropriate tab.

2. On the Geneticist Assistant main menu, click Filters > <Tab Pane>. For example, if you 
clicked Filters pane with the Sample tab open, then the menu options would be Filters > 
Sample’s Variants, Filters > Sample’s Status Changes, and so on. 

The Table Filters pane opens to the right of the tab. See Figure 1-21 on page 32.

3. Click Load Filters.

The Load Filter Template dialog box opens. The dialog box displays all the filter 
templates that have been saved by all users for the selected tab pane. 

Figure 1-25:  Load Filter Template dialog box

4. Select the filter template that you are deleting, and then click Delete.

The filter is deleted immediately. The Load Filter Template dialog box remains open.

To show/hide columns in a tab pane
You specify which columns to show and which to hide in a tab pane in the Select Columns 
dialog box. By default, when the dialog box first opens for a tab pane, the columns that are 
currently displayed are selected, and Select/deselect/restore all is either selected or 
completely filled. The Select/deselect/restore all option on the Select Columns dialog box is 
a tri-state checkbox. When the dialog box is opened for the first time for a tab pane, all the 
columns are selected for display, and the Select/deselect/restore option is also selected. After 
you make your column selections, then each subsequent time that the dialog box opens, the 
columns that have been selected for display are selected, those that have been hidden are 
deselected, and the Select/deselect/restore option is completely filled. If you click this option 
once, then all columns are added for the view in the tab pane in a single step and the select/
deselect/restore option is selected. If you click the Select/deselect/restore option a second 
time, then all data columns are hidden from view in the pane in a single step, and the option 
is cleared. If you click the Select/deselect/restore option a third time, then the last specified 
settings are restored, and a completely filled checkbox is displayed for the option.
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1. Right-click the tab pane anywhere, and on the context menu that opens, click Load 
Columns.

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Click Manually.

The Select Columns dialog box opens. 

Figure 1-26:  Select Columns dialog box

3. Clear the options for the columns that are to be hidden from view in the pane, and leave 
the options for the columns that are to be shown selected.

4. Optionally, to rearrange the column display, click the column number for a column, and 
then drag it to a new location in the list of columns.

5. Click Apply to update the column display.

6. Click OK to close the dialog box.

The column preferences remain in effect even if you log out of and then log back into 
Geneticist Assistant. To restore the last specified settings, or display all columns in a 
single step, click the Select/deselect/restore all option as needed.

     

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

This is identical to rearranging the data columns directly in a tab pane. See “To 
rearrange the order of data columns” on page 42.
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To manage tab pane configurations
Instead of selecting individual columns to show or hide, you can use pane configurations to 
manage your data column displays. You can load an existing pane configuration, you can 
create your own pane configurations, and you can delete pane configurations. See:

• “To load a pane configuration” below.

• “To create/edit a pane configuration” below.

• “To delete a pane configuration” on page 41.

To load a pane configuration

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Select the configuration that you are loading.

The context menu closes. The pane display is updated dynamically after the 
configuration is loaded.

To create/edit a pane configuration

When you create and save a configuration for a tab pane, the configuration is available and 
applicable only for this specific tab pane. You can edit only the configurations that you have 
created.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

     

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.

Compact displays the data columns in the pane in a more condensed view. To 
toggle the display, click Compact as needed.
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2. Do one of the following:

3. Clear the options for the columns that are to be hidden from view in the pane, and select 
the options for the columns that are to be displayed. 

4. Click Apply to update the column display.

5. Click Save Configuration. 

The Save Configuration dialog box opens.

Figure 1-28:  Save Configuration dialog box

Option Description

To create an entirely new 
pane configuration

1. Click Manually.

The Select Columns dialog box opens. By default, when the dialog 
box first opens for a tab pane, the columns that are currently 
displayed are selected, and Select/deselect/restore is either selected 
or completely filled. See Figure 1-26 on page 38.

2. Continue to Step 3.

To create a new pane 
configuration by editing 
an existing configuration

1. Click Manually.

The Select Columns dialog box opens. See Figure 1-26 on page 38.

2. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all 
your private and public configurations as well as all the 
configurations that other users have made public.

Figure 1-27:  Load Configuration dialog box

3. Select the configuration that is to be modified.

The pane display is dynamically updated according to the loaded 
configuration

4. Right-click the tab pane anywhere, and on the context menu that 
opens, click Load Columns > Manually.

The Select Columns dialog box opens again. The settings on the 
dialog box reflect the loaded configuration. 

5. Continue to Step 3.
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6. Enter a name for the configuration.

7. If this configuration is to be available to all other users of this Geneticist Assistant 
instance (a public configuration), then select Make configuration available to all users; 
otherwise, to make the configuration available only to you (a private configuration), 
leave this option blank.

8. Click Save.

The Save Configuration dialog box closes. The Select Columns dialog box remains 
open.

9. Click OK to close the Select Columns dialog box.

To delete a pane configuration

You can delete only those pane configurations that you have created.

1. Right-click the tab pane anywhere, including the column headers, and on the context 
menu that opens, click Load Columns. 

A sub-menu opens that displays up to three options: Manually, Compact, and all the 
available configurations for the pane. The name of the user who created each 
configuration displayed next to the configuration.

2. Click Manually.

The Select Columns dialog box opens. See Figure 1-26 on page 38.

3. Click Load Configuration.

The Load Configuration dialog box. The dialog box displays all your private and public 
configurations as well as all the configurations that other users have made public. 

Figure 1-29:  Load Configuration dialog box

     

If you are editing a configuration, then you must save it with exactly the same 
name as the original configuration. 
Geneticist Assistant User’s Manual 41



Chapter 1
Getting Started with Geneticist Assistant
4. Right-click the configuration that you are deleting, and on the context menu that opens, 
click Delete Column Configuration.

The Column Configuration is deleted.

5. Click Close (x) to close the Load Configuration dialog box.

6. Click OK to close the Select Columns dialog box.

To change the widths of data columns
To change the width of a data column, rest the mouse pointer on the right side of a column 
heading until the pointer changes to a double-headed arrow, and then drag the boundary until 
the column is the width that you want.

To rearrange the order of data columns
You can rearrange the order of the data columns in a tab pane by clicking and holding the 
mouse pointer on a column header, and then dragging the column to a new location.

To change the sort order of data
When a tab first opens, data is sorted in ascending order based on the IDs of the data. To 
change the sort order of the data in a column, click a column header to sort the display based 
on the descending order of data in the column. A Sort Order icon is displayed in the column 
header. You can click this Sort Order icon to toggle between an ascending sort and a 
descending sort of the data based on the column heading.

To rename column headers
Every data column is titled with a default column header. To rename a column header to 
better suit your working needs, right-click the column header, and on the context menu that 
opens, click Rename Header. The column header is selected, and you can then edit the 
column header as needed.

     

If you select a configuration that you did not create, then the Delete Column 
Configuration option is not available on the context menu.

You can also rearrange the order of data columns in a tab pane using the function 
that is available in the Select Columns dialog box. See “To show/hide columns in a 
tab pane” on page 37.
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To select data to be included in a custom report
You can include just specific data in a custom report, or you can include all data in a pane in 
a custom report.

• To include just specific data, right-click the data (CTRL-click to select multiple rows of 
data), and on the context menu that opens, select Add Selected to Custom Report. All data 
in all columns that are currently shown in the selected rows is included in the custom 
report. Data in hidden columns is not included in the report.

• To include all data that is currently shown in a tab pane in a custom report, right-click 
anywhere in the pane and on the context menu that opens, click Add All to Custom 
Report. All data in all columns that are currently shown in the tab pane is included in the 
custom report. Data in hidden columns is not included in the report.

For detailed information about generating a custom report after you have selected 
the necessary data, see “Generating a Custom Report” on page 319.
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Searching the Geneticist Assistant Database
You use the Search feature that is available on the Geneticist Assistant main window toolbar 
to search for samples, runs, panels, panel groups, sample groups, genes, and variants in your 
Geneticist Assistant database. 

Figure 1-30:  Geneticist Assistant main window toolbar

Important points to note about a search are the following:

• As you enter a search string, the list of search results that match the string is dynamically 
updated, and the type of search result that matches the string is indicated in bold above 
the list (Run, Variant, and so on). 

• The search for any item is not case-sensitive, and the search string can be found anywhere 
in the search results. For example, if you enter “Mayo” as the search string, then the 
search results can include a run named “Mayo Clinic” or a run named “Clinic Run:Mayo.”

• If you search for a variant, the search is not carried out relative to any sample, and 
multiple search options are available. 

• You can use the variant description in the format of chrom:start position:ref:alt. You 
must separate multiple variant search strings with a comma (,) or a semi-colon (;). 

• You can search for a single position on a single chromosome (for example, 1:123) or 
for a range of positions on a single chromosome (for example, 1:1-1000).

• You can search by the partial or complete gene name; for example, MSH or MSH2, 
respectively. 

Search results for any entity in your Geneticist Assistant database are displayed on a Search 
Results tab. 

Figure 1-31:  Search feature and results example
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You can double-click any search result on a Search Results tab to “drill down” into the 
search result, and review the associated data. For example, you can:

• Double-click a Run search result to open the associated Run tab.

• Double-click a Gene search result to open the list of variants for the gene, and then 
double-click a variant in this list to open the associated Variant tab. 

You can also right-click any search result to open a context menu that has options that are 
specific for the search result.
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Updating References 
The reference directory contains the information for the reference that was used for aligning 
the data and/or detecting variants in sample. References are stored in their own folders in the 
reference directory. SoftGenetics initially provides the necessary references files for your 
Geneticist Assistant installation. You use the Ref function that is available on the toolbar of 
the Geneticist Assistant main window to update to the most recent version of any reference 
in the reference directory. You can select multiple references for updating at the same time. 

To update a reference
1. On the toolbar of the Geneticist Assistant main window, click Ref.

The Reference Downloader dialog box opens. The dialog box lists the following 
information for each reference that is currently installed for your Geneticist Assistant 
instance:

• The reference name.

• The Local Version, which is the version of the currently installed reference.

• The Remote Version, which is the most recent version that is available on the 
SoftGenetics server.

• The Update Size, which is the difference in size between the Local Version and the 
Remote Version.

• The Total Size of the downloaded reference.

The location of the Reference Directory that has been specified for your Geneticist 
Assistant instance is displayed at the top of the dialog box. A checkbox is displayed next 
to each reference for which the Local Version and Remote Versions are different. 

Figure 1-32:  Reference Downloader dialog box

The Ref option prevents you from having to log in to SoftGenetics’s ftp site and 
individually selecting each reference that is to be updated.
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2. Select the references that are to be updated, and then click Update.

After the selected references are updated, the Local Version and the Remote Version are 
identical.

Be patient. Depending on the update size, the update process can take up to 
several hours.
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Reviewing the Database Log
Geneticist Assistant tracks all actions that have occurred for its database, such as user logins, 
data additions, data edits, data deletions, and so on, in a database log. This database log is 
displayed on the Database Log tab. The log shows all the actions that have occurred in the 
Geneticist Assistant in reverse chronological order. For each action, the following 
information is displayed: the date/time of the database action, the user who carried out the 
action, the type of action, and the data type that was affected by the action. A detailed 
description of the action is also supplied. To review the database log, on the Geneticist 
Assistant main menu, click File > Database Log. 

Figure 1-33:  Database Log tab
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Before you use Geneticist Assistant for the first time, you must add and/or edit the necessary 
objects and specify the settings for your installation. Optionally, you can also create models 
for the workflows that are used for your lab’s NGS analyses. For data protection, you can 
manually back up the Geneticist Assistant database at any time of your choosing.

This chapter covers the following topics:

• “Managing Objects in the Geneticist Assistant” on page 51.

• “Specifying your Geneticist Assistant Settings” on page 55.

• “Creating Workflow Models” on page 71.

• “Backing up the Geneticist Assistant Database” on page 79.
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Managing Objects in the Geneticist Assistant
An object in Geneticist Assistant holds a value or variable that can be applied for carrying 
out a run in Geneticist Assistant, or for processing and interpreting the resulting run data. 
Managing objects in Geneticist Assistant consists of adding and editing the values for these 
objects as well as deleting values that are no longer valid or required. Thirteen objects are 
available in Geneticist Assistant: Chemistry, Instrument, Pathogenicity, Pathogenicity Status, 
Sample Status, Panel Group, Coverage Region Status, Sample Status, Run Status, Artifact 
Type, Phenotype, Ethnicity, and Case Priority. Geneticist Assistant is installed with default 
values for seven of these objects: Pathogenicity, Pathogenicity Status, Sample Status, 
Coverage Region Status, Run Status, and Artifact. You have the option of adding custom 
values for these objects, and then selecting a custom value in lieu of a default value. You 
must manually add values for all other objects.

Object Description

Chemistry Refers to the chemistry that was used to prepare the samples for 
sequencing. 

Instrument Refers to the instrument that was used to sequence the samples.

Pathogenicity The pathogenicity for a selected variant. Default values are Deleterious, 
Likely Deleterious, Unknown, Likely Benign, and Benign.

Pathogenicity Status Indicates the status for changing the pathogenicity for a selected 
variant. Default values are Pending and Confirmed.

Sample Status The status for a sample. Default values are New, QC Passed, 
Reviewed, and Complete.

Panel Group Separately tracks the pathogenicities of variants that might be found in 
multiple panels. For example, the pathogenicity of a selected variant is 
set to Deleterious for multiple cancer panels; however, the pathogenicity 
can be set to Benign for a cardiac panel. You can create a group for 
each panel, and then assign the appropriate panels to each group.

Coverage Region 
Status

The Coverage Regions tab (via the Run tab) lists the coverage 
information for every region in your panel as well as a status for each 
region. Default values are Passed or Failed to indicate whether a region 
passed or failed the coverage settings that were set for the run. 

Note: See “Coverage Regions tab” on page 217.

Sample Group Used for a group of samples that are to be processed repeatedly over a 
period of time, for example, a group of control samples for which the 
coverage or variant frequency is to be tracked. 

Run Status The status for a run. Default values are New, QC Passed, Reviewed, 
and Complete.

Artifact The artifact type for the sample variant, for example, a Sequencing 
artifact. A single default value, None, is supplied for artifact type. 

Phenotype The phenotype for a patient.

Ethnicity The ethnicity for a run patient, for example, Caucasian (Non-Hispanic).

Case Priority The priority such as Urgent or Normal for a case. 
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To add a value for an object
1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. 

Figure 2-1:  Add/Edit Objects dialog box

2. On the Object dropdown list, select the object for which you are adding a value.

If the selected object has default values, or custom values have already been added for 
the selected object, then these values are displayed in the Current Values pane.

3. In the Value field, enter the value for the object, and then click Add.

The newly added value is displayed in the Current Values pane.

4. If you did not add a new pathogenicity value, then go to Step 5; otherwise, if you added 
a new pathogenicity value, then to correctly order the pathogenicity values from least 
severe to most severe, select a value in the Current Values pane, and then click Move Up 
or Move Down as needed. 

     

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.

If you add a value for pathogenicity, then you can also specify a highlighting color 
for variants of this type in all the variant panes and sub-tabs. If you add a value 
for case priority, then you can also specify a highlighting color for this value. See 
“To specify the highlighting colors for variants of a pathogenicity and/or case 
priorities” on page 61.
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5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is added successfully.

To edit an object
When you edit an object, you edit the object value. Any previous runs that use the edited 
object value are not affected. The “old” (previous) value remains displayed in Geneticist 
Assistant on the Runs tab. Going forward, only the “new” value is available for selection for 
new runs. 

1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 52.

2. On the Object dropdown list, select the object for which you are editing a value.

The currently available values for the selected object are displayed in the Current Values 
pane.

3. In the Current Values pane, double-click the object value that you are editing.

The value is highlighted in a blue rectangle.

4. Edit the value as needed.

5. Click OK.

The message “Saving new objects” is displayed on the Add/Edit Objects dialog box. The 
dialog box closes after the value is edited successfully.

To delete a value from an object

1. On the Geneticist Assistant main menu, click File > Add/Edit Objects.

The Add/Edit Objects dialog box opens. See Figure 2-1 on page 52.

2. On the Object dropdown list, select the object from which you are deleting values.

The currently available values for the selected object are displayed in the Current Values 
pane.

     

The value can have a maximum of 255 characters. Spaces and special characters 
are allowed.

If you delete a value for an object that has been previously used in a run, then the 
run is also deleted in its entirety from the Geneticist Assistant database. Be very 
sure that you want to delete a value from an object before doing so.
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3. In the Current Objects pane, click the object value that you are deleting, and then click 
Remove Selected.

The value is deleted immediately. The Add/Edit Objects dialog box remains open.

4. Click OK.

The Add/Edit Objects dialog box closes.
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Specifying your Geneticist Assistant Settings
When specifying the settings for your Geneticist Assistant installation, if you did not 
configure the reference directory the first time that you logged into Geneticist Assistant, at a 
minimum, you must create your reference directory and specify its location. You must also 
specify the global Quality Control (coverage) settings for your data. See:

• “To configure Geneticist Assistant directories” on page 55.

• “To specify the global Quality Control settings” on page 60.

Optionally, you can also:

• Configure your proxy server settings. See “To configure proxy server settings” on page 
57.

• Edit the SoftGenetics license server settings. See “To edit the SoftGenetics license server 
settings” on page 58.

• Specify an encryption key for patient data. See “To specify an encryption key for patient 
data” on page 59.

• Specify the colors for highlighting variants of a specific pathogenicity in all the variant 
panes and variant sub-tabs. See “To specify the highlighting colors for variants of a 
pathogenicity and/or case priorities” on page 61.

• Specify the same column display preferences for variants in all the variant panes and 
variant sub-tabs (with the exception of the Sample Group columns on the Sample Variant 
Data sub-tab for the Sample tab and the Variant pane on the Variant tab), and/or clear the 
preferred settings for all the data tabs. See “To apply shared preferences or to clear all tab 
preferences” on page 63.

• Specify the preferred settings for variants, which determines how the information is 
displayed for variants in all the variant panes and variant sub-tabs, and/or clear the 
preferred settings for all the data tabs. See “To specify variant preferences” on page 65.

• Specify the requirements for all user passwords for Geneticist Assistant. See “To specify 
the Geneticist Assistant password requirements” on page 66.

• Specify your Alamut settings. See “To specify Alamut settings” on page 67.

• Specify your OMIM settings. See “Backing up the Geneticist Assistant Database” on 
page 79.

• Specify your HGMD settings. See “To specify HGMD settings” on page 70.

To configure Geneticist Assistant directories
Before you run Geneticist Assistant for the first time, you must create your reference 
directory. The reference directory contains the information for the reference that was used 
for aligning the data and/or detecting variants. References are stored in their own folders in 
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this directory. For example, if you are studying variants that are associated with the human 
genome, then you might create a Human folder in the reference directory, such as 
C:\References\Human 37. Optionally, if you have already configured the reference directory, 
but you have not yet submitted data to the Geneticist Assistant database, then you can change 
the location of the reference directory. Optionally, you can also specify a Reports directory, 
and/or, if applicable, specify the location for your NextGENe installation.

1. If you configured the reference directory the first time that you logged into Geneticist 
Assistant, then go to Step 2; otherwise, create your reference directory in a location that 
meets your business needs, and then go to Step 2.

2. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab. If you are 
configuring the Reference directory for the first time, go to Step 3; otherwise, go to Step 
4.

Figure 2-2:  Settings dialog box, General tab

3. In the Directories pane, next to the Reference Directory field, click the Browse button 

, and then browse to and select the Reference directory that you created in Step 1.

4. Optionally, in the Directories (top) pane, do any or all of the following as appropriate:

• To change the location of the reference directory, next to the Reference Directory 

field, click the Browse button , and then browse to and select a different 

reference directory.

Although not required, SoftGenetics recommends that you create the reference 
directory on the same computer and drive on which you installed the Geneticist 
Assistant client.
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• To specify the directory in which all Geneticist Assistant reports are to be saved, 

next to the Report Directory field, click the Browse button , and then browse to 

and select the directory.

• If your organization also has NextGENe installed, then to use the interactive 
functionality that is available for Geneticist Assistant and NextGENe, Geneticist 
Assistant must be able to locate your NextGENe installation. If your NextGENe 
instance is installed on the same client as your Geneticist Assistant instance, then 
leave Locate on Startup selected; otherwise, clear Locate on Startup, and then next to 

the NextGENe Directory field, click the Browse button , and then browse to and 

select the appropriate directory.

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To configure proxy server settings
If your organization uses a proxy server for external connections, then to view data from 
external databases such as OMIM or LOVD in Geneticist Assistant, you must configure the 
settings for the proxy server.

1. On the Geneticist Assistant main menu, click File > Settings

The Settings dialog box opens. By default, the General tab is the open tab. 

Figure 2-3:  Settings dialog box, General tab

If you have previously specified the location for the reference directory and 
submitted data to the Geneticist Assistant database, then you cannot change its 
location.
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2. In the Proxy pane, configure your proxy server settings. 

3. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To edit the SoftGenetics license server settings
If you are running a purchased version of Geneticist Assistant, the first time that you run the 
program, you must configure Geneticist Assistant to connect to the SoftGenetics license 
server. (See “To run a purchased version of Geneticist Assistant” on page 24.) If you change 
the location of this license server, then you must edit the license server settings so that 
Geneticist Assistant can still connect to the server.

1. On the Geneticist Assistant main menu, click File > Settings to open the Settings dialog 
box.

The Settings dialog box opens. By default, the General tab is the open tab. The current 
information (name or IP address) for the SoftGenetics license server is displayed in the 
Server field. 

Figure 2-4:  Settings dialog box, General tab

2. In the License Server pane, in the Server field, enter the fully qualified domain name 
(FQDN) for the server, or its IP address.

If you select DefaultProxy for Type, then the proxy settings for Internet Explorer 
are used for the connection and you can leave all other proxy settings blank.

If the License Server is running on the same computer on which Geneticist 
Assistant is running, then you must enter 127.0.0.1. 
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3. Leave the Port value set to the default value of 50000.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify an encryption key for patient data
If needed, you can specify an encryption key for the patient data in your Geneticist Assistant 
database. If encryption is enabled for patient data, then no data is displayed in specific 
Patient fields such as First Name, Last Name, and so on. Instead, *encrypted* is displayed. 
To set up encryption for patient data, two files are required: 

• Cert.pem file, which you must save in C:\Program Files\SoftGenetics\SoftGenetics 
Server\ga on the Geneticist Assistant server.

• Cert.pfx, which you can save anywhere on the Geneticist Assistant client. You must 
double-click this file to launch the Certificate Import Wizard and import the encryption 
key for your Geneticist Assistant installation.

1. On the Geneticist Assistant main menu, click File > Settings to open the Settings dialog 
box.

The Settings dialog box opens. By default, the General tab is the open tab. 

Figure 2-5:  Settings dialog box, General tab

     

If your organization already uses encryption for patient data, then these files 
should already be configured and available for use; otherwise, work with your 
organization’s System Administrator to create and configure these files, or you can 
contact.tech_support@softgenetics.com for assistance.
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2. In the Encryption pane, select the appropriate Windows certificate.

3. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify the global Quality Control settings
The settings on the Quality Control tab are the minimum required coverage values (coverage 
threshold values) that a panel region must meet, or it is flagged as failed region for a run. The 
coverage values that you specify here are global settings, which means that, by default, they 
are automatically applied to all panel regions in all runs.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Quality Control tab.

Figure 2-6:  Settings dialog box, Quality Control tab

3. Specify the value for the Quality Control settings.

• Minimum Coverage – The minimum number of reads that are required for a panel 
region.

• Average Coverage – The average number of reads that are required for a panel 
region.

• Percent Covered (%) – The minimum percentage of the panel region that has reads 
aligned to it.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 
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To specify the highlighting colors for variants of a pathogenicity 
and/or case priorities

By default, variants for any of the five system-supplied pathogenicity values—Deleterious, 
Likely Deleterious, Unknown, Likely Benign, and Benign—are highlighted in a specific 
color on the various variant sub-tabs and panes in your Geneticist Assistant instance. You 
can use these default colors, or you can specify other colors on the Colors tab that better meet 
your business needs. Also, if you have added any case priority objects for your Geneticist 
Assistant instance, then these priorities are also displayed on the Colors tab. By default, none 
of these priorities are initially highlighted in a specific color, but optionally, you can specify 
a highlighting color for a case priority, or select a different highlighting color if one has 
already been set. Like the pathogenicity values, these priorities are highlighted in the 
indicated colors on various sub-tabs and panes in your Geneticist Assistant instance. 

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Colors tab. 

The first time that the tab opens, the default highlighting colors for the five  
system-supplied pathogenicity values are displayed on the tab. If applicable, any custom 
pathogenicity values and any case priority objects are also displayed, but without any 
highlighting colors. Going forward, the pathogenicity values and if applicable, case 
priority objects, are highlighted in their specified colors.

Figure 2-7:  Settings dialog box, Default colors shown on the Pathogenicity Colors tab

     

For information about adding a custom pathogenicity value and/or case 
priorities, see “Managing Objects in the Geneticist Assistant” on page 51),
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3. Do one of the following:

• To specify or change the highlighting color for a pathogenicity, double-click the 
pathogenicity.

• To specify or change the highlighting color for a case priority, double-click the case 
priority.

The Select Highlight Color dialog box opens. The pathogenicity or case priority that you 
selected is displayed in the title bar of the dialog box. 

Figure 2-8:  Select Highlight Color dialog box

4. Continue to one of the following:

• “To specify a basic highlighting color for a pathogenicity or case priority” on page 
62.

• “To specify a custom highlighting color for a pathogenicity or case priority” on page 
63.

To specify a basic highlighting color for a pathogenicity or case 
priority

1. Click a basic color.

2. Click OK.

The Select Highlight Color dialog box closes. The Colors tab on the Settings dialog box 
remains open. The selected pathogenicity or case priority is highlighted in the basic 
color.

Multiple ways are available for selecting a highlighting color for a pathogenicity. 
The following are for example purposes only. You can select whichever method or 
combination of methods best suits your working needs.

Color Spectrum

Gradient Bar
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3. Continue selecting pathogenicities or case priorities and specifying basic colors as 
needed.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify a custom highlighting color for a pathogenicity or case 
priority

1. Click in a blank custom color box.

2. Click the color in the Color Spectrum to select an approximate color.

A set of crosshairs is displayed where you clicked and the corresponding color is 
displayed below the spectrum. The HSV and RGB values are also displayed for the 
color. 

3. Do one of the following:

• Manually set the HSV or RGB values for the color.

• Drag and drop the crosshairs to a new location in the Color Spectrum.

• Point and hold your cursor on the Gradient arrow to the right of the Color Spectrum 
and move the arrow up and down until the appropriate color is displayed.

4. Click Add to Custom Colors.

5. Click OK.

The Select Highlight Color dialog box closes. The Colors tab on the Settings dialog box 
remains open. The selected pathogenicity or case priority is highlighted in the custom 
color.

6. Continue selecting pathogenicities or case priorities and specifying custom colors as 
needed.

7. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To apply shared preferences or to clear all tab preferences
Remember, a variety of options are available for settings preferences for a tab display, 
including resizing data columns, rearranging the order of data columns, and so on. (See 
“Setting Display Preferences in the Geneticist Assistant Main Window” on page 31.) Any 
preferences that you set for a tab display remain in effect regardless if you log out of and then 
log back into Geneticist Assistant. You can use an option on the Tab Preferences tab to apply 
the same column display preferences for variants in all the variant sub-tabs and panes (with 
the exception of the Sample Group columns on the Sample Variant Data sub-tab on the 
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Sample tab and the Variant pane on the Variant tab) in a single step. You can also use an 
option on the Tab Preferences tab to clear all the preferred settings for all the data tabs in a 
single step, or you can clear only the column preferences.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Tab Preferences tab. 

Figure 2-9:  Settings dialog box, Tab Preferences tab

3. Do one of the following:

• To return all tab displays to their default displays (all custom display preferences 
such as column header names are reset) in a single step, click Clear All Preferences.

• After you set the column display preferences for a specific variant sub-tab or pane, 
select Apply Shared Preferences to Variant Panel Views. 

The same preferences that were set for this single variant sub-tab or pane are applied 
to all the appropriate sub-tabs or panes on all the other tabs; otherwise, if you clear 
this option, then you can set display preferences individually for each variant sub-tab 
or pane.

• To remove only the column preferences that have been specified for all variant  
sub-tabs or panes in a single step, click Clear Variant Panel View Column 
Preferences.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 
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To specify variant preferences
Variant preferences determine how the information about variants is displayed on all the 
variant tabs, sub-tabs, and panes in Geneticist Assistant.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Variant Preferences tab. 

Figure 2-10:  Settings dialog box, Variant Preferences tab

3. Set the variant preferences.

Option Description

Zygosity

Heterozygosity Upper Bound (%) Default value is 80. The maximum variant frequency for a 
variant to be considered heterozygous.

Heterozygosity Lower Bound (%) Default value is 20. The minimum variant frequency for a 
variant to be considered heterozygous.

Note: To report low frequency variants, reduce this value.

Variant Annotation

• Use GFF3 file • The default value. Use the annotation information in the 
reference files that SoftGenetics provides.

• Use GTF file • Use the annotation inf ormation in the reference files that 
ENSEMBL provides.

Note: If you select this option, then you must download the 
correct references files from ENSEMBL and place them 
in the Reference directory that is defined for your 
Geneticist Assistant installation. See “To configure 
Geneticist Assistant directories” on page 55.
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4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify the Geneticist Assistant password requirements
When Geneticist Assistant is first installed, by default, the Username is set to Administrator, 
and you must specify an administrator password. By default, the only requirement is that the 
password cannot contain any spaces. You can, however, specify additional requirements that 
are applicable for all user passwords, including the Administrator password. You can specify 
the following requirements for your user passwords:

• Minimum length.

• Minimum number of upper case and lower case characters.

• Minimum number of numeric characters.

• Minimum number of special characters.

Highlight user-modified fields Select this option to highlight any field that a user has modified 
on all the variant tabs and sub-tabs. This same field is not 
highlighted on the Variant tab.

Variant Submission

Submit Hotspots Deselected by default. Any variants that are included in a VCF 
file that have an allele frequency value = 0 and/or genotype = 
0/0 in the file are submitted to the Geneticist Assistant 
database.

HGVS Nomenclature - Determines which transcript is used for the HGVS nomenclature columns if a 
gene has multiple transcripts.

• Preferred Selected by default. Show only a single transcript, either the 
transcript that is selected by default as the preferred transcript 
or the transcript that is defined as the preferred transcript in a 
preferred transcript list. See “To set or delete a preferred 
transcript list for a panel” on page 106.

• Unique Translation Show multiple transcripts if the translation varies among the 
transcripts.

• Unique Exon region Show multiple transcripts if the exon regions vary among the 
transcripts. 

• All Shows the HGVS nomenclature based on all the transcripts 
that are included for the gene.

HIde predicted if known 
transcripts exist

Selected by default. If known transcripts exist for the gene, 
then do not include any predicted transcripts in the HGVS 
columns. 

Use short description for 
frameshifts

Option Description
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1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Password Settings tab. 

A default value is provided for each password setting.

Figure 2-11:  Settings dialog box, Password Settings tab

3. Specify the requirements for all user passwords for your Geneticist Assistant installation.

4. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any of the other tabs as needed. 

To specify Alamut settings
To view variants that were imported into Geneticist Assistant in Alamut, the following is 
required:

• HTTP-based access must be enabled in Alamut. To enable this in Alamut, select Tools > 
Options > Api, select Enable HTTP-based access, and then set the port to 10000.

• Geneticist Assistant must be able to connect to Alamut and Alamut must be installed on 
the same computer as the Geneticist Assistant client. 

• Alamut must be open to jump to the variant position from Geneticist Assistant. 

You specify the Alamut connection settings for Geneticist Assistant on the Third-Party 
Settings tab on the Settings dialog box.

1. On the Geneticist Assistant main menu, click File > Settings.

You can click Reset Defaults at any time to reset all password settings to their 
default values in a single step.
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The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Third-Party Settings tab. 

Figure 2-12:  Settings dialog box, Third-Party Settings tab

3. Enter the information for the Alamut server. (The default value is http://localhost).

4. Leave the Port value set to 10000.

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To specify the OMIM settings
To view variants in Geneticist Assistant in OMIM, Geneticist Assistant must be able to 
connect to OMIM and use an OMIM API key to log you in automatically. You request an 
OMIM API key and specify the OMIM settings for your Geneticist Assistant installation on 
the Third-Party Settings tab on the Settings dialog box.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Third-Party Settings tab. 

For more information about this value, or to change the value, contact 
SoftGenetics (tech_support@softgenetics.com).
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Figure 2-13:  Settings dialog box, Third-Party Settings tab

3. In the OMIM (middle) pane, click Request an OMIM API key.

You are directed to the API Access to OMIM webpage.

4. Complete the necessary information to obtain an OMIM API Access key.

5. Upon receipt of the key, enter the value in the API field.

6. Indicate the connectivity for the API Host (Europe or United States).

7. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 
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To specify HGMD settings
To view variants that were detected in Geneticist Assistant in HGMD, Geneticist Assistant 
must be able to connect to HGMD and log you in automatically. You specify your HGMD 
login settings on the Third-Parting Settings tab on the Settings dialog box.

1. On the Geneticist Assistant main menu, click File > Settings.

The Settings dialog box opens. By default, the General tab is the open tab.

2. Open the Third-Party Settings tab. 

Figure 2-14:  Settings dialog box, HGMD Settings tab

3. In the HGMD (bottom) pane, enter your HGMD username and password.

4. Optionally, to show only the HGMD ID when the HGMD entry matches not only for the 
chromosome position, but also for the reference and alternate alleles, select Match 
Alleles.

5. If you are done specifying your settings, then click OK to close the Settings dialog box 
and return to the Geneticist Assistant main window; otherwise, continue to add and/or 
edit the information on any this tab or any of the other tabs as appropriate. 

To clear the currently entered values for username and password in a single step, 
you can click Clear.
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Creating Workflow Models
A workflow is the progression of steps that comprise an NGS-based analysis in your lab. You 
can use the Workflow Builder function in Geneticist Assistant to create models of your lab’s 
NGS workflows. A workflow model consists of two parts: the steps (or nodes), and the 
connections. A step indicates the action that was carried out on the NGS data, for example, 
sample alignment. A connection indicates the order of the flow of steps, or how the steps are 
related to one another, for example, from sequencing to variant calling. When you are 
building a workflow model, you must adhere to the following rules, or you cannot save the 
workflow model to your Geneticist Assistant database:

• You must always identify which step in a workflow model is the final, or Exit, step. 

• You must connect every step in the workflow model to at least one other step. (Multiple 
connections, or branches, are allowed for a step.)

After you create and save a workflow model, you can then assign this workflow model to 
any case in your Geneticist Assistant database.

To create a new workflow model
When you are creating a new workflow model, you can add all the necessary steps and then 
connect the steps, or you can add a step, specify the connection for the step, and then add the 
next step to complete the connection. You can also load an existing workflow model in the 
Workflow Builder, and then edit the workflow as needed to create a new workflow. 

1. On the Geneticist Assistant main menu, click File > Workflow Builder.

The Workflow Builder dialog box opens. When the dialog box opens for the first time, it 
is blank. After you create and save one or more workflow models, the models are listed 
alphabetically by name on a Workflow Model dropdown list to the right of the Name 
field. See Figure 2-15 on page 72.

A workflow is for informational purposes only. It does not affect the processing or 
interpretation of the NGS data that is stored in your Geneticist Assistant database.

The following procedure describes how to create an entirely new workflow model. 
In this example, the model is built by adding all the necessary steps first, and then 
connecting the steps. To create a new workflow model based on existing model, 
see “To create a new workflow by editing an existing workflow” on page 77.

To edit an existing workflow, on the Workflow Model dropdown list, select the 
appropriate workflow model, and then click Load Workflow. The workflow model 
is displayed in the Workflow Builder dialog box. You can then edit the workflow as 
needed, including adding, editing, and/or deleting workflow steps, and adding, 
editing, or deleting workflow connections. See “To add the steps for the workflow 
model” on page 73 and/or “To connect the steps in workflow model” on page 74.
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Figure 2-15:  Workflow Builder dialog box

1. In the Name dialog box, enter the name for the new workflow model.

2. Optionally, in the Description field, enter a description for the workflow model.

3. Add the workflow steps and the connections. See:

• “To add the steps for the workflow model” on page 73.

• “To connect the steps in workflow model” on page 74.

4. Click Save.

A Workflow Saved message opens.

5. Click OK.

The Workflow Saved message closes. The workflow model is now saved to your 
Geneticist Assistant database. You can assign this workflow model to any case in your 
Geneticist Assistant database. See Chapter 9, “Geneticist Assistant Data Review - Cases 
Tab,” on page 279.

     

At any time, you can click Clear and Restart to delete the workflow model in its 
entirety from the Workflow Builder dialog box and start over with building the 
workflow. 
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To add the steps for the workflow model

When you are creating a workflow model, Geneticist Assistant automatically designates the 
first step as the “Start” step and you cannot change this. In addition, when you are adding a 
step to a workflow model, you must select an icon to identify the step. You select the icon for 
a step from a list of pre-defined icons. To open and view a list of the available pre-defined 
icons, next to the New Step button, click the Down arrow. You can hold your mouse pointer 
over an icon to open a tooltip that provides a description for the icon.

Figure 2-16:  Pre-defined Workflow Step icons

Do the following to add the steps for a workflow model:

1. To add the first step, the Start step, for the workflow model, do one of the following:

• Click New Step. 

• Right-click anywhere in the lower blank pane of the Workflow Builder dialog box, 
and on the context menu that opens, click Create New Step.

A Start workflow step icon is displayed in the lower blank pane of the Workflow 
Builder dialog box. You can click and drag this icon to any location in the pane.

2. Continue adding the necessary steps for the workflow model:

a. Do one of the following:

• Click New Step. 

• Right-click anywhere in the lower blank pane of the Workflow Builder dialog 
box, and on the context menu that opens, click Create New Step.

The New Workflow Step dialog box opens.

Figure 2-17:  New Workflow Step dialog box

b. In the Name field, enter the name for the workflow step, for example, DNA 
Sequencing.
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c. Optionally, in the Description field, enter a description for the workflow step.

d. Click the Workflow Step icon to open a list of all the available pre-defined workflow 
step icons, and then click the appropriate icon for the step. 

e. If the selected step is the last step, or Exit step, in the workflow model, then select Is 
Exit Step.

f. Click OK. 

The New Workflow Step dialog box closes. The selected workflow step icon is 
displayed in the lower blank pane of the Workflow Builder dialog box. You can click 
and drag this icon to the appropriate location in the pane. After you have added all 
the necessary steps, you must connect the steps. 

3. Continue to “To connect the steps in workflow model” below.

To connect the steps in workflow model

You must connect every step in the workflow model to at least one other step. You can use 
the New Connection function to add a connection between workflow steps, or you can 
manually add the connection. Regardless of how you add the connection, a connection must 
always be defined as one of five allowed connection types: Completed, Passed, Failed, Yes, 
or No. You can also add multiple connections for a step.

To use the New Connection function to connect steps in a workflow model

1. Click New Connection. 

The New Connection dialog box opens. The Source Step (left) pane lists all the 
workflow model steps alphabetically by name from which you can start a connection. 
The Destination Step (right) pane lists all the workflow model steps alphabetically by 
name to which you can connect (complete the connection). See Figure 2-18 on page 75.

You must always identify which step in a workflow model is the Exit step, or you 
cannot save the workflow model to the Geneticist Assistant database. 

Also, you an always edit or remove the step. To do so, right-click the step icon, and 
on the context menu that opens, click Edit this node or Remove this mode as 
appropriate.
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Figure 2-18:  New Connection dialog box

2. In the Source Step pane, select the workflow step from which the connection starts. 

3. In the Destination Step pane, select the workflow field at which the connection ends.

4. On the Connection Type dropdown list, leave the connection type set to the default value 
of completed, or select a different value (passed, failed, yes, or no).

5. Click Apply.

6. Click OK.

The New Connection dialog box closes. The connection and its type are displayed in the 
workflow model.

To manually connect steps in a workflow

1. Press and hold the Shift key, and then in the Workflow Builder dialog box, click the 
workflow step icon from which the connection is to start.

2. Drag the mouse pointer onto the icon for the workflow step at which the connection is to 
end, and then release the mouse button.

The Choose Connection Type dialog box opens.

Figure 2-19:  Choose Connection Type dialog box

3. Leave the connection type set to the default value of completed, or select a different 
value (passed, failed, yes, or no).

     

If you add a connection in error, and need to delete the connection, then in the 
workflow model, right-click the connection, and on the context menu that opens, 
click Remove this edge.
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4. Click OK.

The Choose Connection Type dialog box closes. The connection and its type are 
displayed in the workflow model.

To add multiple connections (branches) for a step

Multiple connections for a step are referred to as branches. A branch typically represents a 
step in the workflow that is not part of the primary workflow.

1. Right-click the appropriate workflow step icon, and on the context menu that opens, 
click Branch a node.

The New Connection dialog box opens. The Source Step (left) pane lists the selected 
workflow step. The Destination Step (right) pane lists all the workflow model steps 
alphabetically, by name, to which you can connect (complete the branch). 

Figure 2-20:  New Connection dialog box

2. In the Source Step pane, select the single workflow step. 

3. In the Destination Step pane, select the workflow step at which the connection ends.

4. On the Connection Type dropdown list, leave the connection type set to the default value 
of completed, or select a different value (passed, failed, yes, or no).

5. Click Apply.

6. Click OK.

The New Connection dialog box closes. The connection and its type are displayed in the 
workflow model.

If you add a connection in error, and need to delete the connection, then in the 
workflow model, right-click the connection, and on the context menu that opens, 
click Remove this edge.

If you add a connection in error, and need to delete the connection, then in the 
workflow model, right-click the connection, and on the context menu that opens, 
click Remove this edge.
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To create a new workflow by editing an existing workflow
1. On the Geneticist Assistant main menu, click File > Workflow Builder.

The Workflow Builder dialog box opens. All the workflow models that are currently 
saved in your Geneticist Assistant database are listed alphabetically by name on a 
Workflow Model dropdown list to the right of the Name field. 

Figure 2-21:  Workflow Builder dialog box

2. On the Workflow Model dropdown list, select the source workflow model, and then 
click Copy Pathway.

The workflow model is displayed in the Workflow Builder dialog box. The Name field is 
blank. The Description field displays any description that was saved for the workflow 
model.

3. Enter a name for the new workflow, and if applicable, enter or edit its description.

4. Edit the steps and/or the connections for the workflow as appropriate. See:

• “To add the steps for the workflow model” on page 73.

• “To connect the steps in workflow model” on page 74.

5. Click Save.

A Workflow Saved message opens.

     

At any time, you can click Clear and Restart to delete the workflow model in its 
entirety from the Workflow Builder dialog box and start over with building the 
workflow. 
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6. Click OK.

The Workflow Saved message closes. The workflow model is now saved to your 
Geneticist Assistant database. You can assign this workflow model to any case in your 
Geneticist Assistant database. See Chapter 9, “Geneticist Assistant Data Review - Cases 
Tab,” on page 279.
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Backing up the Geneticist Assistant Database
For data protection, you can manually back up the Geneticist Assistant database at any time 
of your choosing.

To back up the Geneticist Assistant database
1. On the Geneticist Assistant main menu, click Backup > Run Backup.

The Backup dialog box opens. Note the following about this dialog box:

• The first time that the Backup dialog box opens, in the Backup File field, the default 
location for saving the database backup file is set to C:\Program 
Files\SoftGenetics\Geneticist Assistant\ga_exe.

• When the Backup dialog box subsequently opens, the location in which you last 
generated and saved a database backup file is displayed in the Backup File field, 
with the suggested name for the new backup file set to 
softgenetics_backup_<current year>_<current month_day>_<current_time>, for 
example, softgenetics_backup_2017_0103_1053.sql. 

Figure 2-22:  Backup dialog box

2. Next to the MySQLDump path field, click the Browse button  to open the Select 

mysqldump.exe dialog box, and then browse to and select the mysqldump.exe file.

3. Enter your MySQL Username and password.

     

If you installed MySQL in is default directory, then the mysqldump.exe file is found 
in C:\Program Files (x86)\MySQL\MySQL Server 5.1\bin or  
C:\MySQL\MySQL-5.6\bin.

Make sure to enter your MySQL login credentials, and NOT your Geneticist 
Assistant login credentials. Unless you have customized your MySQL installation, 
the username is root and the password is softgeneticssetup.
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4. Do one of the following:

• To leave the database backup file location and name set to their default values and 
immediately generate the file, click OK.

• To change the location and name for the database backup file, next to the Backup 

File field, click the Browse button  to open the Select backup file dialog box, 

and then specify a location and name for the database backup file. 

5. Click OK.

After the Geneticist Assistant database is successfully backed up, a Finished message 
opens indicating that the backup is finished.

6. Click OK to close the message. 

The Geneticist Assistant main window remains open.

The file type is Sql files (*.sql) and you cannot change this.
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In addition to specifying some of the basic settings for Geneticist Assistant, such as the 
Reference directories, or the global Quality Control settings, you must configure the users, 
and optionally, the groups, who are to have access to Geneticist Assistant.

This chapter covers the following topics:

• “Managing Users” on page 83.

• “Managing Groups” on page 89.

• “Managing Web Users” on page 94.
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Managing Users
Users are the people who log into Geneticist Assistant, whether they are adding and 
reviewing content, or just using Geneticist Assistant in a read-only capacity. Remember, 
when Geneticist Assistant is first installed, it is installed with a default Administrator user. 
As the Geneticist Assistant administrator, you must manage all the necessary users for your 
Geneticist Assistant installation, which includes adding new users, deleting users, and 
editing user permissions. 

To add a new user
A user in Geneticist Assistant is one of three types:

• Administrator user - All available permission types (User, Chemistry, Instrument, and so 
on) are automatically assigned to an Administrator user. An Administrator user can view 
all the runs that have been submitted to the Geneticist Assistant database by any user and 
all the patients that have been added to the Geneticist Assistant database by any user.

• Staff user - A Staff user can log into the django web administrator site. The actions that a 
staff user can carry out on this site are determined by the permission types that are 
assigned to the user. 

• Standard user - For a “standard” user, you do not select either the Administrator Privileges 
option or the Staff option. Standard users can view all the runs that they have submitted 
to the Geneticist Assistant database as well as any runs that have been submitted by other 
users and for which they have been granted at least the Can Read permission. Standard 
users can also view all the patients that they have added to the Geneticist Assistant 
database as well as any patients that have been added by others users and for which they 
have been granted at least the Can Read permission.

.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
installation, their status, and if applicable, their permissions level (Staff or 
Administrator). See Figure 3-1 on page 84.

Instead of assigning permissions to each user on an individual basis, optionally, 
you can assign users to a group and apply the same permissions to all the users in 
the group in a single step. See “Managing Groups” on page 89.

For a detailed description of the permission types that you can assign to a user, 
contact SoftGenetics.
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Figure 3-1:  User Management dialog box, User tab

2. Click Add New User.

The Add New User dialog box opens.

Figure 3-2:  Add New User dialog box
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3. Add the information for the new user.

4. In the Permissions pane, add or delete the permissions for the user as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

5. Click OK.

The Add New User dialog box closes. The User Management dialog box remains open.

     

Field Description

Username Required. The login name for the user. Uppercase and lowercase are 
allowed. No special characters are allowed.

Password Required. The login password for the user. The password cannot contain 
any spaces. If additional password requirements have been set, then the 
password must also adhere to these requirements. See “To specify the 
Geneticist Assistant password requirements” on page 66.

Confirm Password Required. Enter the password exactly as you entered it in the Password 
field.

First Name (optional) The first name for the user. Displayed only here in the application.

Last Name (optional) The last name for the user. Displayed only here in the application.

Email Required. The email address for the user.

• Administrator 
Privileges

• Staff 

You can assign both Administrator Privileges and Staff status to the same 
user. Do not assign either option for a standard user.

Active Selected by default and you cannot change this. The user is added as an 
Active user. The user can log into Geneticist Assistant and carry out all the 
activities available to him/her based on the assigned permissions. You can 
inactivate a user when you edit a user. See “To edit a user” on page 86.

Manage Users For informational purposes only. Indicates that the user is a manager of 
other users in your lab.

Manage Groups For informational purposes only. Indicates that the user is a manager of 
groups in your lab.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.
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To delete a user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
installation, their status, and if applicable, their permissions level (Staff or 
Administrator).

Figure 3-3:  User Management dialog box, User tab

2. Right-click the user that you are deleting, and on the context menu that opens, click 
Remove User.

The user is deleted.

To edit a user
When you edit a user, you can edit the user password, the user first and last names, the user 
email address, the user status, the user level (Administrator and/or Staff) and the user 
permissions. You cannot edit a user name. To edit a user name, you must delete the existing 
user (see “To delete a user” on page 86), and then add the user with a new user name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. The 
tab displays all the users who are currently configured for your Geneticist Assistant 
installation, their status, and if applicable, their permissions level (Staff or 
Administrator). See Figure 3-4 on page 87.

No confirmation message opens asking you if you are sure that you want to delete 
a selected user. Instead, the user is deleted immediately, so be very sure that you 
want to delete a user before doing so.
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Figure 3-4:  User Management dialog box, User tab

2. Do one of the following:

• Double-click the user that you are deleting.

• Right-click the user that you are editing, and on the context menu that opens, click 
Edit User.

The Edit User dialog box opens. With the exception of the password, the dialog displays 
all the current information for the user, including the currently assigned permissions. 

Figure 3-5:  Edit User dialog box

3. Edit any or all of the following information as needed—the user password, the user first 
and last names, the user email address, the user status (Active), or the user level (Staff or 
Administrator).
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4. In the Permissions pane, add or delete the permissions for the user as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

5. Click OK.

The Edit Permissions dialog box closes. The User tab of the User Management dialog 
box remain open.

If you edit the user level, do not forget to manually edit the permissions as needed. 
See Step 4 below.

Be aware of the dependencies for these permissions. For example, if a user is to be 
able to add chemistries, then the user must also be able to view chemistries.
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Managing Groups
Instead of assigning permissions to each user on an individual basis, optionally, you can 
assign users to a group and apply the same permissions to all the users in the group in a 
single step. As the Geneticist Assistant administrator, you must manage all the necessary 
groups for your Geneticist Assistant installation, which includes adding new groups, deleting 
groups, and editing group permissions. 

To add a new group
When you add a group, you must name the group, add to users to the group, and assign 
permissions to the group. If a user has different privileges assigned than the group 
permissions, then the complete set of user permissions is the user permissions plus the group 
permissions. If a user is assigned to multiple groups, then the user’s permissions are a sum of 
all the groups’ permissions.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. 

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-6:  User Management dialog box, Group tab

3. Click Add New Group.

The Add New Group dialog box opens. All users who can be added to a group are 
displayed in the All Users pane. See Figure 3-7 on page 90.
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Figure 3-7:  Add New Group dialog box

4. Enter the name for the new group.

5. In the All Users pane, select the users whom you are adding to the group (CTRL-click to 
select multiple users in a single step), and then click Add. 

6. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

7. Click OK.

The Add New Group dialog box closes. The User Management dialog box remains 
opens.

Uppercase and lowercase and spaces are allowed. No special characters are 
allowed. 

If you add a user in error, you can remove them. Select the user in the Current 
Users pane (CTRL-click to select multiple users in a single step), and then click 
Remove. 

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
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To delete a group
When you delete a group, only the group is deleted. All the users remain configured (with 
their user permissions, if applicable), in Geneticist Assistant.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. 

2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-8:  User Management dialog box, Group tab

3. Right-click the group that you are deleting, and on context menu that opens, click 
Remove Group.

The group is deleted.

To edit a group
When you edit a group, you can edit the users who belong to the group and the group 
permissions. You cannot edit the group name. To edit a group name, you must delete the 
existing group (see “To delete a group” on page 91), and then add the group with a new 
group name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab.

     

No confirmation message opens asking you if you are sure that you want to delete 
a selected group. Instead, the group is deleted immediately, so be very sure that 
you want to delete a group before doing so.
Geneticist Assistant User’s Manual 91



Chapter 3
Geneticist Assistant User Management
2. Click the Group tab to open it.

The tab displays all the groups by name that are currently configured for your Geneticist 
Assistant installation.

Figure 3-9:  User Management dialog box, Group tab

3. Do one of the following:

• Double-click the group that you are editing.

• Right-click the group that you are editing, and on the context menu that opens, click 
Edit Group.

The Edit Group dialog box opens. The dialog displays all the current information for the 
group—the group name, the users who are currently assigned to the group, and the 
permissions for the group. 

Figure 3-10:  Edit Group dialog box
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4. To edit the users who belong to the group, do one or both of the following as needed:

• To add users to the group—In the All Users pane, select the users whom you are 
adding to the group (CTRL-click to select multiple users in a single step), and then 
click Add. 

• To remove users from a group—In the Current Users pane, select the users whom 
you are removing from the group, (CTRL-click to select multiple users in a single 
step), and then click Remove. 

5. In the Permissions pane, add or delete the permissions for the group as needed. You can 
add or delete permissions individually, or you can add or delete all permissions of a 
specific type in a single step.

• To add all permissions of a specific type (for example, View), select the check box 
next to the type.

• To clear all permissions of a specific type, clear the check box for the type.

6. Click OK.

The Edit Group dialog box closes. You return to the Group tab of the User Management 
dialog box.

Be aware of the dependencies for these permissions. For example, if a group is to 
be able to add chemistries, then the group must also be able to view chemistries.
Geneticist Assistant User’s Manual 93



Chapter 3
Geneticist Assistant User Management
Managing Web Users
A web user is a user who has login and read/write permissions to the Geneticist Assistant 
customer portal. A web user can enter your organization’s patient and sample information in 
to the Geneticist Assistant customer portal without ever having to log in to an instance of 
Geneticist Assistant and accessing your Geneticist Assistant database. As the Geneticist 
Assistant administrator, you must manage all the necessary web users for the Geneticist 
Assistant customer portal, which includes adding, deleting, and editing web users.

To add a new web user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. See 
Figure 3-1 on page 84.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. 

Figure 3-11:  User Management dialog box, Web User tab

3. Click Add New Web User.

The Add New User dialog box opens. See Figure 3-12 on page 95.

For detailed information about the Geneticist Assistant customer portal, see 
Chapter 13, “The Geneticist Assistant Customer Portal and Submissions,” on 
page 351.
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Figure 3-12:  Add New User dialog box (for a web user)

4. Add the information for the new web user.

5. Click OK.

The Add New User dialog box closes. The User Management dialog box remain open.

To delete a web user
1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. See 
Figure 3-1 on page 84.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. See Figure 3-13 on 
page 96.

Field Description

Username Required. The login name for the user. Uppercase and lowercase are 
allowed. No special characters are allowed.

Password Required. The login password for the user. The password cannot contain 
any spaces. If additional password requirements have been set, then the 
password must also adhere to these requirements. See “To specify the 
Geneticist Assistant password requirements” on page 66.

Confirm Password Required. Enter the password exactly as you entered it in the Password 
field.

First Name (optional) The first name for the user. Displayed only here in the application.

Last Name (optional) The last name for the user. Displayed only here in the application.

Email Required. The email address for the user.

When you add a new web user, the user is added with a status of Active, and the 
user level of Staff and Administrator set to No and you cannot edit this 
information.
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Figure 3-13:  User Management dialog box, Web User tab

3. Right-click the web user that you are deleting, and on the context menu that opens, click 
Disable User.

The web user is deleted.

To edit a web user
When you edit a web user, you can edit the user password, the user first and last names, and 
the user email address, but you cannot edit the username. To edit a user name, you must 
delete the existing web user (see “To delete a web user” on page 95), and then add the web 
user with a new user name.

1. On the Geneticist Assistant main menu, click File > User Management.

The User Management dialog box opens. By default, the User tab is the open tab. See 
Figure 3-1 on page 84.

2. Click Web User.

The Web User tab opens. The tab displays all the web users that are currently configured 
to access your instance of the Geneticist Assistant customer portal. 

Figure 3-14:  User Management dialog box, Web User tab

No confirmation message opens asking you if you are sure that you want to delete 
a selected user. Instead, the user is deleted immediately, so be very sure that you 
want to delete a user before doing so.
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3. Double-click the web user that you are editing.

The Edit User dialog box opens. With the exception of the password, the dialog box 
displays the current information for the selected web user. 

Figure 3-15:  Edit User dialog box (for a web user)

4. Edit any or all of the following information as needed—the user password, the user first 
and last names, or the user email address.

5. Click OK.

The Edit User dialog box closes. You return to the Web User tab of the User 
Management dialog box.

The tab also displays the status (Active) and user levels (Staff and Administrator 
set to No) for every user. Although this information is displayed for a web user, 
you cannot edit it.
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A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. Panels are added to Geneticist Assistant by providing a BED file that defines the 
targeted regions, known as panel regions. Each sample that is submitted in Geneticist 
Assistant is assigned to a specific panel. Managing panels consists of importing, editing, and 
deleting panels, and reviewing panel statistics. A subpanel contains a fixed number of 
regions that are contained within a selected panel. To verify coverage for a smaller number 
of regions that are within the panel that has been selected for a run, you can use a subpanel. 
Managing subpanels consists of adding, editing, and deleting subpanels.

This chapter covers the following topics:

• “Importing a Panel” on page 101.

• “Editing a Panel” on page 111.

• “Deleting a Panel” on page 113.

• “Reviewing Panel Statistics” on page 114.

• “Adding a Subpanel” on page 115.

• “Deleting a Subpanel” on page 118.
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Importing a Panel
A panel is a collection of genomic regions that are targeted for a specific genomic test or 
study. Panels are added to Geneticist Assistant by importing a BED file that defines the 
targeted regions, known as panel regions.

To import a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. The number of panels that have already been 
imported into your Geneticist Assistant instance is displayed at the bottom of the dialog 
box. By default, Import from Panel File is selected.

Figure 4-1:  Manage Panels dialog box

2. Next to Import from Panel File, click the Browse button , and then browse to and 

select the appropriate BED file.

Geneticist Assistant creates a panel name that is the same as the selected BED file.

     

If the correct BED file is not available for a panel, then you can create a new BED 
file for it, either from a BED file that was loaded for another panel (see “To create 
a new BED file for a panel by adding or deleting regions” on page 109), or by 
clicking Bed File Builder to open the BED File Builder tool and create a BED file 
that is based on the information that you specify. See “Building a BED File with 
the BED File Builder Tool” on page 335.
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3. Optionally, in the Panel Name field, change the name of the panel.

4. If the correct panel group is not selected, then click Change Associated Panel Group to 
open the Panel Group Association dialog box, and then select a new panel group or click 
Add New Panel Group to open the Add New Panel Group dialog box and create it.

5. Click Import Panel.

The Manage Panels dialog box display is updated to show all the panel regions by name 
for the panel. By default, the coverage thresholds that are initially displayed are the 
global values that are defined on the Quality Control tab on the Settings tab. See “To 
specify the global Quality Control settings” on page 60.

6. Do one of the following:

• If you are done with the configuration of the newly added panel, then click OK to 
close the Manage Panels dialog box and return to the Current Jobs tab of the 
Geneticist Assistant main window. The tab shows the progress of importing the new 
panel. After the panel is successfully imported, the tab is blank. 

• If you are not done with the configuration of the newly added panel, then continue to 
any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 103.

• “To create a QC Threshold file for panel regions” on page 104.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on 
page 105.

You can always click Default Name to change the name of the panel back to its 
default name.

 For information about panel groups, see “Managing Objects in the Geneticist 
Assistant” on page 51.

To track variant pathogenicities together for all panels, instead of creating custom 
panel groups, create a single panel group that is to be used for all panels, for 
example, a Global panel group.

The time that it can take to import a BED file depends on the size of the BED file. 
Be patient as some BED files can take over an hour to be imported.

To confirm that the panel has been successfully imported, you can open the 
Manage Panels dialog box again, choose Select Existing Panel, and make sure 
that an entry for the imported panel is displayed on the dropdown list of existing 
panels.
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• “To set or delete a preferred transcript list for a panel” on page 106.

• “To set or delete a preferred gene for a panel” on page 108.

• “To create a new BED file for a panel by adding or deleting regions” on page 
109.

To manually set new coverage thresholds for panel regions

After you have imported a new panel, the coverage values that are initially displayed for 
each panel region are the global values that are defined on the Quality Control tab of the 
Settings dialog box. If needed, you can edit these values and save the values for the panel. 
You can edit the values for all the regions in a single step, or you can set different coverage 
thresholds on a per region basis.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions in the bottom 
pane of the Manage Panels dialog box.

2. Do one of the following:

Action Steps

To edit the values for all 
regions in a single step

1. Click Update QC Threshold.

The Update QC Threshold for All Regions dialog box opens.

Figure 4-2:  Update QC Threshold for All Regions dialog box

2. For each coverage value that is to be edited, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.

The coverage value is selected, and Up/Down arrows are displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.
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3. If you are done with the configuration of the newly added panel, then click OK to close 
the Manage Panels dialog box and return to the Geneticist Assistant main window. (The 
edited coverage values are now saved for the panel in the Geneticist Assistant database.) 
Otherwise, continue any of the following as needed:

• “To create a QC Threshold file for panel regions” below.

• “To set or delete a preferred transcript list for a panel” on page 106.

• “To set or delete a preferred gene for a panel” on page 108.

• “To create a new BED file for a panel by adding or deleting regions” on page 109.

To create a QC Threshold file for panel regions

After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file. You can save this file as record of the QC thresholds that 
were used for the panel and you can also load this text file to apply these coverage thresholds 
to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

2. Do one of the following:

Action Steps

To edit the values for all 
regions in a single step

1. Click Update QC Threshold.

The Update QC Threshold for All Regions dialog box opens.

Figure 4-3:  Update QC Threshold for All Regions dialog box

2. For each coverage value that is to be edited, double-click it to select 
it, and then manually enter a new value, or click the Up/Down arrows 
to change the value accordingly.

3. Click OK.
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3. Click Save QC Threshold File.

The Save File dialog box opens. By default, the QC Threshold file is named as <Panel 
Name>_qc_threshold, and it is saved in the same directory as the BED file for the panel. 
You can change one or both of these values. The file type is a text file, and you cannot 
change this.

4. Optionally, change the name for the QC Threshold file, and/or the directory in which to 
save the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. You can 
now load this text file to apply these coverage values to a different panel. See “To set 
new coverage thresholds for panel regions with a QC Threshold file” below.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. (The edited coverage values are now saved for the panel in the Geneticist 
Assistant database.) Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 106.

• “To set or delete a preferred gene for a panel” on page 108.

• “To create a new BED file for a panel by adding or deleting regions” on page 109.

To set new coverage thresholds for panel regions with a QC 
Threshold file

After you edit the coverage values for the regions of one panel, you can save these edited 
values to a QC Threshold text file, and then load this text file to apply these coverage values 
to a different panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

     

To edit the values on a 
per region basis

1. Double-click in the appropriate coverage field for a region.

The coverage value is selected, and Up/Down arrows are also 
displayed.

2. Manually enter a new value, or click the Up/Down arrows to change 
the value accordingly.

Action Steps
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2. Click Load QC Threshold from File.

The Select a file to set QC threshold dialog box opens.

3. Browse to and select the appropriate QC Threshold file, and then click Open.

The Select a file to set QC threshold dialog box closes, and a QC Threshold Updated 
message opens. The message indicates the number of regions for which the QC 
threshold values were successfully updated. 

4. Click OK.

The message closes. The Manage Panels dialog box remains open.

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. (The edited coverage values are now saved for the panel in the Geneticist 
Assistant database.) Otherwise, continue to one or both of the following as needed:

• “To set or delete a preferred transcript list for a panel” on page 106.

• “To set or delete a preferred gene for a panel” on page 108.

• “To create a new BED file for a panel by adding or deleting regions” on page 109.

To set or delete a preferred transcript list for a panel

A preferred transcript list is a tab-delimited text file that defines the specific transcript or 
isoform that is to be used for a gene. You can use different transcripts for different panels. 
The preferred transcript list contains two fields. The first column contains the gene name. 
The second column specifies the transcript by its nm_accession number. There are no 
restrictions for the file name, but you must save the file as a tab-delimited text file.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the transcript list that is currently set as the preferred transcript list for the 
panel, click View Existing.

The Preferred Transcript for <Panel Name> dialog box opens. The dialog box 
displays the transcript list that is currently set as the preferred list for the panel. See 
Figure 4-4 on page 107.

If the correct QC Threshold file is not available, then you can create it. See “To 
create a QC Threshold file for panel regions” on page 104.
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Figure 4-4:  Preferred Transcript dialog box

• To save the preferred transcript list as a text (.txt) file, click Save As in the Preferred 
Transcript dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remain open.

• To set a preferred transcript list for the panel, then next to the Set Preferred 

Transcript from File field, click the Browse button  and in the Open File dialog 

box, browse to and select the appropriate transcript list, and then click Open.

The Open File dialog box closes. The full path to the selected transcript list is 
displayed in the Set Preferred Transcript from File field. 

• To delete the preferred transcript list for the panel, click Delete Existing, and then 
click Yes in the Delete Existing Preference message. 

The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 103.

• “To create a QC Threshold file for panel regions” on page 104.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
105.

• “To set or delete a preferred gene for a panel” on page 108.

• “To create a new BED file for a panel by adding or deleting regions” on page 109.

The Save As option provides a quick way of copying the preferred transcript list so 
that you can make any needed changes to it, and then use it with this panel or 
another panel.
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To set or delete a preferred gene for a panel

If a variant is found at a position where there are overlapping genes, then you can specify the 
gene that is to be used for the panel. The file that specifies the preferred gene is a text file that 
contains the complete gene name on a single line.

1. If you have just created a new panel, then the Manage Panels dialog box is already open 
and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Existing Panel dropdown list, select the appropriate panel.

2. Optionally, do any or all of the following as needed:

• To view the genes that are currently set as the preferred genes for the panel, click 
View Existing.

The Preferred Gene for <Panel Name> dialog box opens. The dialog box displays 
the genes that are currently set as the preferred genes for the panel. 

Figure 4-5:  Preferred Gene dialog box

• To save the preferred gene file as a text (.txt) file, click Save As in the Preferred 
Gene dialog box; otherwise, click Close to close the dialog box.

The Manage Panels dialog box remains open.

     

The Save As option provides a quick way of copying the preferred gene list so that 
you can make any needed changes to it, and then use it with this panel or another 
panel.
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• To set preferred genes for the panel, then next to the Set Preferred Gene from File 

field, click the Browse button  and in the Open File dialog box, browse to and 

select the appropriate preferred gene file, and then click Open.

The Open File dialog box closes. The full path to the selected preferred gene file is 
displayed in the Set Preferred Gene from File field. 

• To delete the preferred genes for the panel, click Delete Existing, and then click Yes 
in the Delete Existing Preference message. 

The Manage Panels dialog box remain open.

3. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 103.

• “To create a QC Threshold file for panel regions” on page 104.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
105.

• “To set or delete a preferred transcript list for a panel” on page 106.

• “To create a new BED file for a panel by adding or deleting regions” on page 109.

To create a new BED file for a panel by adding or deleting regions

Sometimes, you might need to use a panel that is a combination of two or more BED files. 
After you load a BED file for a panel, you can add regions from an existing BED file to it 
and then save the combined regions as either a new BED file or a panel. You can also delete 
regions from the loaded BED file and save the modified regions as a new BED file or panel.

1. If you have just imported a new panel, then the Manage Panels dialog box is already 
open and the panel regions are displayed; otherwise, do the following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. On the Select Panel dropdown list, select the appropriate panel.

c. Click Download and Edit Panel Regions to display the panel regions on the Manage 
Panels dialog box.

     

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.
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2. Do one or both of the following as needed:

3. On the Manage Panels dialog box, click Save Panel Regions to file.

The Save File dialog box opens. By default, the new BED file is named the same as the 
loaded BED file, and it is saved in the same directory as the loaded BED file. You can 
change one or both of these values.

4. Optionally, change the name for the new BED file, and/or the directory in which to save 
the file, and then click Save. 

The Save File dialog box closes. The Manage Panels dialog box remains open. 

5. If you are done with the configuration of the newly added or edited panel, then click OK 
to close the Manage Panels dialog box and return to the Geneticist Assistant main 
window. Otherwise, continue to any of the following as needed:

• “To manually set new coverage thresholds for panel regions” on page 103.

• “To create a QC Threshold file for panel regions” on page 104.

• “To set new coverage thresholds for panel regions with a QC Threshold file” on page 
105.

• “To set or delete a preferred transcript list for a panel” on page 106.

• “To set or delete a preferred gene for a panel” on page 108.

Action Steps

To add regions from an existing 
BED file

1. Click Add Regions from File.

The Select a file to add to the panel dialog box opens.

2. Browse to and select the appropriate BED file, and then 
click Open to close the dialog box and return to the 
Manage Panels dialog box.

To delete regions from the loaded 
BED file

1. Click the region that is to be deleted. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a panel does not delete the 
panel. To delete the panel itself, see “Deleting a 
Panel” on page 113.
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Editing a Panel
Managing panels includes editing panels that will be used for studying your data in 
Geneticist Assistant.

To edit a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-6:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that is to be modified.

3. Click Download and Edit Panel Regions.

The panel regions are displayed on the Manage Panels dialog box.

4. Do any or all of the following as needed:

• To change the associated panel group, click Change Associated Panel Group, and in 
the Panel Group Association dialog box, make the necessary change.

• To manually set new coverage thresholds for the panel regions, see “To manually set 
new coverage thresholds for panel regions” on page 103.

• To set new coverage thresholds for the panel regions with a QC Threshold file, see 
“To set new coverage thresholds for panel regions with a QC Threshold file” on page 
105.
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• To set a preferred transcript list for the panel, or delete a preferred transcript list, see 
“To set or delete a preferred transcript list for a panel” on page 106.

• To set a preferred gene for the panel, see “To set or delete a preferred gene for a 
panel” on page 108.

• To create a new BED file for the panel, see “To create a new BED file for a panel by 
adding or deleting regions” on page 109.
112 Geneticist Assistant User’s Manual



Chapter 4
Managing Panels and Subpanels
Deleting a Panel
Managing panels includes deleting panels that are no longer needed in Geneticist Assistant.

To delete a panel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens.

Figure 4-7:  Manage Panels dialog box

2. On the Select Existing Panel dropdown list, select the panel that is to be deleted.

3. Click Delete.

A message opens asking you if you are sure that you want to delete the selected panel.

4. Click Yes.

The message closes. The entire panel is deleted, and a second message opens indicating 
that the panel was successfully deleted.

5. Click OK.

The message closes. The Manage Panels dialog box remains open.

When you delete a panel, you delete the entire panel. To simply delete regions from 
a panel, not the entire panel, see “To create a new BED file for a panel by adding 
or deleting regions” on page 109.
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Reviewing Panel Statistics
The Panel Statistics tab has options for reviewing specific information for a selected panel/
panel group. By default, all samples for the panel are included. You can edit the options for 
displaying panel statistics such as setting specific date range, or selecting specific samples or 
runs.

To review panel statistics
1. On the Geneticist Assistant main menu, click Panels > Panel Statistics.

The Panel Statistics tab opens.

2. Select the panel for which the statistics are to be viewed.

3. Change any of the display options for the Panel Statistics tab, and then click OK to laod 
the panel statistics based on the specified options.

The Panel Statistics tab that opens from the Panels menu is identical to the Panel 
Statistics tab that opens from the context menu of the Runs tab or the Run tab. For 
a complete description of this tab, see “To calculate panel statistics (Runs tab)” 
on page 186 or “To calculate panel statistics (Run tab)” on page 222.
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Adding a Subpanel
A subpanel contains a fixed number of regions that are contained within a selected panel. To 
verify coverage for a smaller number of regions that are within the panel that has been 
selected for a run, you can use a subpanel. Managing panels includes adding the new 
subpanels that are to be used for targeting a specific genomic test or study.

To add a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 101.

2. Click Manage Subpanels.

The Manage Subpanels dialog box opens. The first time that the dialog box opens, all 
fields are blank; otherwise, it displays the information for the subpanel that was last 
viewed and/or modified. 

Figure 4-8:  Manage Subpanels dialog box

3. Select the panel for which you are adding the subpanel.

4. Click New Subpanel.

The Add New Subpanel dialog box opens.

Figure 4-9:  Add Subpanel dialog box
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5. Click the Browse button  that is next to the Subpanel File (.bed) field, and then 

browse to and select the BED file for the subpanel that you are adding.

The Subpanel file field is populated with the full directory path to the selected BED file, 
and by default, the subpanel name is set to the name of the selected BED file.

6. Optionally, edit the name for the subpanel.

7. Click OK.

The Add Subpanel dialog box closes. The Manage Subpanels dialog box remains open. 
The information for all the regions (Region Name, Chromosome Number, Region Start, 
and Region End) is displayed in the lower pane of the dialog box.

8. If you are done with the configuration of the newly added subpanel, then click OK to 
close the Manage Subpanels dialog box and return to the Manage Panels dialog box; 
otherwise, continue to “To create a new BED file for a subpanel by adding or deleting 
regions” below.

To create a new BED file for a subpanel by adding or deleting 
regions

Sometimes, you might need to use a subpanel that is a combination of two or more BED 
files. After you load a BED file for a subpanel, you can add regions from an existing BED 
file to it and then save the modified regions as a new BED file or subpanel. You can also 
delete regions from the loaded BED file and save the modified regions as a new BED file or 
subpanel.

1. If you have just created a new subpanel, then the Manage subpanels dialog box is 
already open and all the panel regions for the subpanel are displayed; otherwise, do the 
following:

a. On the Geneticist Assistant main menu, click Panels > Manage Panels to open the 
Manage Panels dialog box.

b. Choose Select existing panel, and then on the Panel dropdown list, select the 
appropriate panel.

If the correct BED file is not available for a subpanel, then you can use the BED 
File Builder tool to create one based on the information that you specify. See 
“Building a BED File with the BED File Builder Tool” on page 335.

You can click Default Name to reset the BED file name to the default value.

When you add regions from an existing BED file to another BED file, all the 
regions are added from the existing BED file. You cannot select specific regions to 
add; however, after all the regions are added, you can delete one or more regions.
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c. Click Manage Subpanels.

d. On the Manage Subpanels dialog box, select the appropriate subpanel.

e. Click View subpanel regions.

2. Do one or both of the following as needed:

3. On the Manage Subpanels dialog box, click Save Panel Regions to a BED file.

The Save File dialog box opens. By default, the new BED file is named the same in the 
following format: <subpanel>_<Panel> and it is saved in the same directory as the 
loaded BED file. You can change one or both of these values.

4. Click OK.

The regions are saved as a subpanel.

Action Steps

To add regions from an existing 
BED file

1. Click the Browse button  that is next to the Add 

Regions from BED File field.

The Select a file to add to the panel dialog box opens.

2. Browse to and select the appropriate BED file, and then 
click Open to close the dialog box and return to the 
Manage Panels dialog box.

3. Click Add Regions.

To delete regions from the loaded 
BED file

1. Click the region that is to be deleted. (CTRL-click to 
select multiple regions.)

2. Right-click the selected regions, and on the context 
menu that opens, click Remove Selected Regions.

Note: Deleting regions from a BED file does not delete the 
subpanel. To delete the subpanel itself, see “Deleting 
a Subpanel” on page 118.
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Deleting a Subpanel
Managing subpanels includes deleting subpanels that are no longer needed in Geneticist 
Assistant.

To delete a subpanel
1. On the Geneticist Assistant main menu, click Panels > Manage Panels.

The Manage Panels dialog box opens. See Figure 4-1 on page 101.

2. Choose Select existing panel, and then on the Panel dropdown list, select the appropriate 
panel.

3. Click Manage Subpanels.

The Manage Subpanels dialog box opens. 

Figure 4-10:  Manage Subpanels dialog box

4. Select the subpanel that is to be deleted. 

     

When you delete a subpanel, you delete the entire subpanel. To simply delete 
regions from a BED file, not the entire subpanel, see “To create a new BED file for 
a subpanel by adding or deleting regions” on page 116.
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5. Click Delete.

A Delete Subpanel message opens, asking you if you are sure that you want to delete the 
selected subpanel from the database.

Figure 4-11:  Delete Subpanel message

6. Click Yes.

The Delete Subpanel message closes, and a Subpanel Deleted message opens, indicating 
that the selected subpanel was successfully deleted.

Figure 4-12:  Subpanel Deleted message

7. Click OK.

The Subpanel Deleted message closes. The Manage Subpanels dialog box remains open. 
The subpanel and its regions are no longer displayed in the dialog box.
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A patient refers to an individual from whom a sample was taken. A run refers to loading a 
BAM file and a VCF file or just a VCF file into Geneticist Assistant for the purposes of 
importing a list of variants into the Geneticist Assistant database and/or reviewing a list of 
variants in a sample. This chapter details how to manage patient settings for your runs and 
how to add a new run in Geneticist Assistant.

This chapter covers the following topics:

• “Adding Patients” on page 123.

• “Accessing and Reviewing Patient Records” on page 128.

• “Adding a Run” on page 169.

     

For information about managing your run settings (chemistries, instruments, and 
so on), see “Managing Objects in the Geneticist Assistant” on page 51.
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Adding Patients
In addition to managing settings (chemistries, instruments, and so on) for your runs, you can 
manage the patients for your runs. A patient refers to an individual from whom a sample was 
taken. Managing patients for your runs consists of adding new patients to the Geneticist 
Assistant database. When you add new patients, you can manually add patients one at a time, 
or you can use the a batch import process to add multiple patients in a single step. Moreover, 
if your VCF or BAM sample file names begin or end with the patient ID, then Geneticist 
Assistant can automatically associate the appropriate sample with the patient, or even create 
the patient record if needed, and then associate the sample with the record. If you are loading 
a standalone VCF file, then just the VCF file name must begin or end with the patient ID. If 
you are loading both a VCF file and a BAM file, then the names for both files must begin 
and/or end with the patient ID.

To add new patients one at a time
When you add a patient one at a time, you can specify the name, birthdate, and gender for the 
patient as well as a unique ID for the patient. You can also add relationships to the patient, 
and you can specify one or more phenotypes for the patient.

1. On the Geneticist Assistant main menu, click File > New Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. 

Figure 5-1:  Add New Patient dialog box, Add Patient tab
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2. Enter the information for the new patient.

3. If applicable, to specify relationships for the new patient, select Is Related to Existing 
Patient and then do the following:

a. Select the relationship type (Sibling (the default value), Child, or Parent).

b. Select the existing patient for this relationship. (Select the patient on the select 
existing patient list, or double-click the patient entry in the All Patients pane.)

c. Click Add.

The Relationships About to Be Added list display the relationship that you have 
specified for the new patient.

Figure 5-2:  Add New Patient dialog box, Relationship options

Option Description

External ID A unique ID for the patient. 

First Name The first name for the patient.

Last Name The last name for the patient.

Birthday The patient’s birthday. You must select each value individually, and then you 
can manually enter a new value, or you can use the Up/Down arrows.

Gender Male or Female.
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4. Repeat Step 3 to add as many relationships for a patient as needed.

5. If applicable, to add a phenotype for the patient, on the Add Phenotype dropdown list, 
select the phenotype, and then click Add. You can repeat this step as many times as 
needed to add multiple phenotypes for the patient.

The added phenotype is displayed in the Phenotype pane.
If

6. Optionally, to add a comment for the phenotype, do one of the following; otherwise, go 
to Step 7.

• In the Comment field, single click twice, enter the comment, and then click 
anywhere outside the field.

• Right-click the phenotype and on the context menu that opens, click Add Patient 
Phenotype Comment.

7. Click OK.

Two results are possible:

• If you have encryption enabled for your Geneticist Assistant instance, then the Add 
New Patient dialog box closes. The new patient record is displayed on the Patients 
tab. For specific identifying information, asterisks (*) are displayed.

• If you do not have encryption enabled for your Geneticist Assistant instance, then an 
Invalid Encryption Certificate Setting dialog box opens, warning you that no 
Encryption Certificate is selected and that data will be submitted without encryption. 
Go to Step 8.

Figure 5-3:  Invalid Encryption Certificate Setting dialog box

8. Click Yes.

Both the Invalid Encryption Certificate Setting dialog box and the Add New Patient 
dialog box close. The new patient record is displayed on the Patients tab, with all 
identifying information fully visible.

If you add a relationship in error, right-click the relationship, and then select 
Remove Selected Rows. CTRL-click to select multiple relationships for deletion.

If the appropriate phenotype is not available, then you can click New Phenotype 
and add it. You can also add phenotypes using the Manage Objects function. See 
“Managing Objects in the Geneticist Assistant” on page 51.
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To add new patients with the batch import process
You use a batch import process to add multiple patients in a single step to the Geneticist 
Assistant database. The batch import file must be either a comma-separated values (.csv) 
file, a tab-delimited text (.txt) file, or a tab-separated values (.tsv) file. The file must contain 
the following columns of information—the patient ID, the patient last name, the patient first 
name, the patient date of birth, the patient gender, the patient race, the patient phenotypes, 
and the patient relationships. Patient relationships must in the format  
patient ID-Relationship, for example, ABS17-Father. Multiple phenotypes and multiple 
relationships must be separated by semi-colons. Figure 5-4 below shows the standard 
column order and the standard column names. If your import file does not follow either the 
standard column order or the standard column names, then you must manually indicate the 
order of the columns in your file. 

Figure 5-4:  Standard column order and names

1. On the Geneticist Assistant main menu, click File > New Patient.

The Add New Patient dialog box opens. The Add Patient tab is the opened tab. See 
Figure 5-1 on page 123.

2. Click the Batch Import tab to open it.

Figure 5-5:  Add New Patient dialog box, Batch Import tab
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3. Next to the Patient File field, click the Browse button , and then browse to and select 

your patient file.

4. Specify the properties of your patient file.

5. If your file follows the standard column order or the standard column names, go to Step 
8; otherwise, if your file does not follow either of these standards, go to Step 6.

6. In the Result pane, rearrange the column headers so that they are in the same order as the 
column headers in your patient file.

7. Click Check With File.

• The file is loaded and the patient information is displayed in the Result pane. If your 
file format is correct, go to Step 8.

• If your file format is incorrect then, you must click Incorrect, Redo, and then make 
the necessary changes to the column headers. Click Check With File again to verify 
that your file has the correct format. Only after you verify that your file has the 
correct format can you continue to Step 8.

8. Click OK.

The Add New Patient dialog box closes. The patients, and if applicable, any new 
phenotypes, are imported into your Geneticist Assistant database.

Property Description

Add New Phenotype Terms in 
File Automatically

Selected by default. If the patient file contains phenotypes that 
have not already been added to the Geneticist Assistant 
database either through the Manage Objects function (see 
“Managing Objects in the Geneticist Assistant” on page 51), or 
the Add Phenotype option on the Add Patient tab (see “Patient 
tab, Patient sub-tab, Phenotype pane” on page 139), then leave 
this option selected to automatically add these phenotypes to 
the database. Otherwise, clear this option. 

Data Delimiter Indicate the delimiter used (Comma or Tab).

Date of Birth Format Select the format used for the patients’ birthdays.

File Column Format Select one of the following to indicate the file format. 

• File follows standard column order.

• File follows standard column names.

• File does not follow above standards. I want to specify.

For information about rearranging columns, see “To rearrange the order of data 
columns” on page 42.
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Accessing and Reviewing Patient Records
In addition to managing settings (chemistries, instruments, and so on) for your runs, you can 
manage the patients for your runs. A patient refers to an individual from whom a sample was 
taken. Managing patients for your runs consists of a variety of different activities, including 
reviewing and editing information (such as adding comments relationships) for existing 
patients and related patients, and generating, and optionally, saving Patient reports to the 
Geneticist Assistant database. You can work with patient information from the Patients tab or 
from the Patient tab.

To review existing patient information on the Patients tab
The Patients tab has a single pane, the Patients pane, for displaying information for existing 
patients. When you review the information for an existing patient, a variety of options are 
available for working with the patient, such as editing the identifying information for a 
patient, and adding relationships and comments for the patient. 

1. On the Geneticist Assistant main menu, click Tabs > Patients.

The Patients tab opens.

• If you are an Administrator user, then the tab can display all the patients that have 
been added by all users to your Geneticist Assistant database. By default, when the 
tab first opens, only up to the 30 most recently added patients are displayed and the 
patients are sorted based on Patient ID. 

• If you are a standard user, then the tab can display all the patients that you have 
added to the Geneticist Assistant database as well as all the patients that others users 
have added to the database and for which you have been granted at least the Can 
Read permission. By default, when the tab first opens, only up to the 30 most 
recently added patients that fit one of these two criteria are displayed and the 
patients are sorted based on Patient ID.

Figure 5-6:  Patients tab
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2. Optionally, do any or all of the following as needed:

• Change the number of patients by which to limit the display.

• If you are an Administrator user, clear the Limit Patients by Number option to 
display all the patients that have been added to your Geneticist Assistant database.

• If you are a standard user, clear the Limit Patients by Number option to display all 
the patients you have added to the Geneticist Assistant database as well as all the 
patients that have been added by other users and for which you have been granted at 
least the Can Read permission.

3. Do any or all of the following as needed for a patient on the Patients tab:

• Edit the identifying information and/or comment for a patient. See “To edit the 
identifying information and/or comment for a patient” below.

• Right-click a patient on the tab to open a context menu with options for working 
with the patient. See “To use the context menu for a patient (Patients tab)” on page 
131.

• Open the corresponding Patient tab. See “To review existing patient information on 
the Patient tab” on page 134.

To edit the identifying information and/or comment for a patient

You can edit the identifying information and/or a comment for a patient on the Patients tab.

1. If you have not already done so, open the Patients tab.

2. For the patient for whom you are editing the identifying information and/or comment, do 
any or all of the following as appropriate:

• On the Gender dropdown list, select the appropriate gender.

• On the Ethnicity dropdown list, select the appropriate ethnicity.

• Single click twice in any of the identifying information fields (External ID, First 
Name, Last Name, or Date of Birth), and then do the following:

i Add or edit the information as needed, and then click anywhere out of the field.

The Edit Patient dialog box opens. The dialog box displays the current value for 
the identifying information, if applicable, and the new value. See Figure 5-7 on 
page 130.

If the appropriate ethnicity is not available, you can add it. See “Managing 
Objects in the Geneticist Assistant” on page 51.

If you are changing the Date of Birth for the patient, then you must select one 
value (month, day, or year) at a time, and then you can manually enter a a new 
value, or you can use the Up/Down arrows to change the value.
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Figure 5-7:  Edit Patient dialog box, Last Name selected for editing

ii. If needed, make any other changes to the new value, and then click OK.

The Edit Patient dialog box closes. The Patients tab remains open. The patient 
record is displayed with the new information.

• Single-click twice in the Comment field, and then do the following:

i Enter a new comment, or edit the existing comment as needed, and then click 
anywhere out of the field.

The Update Patient Comment dialog box opens. The dialog box displays the 
current comment, if applicable, and the new or edited comment.

Figure 5-8:  Update Patient Comment dialog box

ii. If needed, make any other changes to the new value, and then click OK.

The Update Patient Comment dialog box closes. The Patients tab remains open. 
The patient record is displayed with the new information.

For any information other than the External ID, the dialog box also displays the 
External ID, and you cannot edit this value.
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To use the context menu for a patient (Patients tab)

You can right-click any patient on the tab to open a context menu with the following options 
for reviewing and working with the patient record:
 

Table 5-1: Patients tab context menu 

Option Description

Patient Detail Opens the Patient tab. 

Note: You can also double-click a patient to open the Patient tab.

Add New Relationships Opens the Add New Patient dialog box so that you can add a relationship to the 
selected patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add new patients one at a time” on page 123 as 
many times as needed to add all the necessary patient relationships to the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patients for inclusion in a custom report. 
See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Delete Patient Deletes the selected patient from the Geneticist Assistant database. 

Add Comment Opens the Add Patient Comment dialog box. You add a comment for the selected 
patient in the Add Comment field. The comment is displayed in the Last Comment field 
and in the Comments pane on the Patient sub-tab on the Patient tab. See “Patient tab, 
Patient sub-tab, Comments pane” on page 144.

Figure 5-9:  Add Patient Comment dialog box

Note: If multiple comments have been added for a patient, then the comment that was 
added last is displayed in the Last Comment field. All comments that have been 
added for the patient are displayed in reverse chronological order in the 
Comments pane on the Patient tab.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit 
the permissions (Can Read or Can Read and Can Write) that the specified users or 
groups are to have for the patient record. If you are an Administrator user, then you can 
set or edit the permissions for a patient record that any user has added. If you are a 
standard user, then you can set or edit the permissions for only those patient records 
that you have added to the Geneticist Assistant database, or for those patient records 
that other users have added and to which you have been granted Can Read and Can 
Write permissions. See “To set or edit the Read/Write permissions for patient records 
(Patients tab)” on page 133.
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Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the 
current owner for the patient, and an option (New Owner) for selecting a new owner for 
the patient from a list of all the currently available and active users for your Geneticist 
Assistant instance. You can change the ownership for any patient if you are an 
Administrator user, the current owner of the patient, or if you have been granted Can 
Read and Can Write permissions for the patient.

Figure 5-10:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed for the selected patient to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.

Load Filters

Manually Opens the Filters table for the Patients pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Patients pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Table 5-1: Patients tab context menu (Continued)

Option Description
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To set or edit the Read/Write permissions for patient records (Patients tab)

If you are an Administrator user, then you can set or edit the permissions for a patient record 
that any user has added. If you are a standard user, then you can set or edit the permissions 
for only those patient records that you have added to the Geneticist Assistant database, or for 
those patient records that other users have added and to which you have been granted Can 
Read and Can Write permissions.

1. If you have not already done so, open the Patients tab.

2. Select the patient or CTRL-click to select the multiple patients for which the permissions 
are being set.

3. Right-click any selected patient, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the names of all the users 
and/or groups and their assigned permissions for the patient records

Figure 5-11:  Permissions dialog box (Patient tab)

4. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the patient records. They cannot edit 
them.

7. Optionally, if the user or group must be able to edit the patient records as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient records.

To review existing patient information on the Patient tab
The Patient tab has three sub-tabs: Patient, Samples, and Variants. Each sub-tab has different 
panes for displaying and working with patient information. 

1. If you have not already done so, open the Patients tab. 

2. Do one of the following to open the Patient tab:

• Right-click the patient record that you are reviewing, and on the context menu that 
opens, click Patient Detail.

• Double-click the patient record that you are reviewing.

3. Continue to one of the following:

• “Patient tab, Patient sub-tab” on page 135.

• “Patient tab, Samples sub-tab” on page 147.

• “Patient tab, Variants sub-tab” on page 159.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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Patient tab, Patient sub-tab

When a Patient tab first opens, the Variants sub-tab is the active tab. Click the Patient sub-tab 
to open it.

Figure 5-12:  Patient tab, Patient sub-tab

The Patient sub-tab has six panes for displaying and working with patient information. 

Pane Available Options

Patient • Editing the identifying information for a patient.

• Adding relationships to the patient.

• Creating a report for the patient.

• Adding comments for the patient.

• Settings permissions for the patient.

• Specifying the ownership for the patient.

See “Patient tab, Patient sub-tab, Patient pane” on page 136.

Phenotypes Adding and removing phenotypes for the patient. See “Patient tab, Patient sub-
tab, Phenotype pane” on page 139.

Related Patients • Adding relationships to a related patient.

• Removing relationships for a related patient.

• Adding comments for the related patient.

• Settings permissions for the related patient.

• Specifying the ownership for the related patient.

See “Patient tab, Patient sub-tab, Related Patients pane” on page 141.

Comments • Adding comments for a patient.

• Deleting comments for a patient.

See “Patient tab, Patient sub-tab, Comments pane” on page 144.
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Patient tab, Patient sub-tab, Patient pane

The Patient pane on the Patient sub-tab shows the identifying information for the patient (ID, 
name, and so on). You can edit any of the identifying information as needed for the patient. 
(Begin at Step 2 of “To edit the identifying information and/or comment for a patient” on 
page 129.) You can also right-click any patient record in the pane to open a context menu 
with the following options:

Reports • Viewing a Patient report that was saved to the Geneticist Assistant 
database.

• Deleting a Patient report that was saved to the Geneticist Assistant 
database.

See “Patient tab, Patient sub-tab, Reports pane” on page 146.

Barcodes Viewing all the barcodes that are associated with the patient in the Geneticist 
Assistant customer portal. 

See “Patient tab, Patient sub-tab, Barcodes pane” on page 147.

Pane Available Options

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu 

Option Description

Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
patient. By default, the Is Related to Existing Patient option is selected and unavailable. 
Repeat Step 3 of “To add new patients one at a time” on page 123 as many times as 
needed to add all the necessary patient relationships to the patient.

Add All to Custom 
Report

Selects all the data that is displayed for the patient for inclusion in a custom report. See 
Chapter 11, “Geneticist Assistant Reports,” on page 313.

Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 
Add Comment field. The comment is displayed in the Last Comment field in the pane and 
in the Comments pane. See “Patient tab, Patient sub-tab, Comments pane” on page 144.

Figure 5-13:  Add Patient Comment dialog box

Note: If multiple comments have been added for a patient, then the comments are 
displayed in reverse chronological order in the Comments pane. Only the last 
comment added is displayed in the Last Comment field. 
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Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record. If you are an Administrator user, then you can set or edit the 
permissions for a patient record that any user has added. If you are a standard user, then 
you can set or edit the permissions for only those patient records that you have added to 
the Geneticist Assistant database, or for those patient records that other users have added 
and to which you have been granted Can Read and Can Write permissions. See “To set or 
edit the Read/Write permissions for a patient record (Patient tab)” on page 138.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the patient, and an option (New Owner) for selecting a new owner for the patient 
from a list of all the currently available and active users for your Geneticist Assistant 
instance. You can change the ownership for any patient if you are an Administrator user, 
the current owner of the patient, or if you have been granted Can Read and Can Write 
permissions for the patient.

Figure 5-14:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed in the Patient pane for the patient to your 
client’s clipboard. You can then use standard Paste commands to paste this copied 
information into a third-party application such as Notepad.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description
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To set or edit the Read/Write permissions for a patient record (Patient tab)

If you are an Administrator user, then you can set or edit the permissions for a patient record 
that any user has added. If you are a standard user, then you can set or edit the permissions 
for only those patient records that you have added to the Geneticist Assistant database, or for 
those patient records that other users have added and to which you have been granted Can 
Read and Can Write permissions.

1. If you have not already done so, open the Patient sub-tab on the Patient tab.

2. Right-click the patient record, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the name of all the users 
and/or groups and their assigned permissions for the patient record.

Figure 5-15:  Permissions dialog box (Patient tab)

3. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 4.

     

Load Filters

Manually Opens the Filters table for the Patient pane. See “To filter the data that is displayed in a tab 
pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Patient pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-2: Patient tab, Patient sub-tab, Patient pane context menu (Continued)

Option Description

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
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4. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

5. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the patient record. They cannot edit it.

6. Optionally, if the user or group must be able to edit the patient record as well, then select 
the Can Write permission.

7. Click OK.

A Permission Updated message opens. 

8. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient record.

Patient tab, Patient sub-tab, Phenotype pane

The Phenotype pane on the Patient sub-tab shows all the phenotypes that have been added 
for the patient, and if applicable, the associated comments that have been added for each 
phenotype. You can right-click in the pane to open a context menu with the following 
options:

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.

Table 5-3: Patient tab, Patient sub-tab, Phenotypes pane context menu 

Option Description

Add All to Custom 
Report

Selects all the data that is displayed in the Phenotype pane for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Delete Phenotype Deletes the selected phenotype for the patient.
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Add Phenotype Opens the Add Phenotype dialog box. The Phenotypes dropdown list contains all the 
phenotypes that are currently available in the Geneticist Assistant database that you can 
add for the patient. You can add multiple phenotypes for the patient. You can also add a 
comment for each phenotype that you add for the patient.

Figure 5-16:  Add Phenotype dialog box

Note: If the appropriate phenotype is not available, then you can click New to add it to the 
Geneticist Assistant database. You can also use the Manage Objects function to 
add a phenotype to the Geneticist Assistant database. See “Managing Objects in 
the Geneticist Assistant” on page 51.

Delete Phenotype Deletes the selected phenotype from the patient record. The phenotype is not deleted from 
the Geneticist Assistant database.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Phenotypes pan. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Phenotypes pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-3: Patient tab, Patient sub-tab, Phenotypes pane context menu (Continued)

Option Description
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You can single click twice in the Comment field in the Phenotypes pane to select the current 
comment in the field and edit it, or if the field is blank, enter a new comment. After you add 
or edit a comment, and then click out of the field, the Update Phenotype Comment dialog 
box opens. The dialog box displays the phenotype for which you are adding or editing the 
comment, the current (old) comment, and the new comment. You can make additional edits 
to the new comment as needed, and then click OK to close the dialog box and save the new 
or modified comment for the phenotype. 

Figure 5-17:  Update Phenotype Comment dialog box

Patient tab, Patient sub-tab, Related Patients pane

The Related Patients pane on the Patient sub-tab shows all the current relationships for the 
patient, and the last comment that was added for each related patient. You can  
double-click a patient on the Related Patients tab to display the information for the related 
patient in a new Patient tab. The currently opened Patient tab remains open, but the focus is 
changed to the new Patient tab. You can right-click in the pane to open a context menu with 
the following options:

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu 

Option Description

Reload in Current 
Tab

Displays the information for the selected related patient in the currently opened Patient 
tab. 

Open in New Tab Displays the information for the selected related patient in a new Patient tab. The currently 
opened Patient tab remains open, but the focus is changed to a new Patient tab that 
displays the information for the related patient.

Add New 
Relationships

Opens the Add New Patient dialog box so that you can add a relationship to the selected 
related patient. By default, the Is Related to Existing Patient option is selected and 
unavailable. Repeat Step 3 of “To add new patients one at a time” on page 123 as many 
times as needed to add all the necessary patient relationships to the related patient.

Remove Selected 
Relationship

Removes the selected relationship for the patient.

Add All to Custom 
Report

Selects all the data that is displayed for all the related patients for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.
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Add Comment Opens the Add Comment dialog box. You add a comment for the selected related patient 
in the Add Comment field. The comment is displayed in the Last Comment field in the 
pane. 

Figure 5-18:  Add Comment dialog box

Note: If multiple comments have been added for a related patient, then only the last 
comment added is displayed in the Last Comment field. To see all the comments 
that have been added for a related patient, you must open the related patient in a 
new Patient tab.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record. If you are an Administrator user, then you can set or edit the 
permissions for a patient record that any user has added. If you are a standard user, then 
you can set or edit the permissions for only those patient records that you have added to 
the Geneticist Assistant database, or for those patient records that other users have added 
and to which you have been granted Can Read and Can Write permissions. See “To set or 
edit the Read/Write permissions for a patient record (Patient tab)” on page 138.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the related patient, and an option (New Owner) for selecting a new owner for the 
related patient from a list of all the currently available and active users for your Geneticist 
Assistant instance. You can change the ownership for any patient if you are an 
Administrator user, the current owner of the patient, or if you have been granted Can Read 
and Can Write permissions for the patient.

Figure 5-19:  Change Patient Ownership dialog box

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu (Continued)

Option Description
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Copy Copies all the information that is displayed for the related patient to your client’s clipboard. 
You can then use standard Paste commands to paste this copied information into a  
third-party application such as Notepad.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-4: Patient tab, Patient sub-tab, Related Patients pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Comments pane

The Comments pane on the Patient sub-tab shows all the comments that have been added for 
the patient in reverse chronological order. You can right-click in the pane to open a context 
menu with the following options:

Table 5-5: Patient tab, Patient sub-tab, Comments pane context menu 

Option Description

Add Comment Opens the Add Comment dialog box. You add a comment for the selected patient in the 
Add Comment field. The Comments are displayed in reverse chronological order in the 
pane.

Figure 5-20:  Add Comment dialog box

Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the patient and 
close the dialog box.

Figure 5-21:  Delete Comment dialog box

Copy Copies all the information that is displayed for the selected comment to your client’s 
clipboard. You can then use the standard Paste commands to paste this copied 
information into a third-party application such as Notepad.
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Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Comments pan. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-5: Patient tab, Patient sub-tab, Comments pane context menu (Continued)

Option Description
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Patient tab, Patient sub-tab, Reports pane

The Reports pane on the Patient sub-tab lists all the reports that have been generated for the 
selected patient and saved to the Geneticist Assistant database. 

You can right-click a report entry to open a context menu with the following options:

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a (Patient) Reports tab that includes these same reports.

Table 5-6: Patient tab, Patient sub-tab, Reports pane context menu 

Option Description

View Report Opens the Report Browser dialog box, which displays the report in plain text.

Note: You can also double-click the report entry to open the Report Browser dialog box.

Figure 5-22:  Report Browser dialog box

The following options are available for the report:

• View XML - Toggles the onscreen display of the report between XML and plain text.

• Save As - Saves the report as a .csv file. By default, the report is named as <External 
ID>.csv but you can always change the name and you can also select the location in 
which to save the report.

• Print—Prints the onscreen report to a printer of your choice.

Delete Report Deletes the selected report from the Geneticist Assistant database.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.
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Patient tab, Patient sub-tab, Barcodes pane

The Barcodes pane on the Patient sub-tab lists all the barcodes that are associated with the 
patient in the Geneticist Assistant customer portal. You can use these barcodes to validate 
that the correct patient/sample combination was submitted to the customer portal and to 
confirm sample identity when you are reviewing a sample in Geneticist Assistant. See 
Chapter 13, “The Geneticist Assistant Customer Portal and Submissions,” on page 351.

Patient tab, Samples sub-tab

The Samples sub-tab on the Patient tab has a single pane, the Samples pane, that displays all 
the samples that are associated with the patient as well as information about the samples. 

Figure 5-23:  Patient tab, Samples sub-tab

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Reports pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Reports pane. Limits the display in the pane to only 
the data (fields) that are defined by the template. See “To filter the data that is displayed in 
a tab pane” on page 32.

Table 5-6: Patient tab, Patient sub-tab, Reports pane context menu (Continued)

Option Description

For detailed information about generating and saving both standard and custom 
Patient reports, see Chapter 11, “Geneticist Assistant Reports,” on page 313.
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You can do the following on the Samples sub-tab:

• View the information for an individual sample.

• View the coverage information for all regions in a sample panel.

• Delete the association between a selected sample and the patient and delete the sample 
from the Geneticist Assistant database.

• Generate a Batch Variants report for the selected sample.

• Generate a Batch Coverage report for the selected sample.

• Add or edit a comment for a sample.

• Change the ownership for a sample.

• Set sample permissions.

You can right-click a sample in the Samples pane to open a context menu with the following 
options for working with the sample:

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu 

Option Description

Sample Details Opens the Sample tab, which contains detailed information about the associated sample, 
including the variant list. See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” 
on page 243.

Note: You can also double-click the sample to open the Sample tab.

Coverage Regions Opens the Coverage Regions tab, which lists the coverage information for every region in 
the panel for the associated sample. See “Coverage Regions tab” on page 217.

Delete Sample Deletes the association between the sample and the patient and removes the sample 
entry from the Samples pane.

Add All to Custom 
Report

Selects all the data that is displayed for all the associated samples in the run for inclusion 
in a custom report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Create Batch 
Variants Report

Generates the Batch Variants report for the selected associated sample or samples. 
(Press and hold the CTRL to select multiple samples.) See “To manage a Batch Variants 
report (Samples sub-tab on the Patient tab)” on page 151.

Create Batch 
Coverage Report

Generates the Batch Coverage report for the selected associated sample or samples. 
(Press and hold the CTRL to select multiple samples.) See “To generate a Batch Coverage 
report (Samples sub-tab on the Patient tab)” on page 155.
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Add Comment Opens the Add Sample Comment dialog box. You add a comment for the associated 
sample in the Add Comment field. The comment is displayed in the Comments field in the 
Samples pane.

Figure 5-24:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then these comments are 
displayed in reverse chronological order in the Comments pane on the Sample Data 
sub-tab for the Sample tab. Only the last added comment is displayed in the 
Comments field in the Samples pane on the Samples data sub-tab on the Patient 
tab and in the Samples pane on the Run tab. 

Change Ownership Opens the Change Sample Ownership dialog box, which displays the name of the current 
owner for the associated sample, and an option (New Owner) for selecting a new owner 
for the sample. You can change the ownership for any sample if you are an Administrator 
user, the current owner of the sample, or if you have been granted Can Read and Can 
Write permissions for the sample.

Figure 5-25:  Change Sample Ownership dialog box

Permissions Opens the Permissions dialog box. You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient sample. If you are an Administrator user, then you can set or edit the 
permissions for a sample in a patient record that any user has added. If you are a standard 
user, then you can set or edit the permissions for samples in only those patient records 
that you have added to the Geneticist Assistant database, or for those patient records that 
other users have added and to which you have been granted Can Read and Can Write 
permissions. See “To set or edit the Read/Write permissions for a sample that is 
associated with a patient” on page 158.

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
Geneticist Assistant User’s Manual 149



Chapter 5
Managing Patients and Runs
     

Copy Copies all the information that is displayed for the selected associated sample to your 
client’s clipboard. You can then use standard Paste commands to paste this copied 
information into a third-party application such as Notepad.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Samples pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-7: Patient tab, Samples sub-tab, Samples pane context menu (Continued)

Option Description
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To manage a Batch Variants report (Samples sub-tab on the Patient tab)

A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to save reports for multiple samples in a single step. A Batch 
Variants report configuration determines the data that is to be included in the report. You can 
choose if the configuration is to be available only to the user who created it, or to all users. 
The configuration does not include the report format (PDF, HTML and so on), or the location 
in which the report is to be saved. Instead, you must specify the format and location in which 
to save the report every time you generate a report for a new or saved configuration.

Figure 5-26:  Batch Variants Report dialog box

You can generate a Batch Variants report according to a new or saved configuration, edit a 
Batch Variants report configuration, or delete a Batch Variants report configuration. See:

• “To generate a Batch Variants report based on a new configuration” below.

• “To generate a Batch Variants report based on a saved configuration” on page 153.

• “To edit a Batch Variants report configuration” on page 154.

• “To delete a Batch Variants Report configuration” on page 155.

To generate a Batch Variants report based on a new configuration
 

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for which you are generating the report (for example, 
76_800458.variants.filter) and you cannot change this. You must select a location in which to 
save the report.

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.
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3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

9. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box with a message that 
indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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To generate a Batch Variants report based on a saved configuration
  

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure 5-27:  Load Configuration dialog box

8. Select a configuration, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.
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11. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box with a message that 
indicates that the report was generated and where the report was saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To edit a Batch Variants report configuration
 

When you edit a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 

4. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

5. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

6. To edit the report configuration, see “To create/edit a pane configuration” on page 39.

7. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

8. Click OK.

The Batch Variants report is generated for all selected samples. After the report is 
successfully generated, a Batch Variants Report Finished dialog box opens, with a 
message that indicates where the report was saved.
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9. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants Report configuration
 

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

5. See “To delete a pane configuration” on page 41.

6. Click Close (x) to close the Batch Variants Report dialog box.

To generate a Batch Coverage report (Samples sub-tab on the Patient tab)

The Batch Coverage report generates a coverage report for each of the selected samples for 
the patient in a specific panel or panels and panel group. The report also includes coverage 
statistics for the panel that are calculated based on one of the following options: 

• All panel samples or selected panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

1. If you have not already done so, the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the Batch Coverage report is to be generated.

     

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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3. Right-click on any selected sample, and on the context menu that opens, click Export > 
Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the selected samples for the run are 
displayed in the bottom pane of the dialog box. If multiple samples are selected with 
different panels, then a separate tab is displayed for each panel. 

Figure 5-28:  Batch Coverage Report dialog box (Runs tab)

4. Leave the report type set to the default value of HTML, or select a different report type.

5. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the report.

6. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options (listed in the table below) by which to 
calculate the panel coverage statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. By default, all the runs for the panel 
are displayed in the dialog box. Select the appropriate run, or CTRL-click to 
select multiple runs, and then click OK.

Figure 5-29:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. By default, all 
the samples for the panel are displayed in the dialog box. Select the 
appropriate sample, or CTRL-click to select multiple samples, and then click 
OK.

Figure 5-30:  Select Samples dialog box

Option Description
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After you click OK to generate the report, the Current Jobs tab opens. The tab displays the 
progress of calculating the coverage information for every sample that was selected for the 
report. A report file is saved in the specified format and the specified location. 

To set or edit the Read/Write permissions for a sample that is associated with 
a patient

If you are an Administrator user, then you can set or edit the permissions for a sample in a 
patient record that any user has added. If you are a standard user, then you can set or edit the 
permissions for samples in only those patient records that you have added to the Geneticist 
Assistant database, or for those patient records that other users have added and to which you 
have been granted Can Read and Can Write permissions.

1. If you have not already done so, open the Patient tab.

2. On the Samples sub-tab, select the sample or CTRL-click to select the multiple samples 
for which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the names of all the users 
and/or groups and their assigned permissions for the sample

Figure 5-31:  Permissions dialog box (Samples sub-tab on the Patient tab)

4. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

If the report is to be generated based on only a small number of samples, such as 
two to four, then, before the statistics are calculated, a Very few samples message 
dialog box opens, warning you of this and asking you if you want to continue. You 
can click Yes, or you can click Cancel to return to the Runs tab.

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.
158 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can view the sample record. They cannot edit it.

7. Optionally, if the user or group must be able to edit the sample record as well, then select 
the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample record.

Patient tab, Variants sub-tab

The Variants sub-tab on the Patient tab has a single pane, the Variants pane, that displays all 
the variants in all the samples that are associated with the patient. With the exception of a 
few omitted columns, the information that is available in the Variants pane is identical to the 
information that is available for a variant on the Sample Variant Data sub-tab on the Sample 
tab. (See “Sample Variant Data Sub-Tab” on page 246.) 

Figure 5-32:  Patient tab, Variants sub-tab

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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You can specify how the information about the variants is to displayed on the Variants sub-
tab. See “To specify variant preferences” on page 65. You can also do the following for an 
individual variant that is displayed on the Variants sub-tab:

• Select a different gene for a variant: If the variant is located where there are overlapping 
genes, then you can select a different gene for the variant on the Gene dropdown list. If 
you select a different gene, then the gene that is used on the current tab for the current 
Geneticist Assistant session is temporarily changed. After you close and then re-open 
Geneticist Assistant, the selected gene is reset to the preferred gene. To permanently 
change the gene that is used for variant, you can add a preferred gene for the panel. See 
“To set or delete a preferred gene for a panel” on page 108.

• Select a different transcript for a variant: You can select a different transcript for the 
variant on the Transcript dropdown list. If you select a different transcript, then the 
transcript that is used on the current tab for the current Geneticist Assistant session is 
temporarily changed. After you close and then re-open Geneticist Assistant, the selected 
transcript is reset to the preferred transcript. 

• Add or edit a comment for a variant: You can single click twice in the Variant Comment 
field to select the current comment in the field and edit it, or if the field is blank, enter a 
new comment. After you add or edit a comment, and then click out of the field, the Update 
Variant Comment dialog box opens. 

Figure 5-33:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or 
modified comment for the variant.

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript, or you can add a 
preferred transcript list for the panel. See “To set or delete a preferred transcript 
list for a panel” on page 106.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. 
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• Edit the type field, zygosity field, and/or the HGVS information (Genomic, Coding, and/
or Protein) for a variant: You can click once in the Type field, the Zygosity field, the 
HGVS Genomic field, the HGVS Coding field, the HGVS Protein field, and the Read 
Balance field to select the current value in the field and edit it, or if the field is blank, enter 
a new value.

You can right-click a variant on the Variants sub-tab to open a context menu with the 
following options: 

If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 299. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in Geneticist 
Assistant.

Table 5-8: Patient tab, Variants sub-tab context menu 

Option Description

Variant Details Opens the Variant tab for the selected variant. See “Overview of the Variant Tab” on 
page 293.

Note: You can also double-click the variant to open the Variant tab. 

Show Variants Filtered 
by Panel

Displays all the variants in all the associated samples for the selected patient filtered by 
a selected panel or panels. If you select this option, then the Select Panel to Filter 
Variants dialog box opens. You must select a panel or panels in this dialog box by 
which to filter the variants for the selected patient. 

Figure 5-34:  Select Panel to Filter Variants dialog box

Show Samples with 
Selected Variants

Opens the Samples with variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain the selected variant. You can right-click a 
sample in the list to open a context menu with sample-specific options. See “The 
Samples Pane (Run tab) Context Menu” on page 207.
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Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for a selected 
variant in the Add Comment field, and then click OK. You can also CTRL-click to select 
multiple variants and add the same comment to all the selected variants in a single 
step. The comment is displayed in the Variant Comment field in the Variants pane on 
the Search Results tab, the Variant Comment field on the Variants sub-tab on the 
Patient tab, the Sample Variant Data sub-tab on the Sample tab, the Variant Comment 
field in the Variant pane on the Variant tab, and the Variant Comments pane on the 
Variant tab.

Figure 5-35:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity Opens the Submit Pathogenicity dialog box. You can update the pathogenicity and/or 
pathogenicity status for the selected variant in this dialog box. You can also add a 
comment for the variant. By default, the pathogenicity is always set to an initial value of 
Unassigned. You must review the information for the variant and then decide what the 
pathogenicity should be. After you set the pathogenicity for a variant, the next time that 
the variant is detected in another sample, this is the pathogenicity that is displayed for 
the variant. 

Figure 5-36:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box. You also CTRL-click to select multiple variants for 
updating the pathogenicities and the pathogenicity statuses at the same time.

Note: You can also update the Pathogenicity and the Pathogenicity Status for a variant 
on the Sample Variant Data sub-tab on the Sample tab.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely 
Benign, and Benign—are available. You have the option of adding custom 
pathogenicities. See “Managing Objects in the Geneticist Assistant” on page 51.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 303.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Update Pathogenicity Status” below.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Opens the Update Variant Pathogenicity Status dialog box. You can update the 
pathogenicity status for the selected variant in this dialog box. You can also add a 
comment for the variant.

Figure 5-37:  Update Variant Pathogenicity Status dialog box

The following information is relevant to updating the pathogenicity status for a variant:

• You can also double-click in the Pathogenicity Status column to open the Update 
Variant Pathogenicity Status dialog box.

• You can CTRL-click to select multiple variants for updating the pathogenicity 
statuses at the same time.

• You can also update the Pathogenicity Status for a variant on the Sample Variant 
Data sub-tab on the Sample tab.

• By default, only two statuses, Pending or Confirmed, are available. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects in the 
Geneticist Assistant” on page 51.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Artifact Type Opens the Update Artifact Type dialog box. You specify the artifact type (for example, 
Sequencing) for the variant in this dialog box. If the appropriate artifact type is not 
available, then an option is provided to create a new type.

Figure 5-38:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of 
the sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the 
same time.

• You can also define artifact types and set the artifact type for a variant in the Variants 
pane, on the Variants sub-tab on the Panel Statistics tab from the Runs tab or the 
Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

• By default, only a single artifact type, None, is available. You have the option of 
adding custom artifact types. See “Managing Objects in the Geneticist Assistant” on 
page 51.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Update Preferred 
Transcript

Opens the Update Preferred Transcript dialog box. You can select a different preferred 
transcript for the variant on the Change Transcript To dropdown list. 

Figure 5-39:  Update Preferred Transcript dialog box

Note: When you select a different transcript here, then the preferred transcript that is 
used for a gene or genes is permanently changed for the panel. You can also 
permanently change the preferred transcript by adding a preferred transcript list 
for the panel. See “To set or delete a preferred transcript list for a panel” on page 
106. To temporarily change the preferred transcript for a gene or genes, you 
simply select the transcript on the Transcript dropdown list on a tab or sub-tab.

External - Contains all the sub-menu options for viewing the variant in third-party tools.

View in Alamut Opens the variant for viewing in Alamut.

Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 
specify Alamut settings” on page 67.

View in UCSC Opens the variant for viewing in the UCSC Genome Browser. 

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
window. 

Figure 5-40:  PubMed window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 

navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variant for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 11, “Geneticist Assistant 
Reports,” on page 313.

Add All Variants to 
Custom Report

Selects all data that is displayed for all the variants for inclusion in a custom report. See 
Chapter 11, “Geneticist Assistant Reports,” on page 313.

Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Copy Copies the information for the selected variant to your client’s clipboard. You can use 
standard Paste commands to paste the copied information in to a third-party application 
such as Notepad.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 5-8: Patient tab, Variants sub-tab context menu (Continued)

Option Description
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Adding a Run
A run refers to loading a BAM file and a VCF file or just a VCF file into Geneticist 
Assistant. for the purposes of importing a list of variants into the Geneticist Assistant 
database and/or reviewing a list of variants. When you add a run, you must specify the run 
and sample settings, which include the chemistry, the instrument, the reference, the panel, 
and the panel group. You must also select the files that are to be loaded. Optionally, you can 
choose to edit the run date/time and/or assign the run to a sample group. You specify these 
settings on a per run basis, or you specify these settings on a per sample basis. At a 
minimum, you must always load a VCF file. Optionally, you can also load a BAM file to 
include coverage information for the panel regions.

To add a run
1. On the Geneticist Assistant main menu, click File > New Run.

The New Run dialog box opens.

Figure 5-41:  New Run dialog box

2. Enter the name for the new run.

     

The name can have a maximum of 255 characters. Spaces are allowed.
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3. Specify the run settings. 

Setting Description

Required Settings

Chemistry If the correct chemistry is not available, then you can add it. Click New 
to open the Add New Chemistry dialog box and add the new chemistry. 

Instrument If the correct instrument is not available, then you can add it. Click New 
to open the Add New Instrument dialog box and add the new 
instrument. 

Reference If the correct references are not available, then you might need to 
specify the reference directory and/or add the necessary references to 
the directory. For information about specifying the reference directory, 
see “Specifying your Geneticist Assistant Settings” on page 55. For 
information about downloading the most recent references, see 
“Updating References” on page 46.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Panel After you select a panel, the panel group is automatically selected and 
the name is displayed in the Panel Group field.

Note: If the correct panel is not available, then you can add it. Click New 
to open the Manage Panels dialog box and import the needed 
panel. See “Importing a Panel” on page 101. 

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Case If appropriate, select the case to which the run is to be assigned; 
otherwise, leave the value set to None. If the appropriate case is not 
available, then you can add it. Click New to open the Add New Case 
dialog box, and add the new case. For information about adding a new 
case, see “Creating a Case” on page 281.

Owner By default, Owner is set to your user name. Optionally, you can select a 
different owner for the run. If the appropriate user is not available, and 
you are an Administrator user or a user with the correct permissions, 
then you can add the new user. Click New to open the Add New User 
dialog box and add the new user. See “Managing Users” on page 83.

Multiple Samples in 
VCF

Select this option if you are loading a VCF file that contains variants 
from multiple samples. 

Optional Settings

Run Date/Time The default value for the Run Date and Time is the current day’s date 
and time, but you can change one or both values as needed. To change 
the value, select the value that is to be changed, for example, the 
month, and then you can manually enter the new value, or you can use 
the Up/Down field arrows to change the value. 

Note: You must select each value that is to be changed one at a time. If 
you set the Run Date/Time here, then this is a run-specific option. 
You also have the option of setting this option on a per sample 
basis later in the process.
170 Geneticist Assistant User’s Manual



Chapter 5
Managing Patients and Runs
4. Do one of the following:

• To automatically load all the applicable sample files (VCF only or VCF and BAM 
files) that are in the same folder in a single step, do the following:

• Click Select Directory to open the Select Directory dialog box, 

• In the Select Directory dialog box, browse to and select the appropriate 
directory, and then click Select Folder.

     

User Group By default, non-administrative users have read/write access to only 
those runs that they submitted. If other non-administrator users are to 
have read/write access to this run, then select the appropriate user 
group.

Sample Group Optional. Used for a group of samples that are to be processed 
repeatedly over a period of time, for example, a group of control 
samples for which the coverage or variant frequency is to be tracked. If 
the correct Sample Group is not available, then you can add it. Click 
New to open the Add New Sample Group dialog box and add the new 
sample group.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Subpanel To verify coverage for a smaller number of regions that are within the 
panel that has been selected for the run, select the appropriate 
subpanel.

Note: If no subpanels have been created for the selected panel, then no 
options are available on the Subpanel dropdown list. For 
information about creating subpanels, see “Adding a Subpanel” 
on page 115.

Identify Patient ID from 
Sample by Separator

Selected by default. If the file names for the loaded sample files contain 
the Patient ID, then define how the Patient ID is separated from the rest 
of the file name, for example, by an underscore (_), a dot (.), and so on. 
This allows each sample to be linked automatically to the corresponding 
patient. If the file names for the loaded sample files do not contain the 
Patient ID, then clear this option.

Note: If this option is selected, but you have not yet added a patient to 
your Geneticist Assistant database for the sample, then a patient 
record that uses the ID of the sample file is automatically added to 
the database and the sample is assigned to the patient.

Import Pathogenicity 
from VCF

Select this option if you are loading a VCF file that contains 
pathogenicity information and you want to import this information into 
the Geneticist Assistant database.

Note: This is a run-specific option. You also have the option of setting 
this option on a per sample basis later in the process.

Submit Hotspots Select to submit any variants that are included in the loaded VCF files 
that have an allele frequency value = 0 to the Geneticist Assistant 
database.

Accepted VCF filters Applicable after you load sample files. See Step 5.

Setting Description
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• To manually select sample files, do the following:

• Click Select Variant and/or Coverage Files to open the Select Files dialog box. 

• In the Select Files dialog box, browse to and select the BAM coverage file and/
or variant (VCF) files that are to be loaded, and then click Open. 

When selecting the files that are to be loaded, note the following:

• You can load a VCF or BAM file for a new run that has been submitted previously 
for another run. You can keep the sample name the same, or you can edit the sample 
name as needed.

• You can use the same run name to load additional sample files (BAM and/or VCF) 
for a previously submitted run. The additional sample files are processed and 
appended to the run. 

• At a minimum, you must always load a VCF file. Optionally, you can also load a 
BAM file to include coverage information for the panel regions.

• If you have a single sample to load, and the VCF and BAM file names do not contain 
corresponding fields in the file names, then select the VCF or BAM file, and then 
after you click Open, the file is placed in the appropriate field for the sample entry. 

You can then click the Browse button  next to the appropriate file type to load 

the corresponding file for the sample. For example, if you loaded a BAM file, then 

you can click the Browse button  next to the Variant File (*.vcf) field for the 

sample entry to load the needed VCF file for the sample.

• If you have multiple samples to load and the VCF and BAM files do not contain 
corresponding fields in the file names, then CTRL-click as you select only the VCF 
files or the BAM files, and then after you click Open, each file is placed in its own 

sample entry. For each sample entry, you can then click the Browse button  next 

to the appropriate file type to load the corresponding file. For example, if you loaded 

a BAM file, then you can click the Browse button  next to the Variant File 

(*.vcf) field for the sample entry to load the needed VCF file for the sample.

• If you are loading both a VCF file and a BAM file, and the files do contain 
corresponding fields in the file names, then CTRL-click as you select both the VCF 
and BAM files, and then after you click Open, both files are loaded into the 
appropriate fields for the same sample entry in a single step. You can load a single 
VCF/BAM file combination this way, or you can load multiple VCF/BAM file 
combinations. Each correspondingly named VCF/BAM file combination is placed in 
its own sample entry.

• If you have multiple BAM files for a sample, you do not need to submit each file as 
an individual sample, and then assign each file to the same patient. Instead, you can 
use the Merge BAM Files tool to merge all the BAM files into one file and then 
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submit the file as a single sample. See “Merging BAM Files with the Merge BAM 
Files Tool” on page 348.

• By default, the sample name is set to the VCF file name. The name is displayed at 
the top of the sample entry. You can edit the sample name.

• If you load a sample file in error, then you can right-click anywhere in the sample 
entry area, and then click Remove this sample.

After the files are loaded for a sample, the full directory paths (directory and file name) 
for the loaded files are displayed in the appropriate fields for each sample entry at the 
bottom of the New Run dialog box. 

Figure 5-42:  New Run dialog box with loaded sample files

     

After you load sample files from a specific directory, if BAM files are included, 
then the BAM files must remain in this directory. You cannot move these BAM files 
to a different directory after you have successfully submitted the files for a run.
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5. After you load your sample files, do one of the following:

• To import all the variants that are contained in the VCF files for all the samples into 
your Geneticist Assistant database, leave Accepted VCF filters set to the default 
value of All.

• To import only those variants with selected filter values into your Geneticist 
Assistant database, click Edit to open the Select Accepted Filters dialog box, and 
then specify the accepted variant filter values that are to be used for import from the 
listed filters that are available in the loaded VCF file.

Figure 5-43:  Selected Accepted Filters dialog box

After you select the filters, and then click OK, the Select Accepted Filters dialog box 
closes. The selected filters replace the default value of All. See Figure 5-44 below.

Figure 5-44:  Selected filters specified for a VCF file on the New Run dialog box

6. Optionally, for each sample, do any or all of the following as needed:

• Edit the sample name.

• By default, the Reference, Panel, Run Date/Time, Sample Group, and Import 
Pathogenicity from VCF values that are indicated for a sample are the run-specific 
values that you specified in Step 3. You can edit any or all these values on a per 
sample basis. 

This is a run-specific option. You also have the option of setting this option on a 
per sample basis later in the process.

You can click Default at any time to return the sample name to its default value.

If you edit the panel on per sample basis, then the panel group might also be 
modified, but you cannot edit the panel group directly.
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• To associate a patient with a sample, select a patient on the Patients dropdown list.

• By default, if you have specified variant filters, then these filters are applied at the 
run level. To edit the accepted variant filters for a sample, click Edit, and then in the 
Select Accepted Filters dialog box, edit the filter selection.

7. Click OK.

The Current Jobs tab opens and a progress bar that shows the progress of loading the 
files is displayed on the Current Jobs tab. After the files are successfully loaded, the 
progress bar is removed from the Current Jobs tab. You return to the Runs tab. The new 
run is displayed on the Runs tab. You can now review the data for the run. See Chapter 6, 
“Geneticist Assistant Data Review - Runs Tab,” on page 177.

If the correct patient is not available, then you can click Add New Patient to add 
the patient. See “Adding Patients” on page 123.
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Runs Tab

Many options are available from the Runs tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Runs Tab” on page 179.

• “The Runs Tab Context Menu” on page 181.
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Overview of the Runs Tab
When the Geneticist Assistant main window first opens, the Runs tab is displayed in the 
Geneticist Assistant main window. The Runs tab has a single pane, the Runs pane, that 
displays information about the runs that have been carried out in your Geneticist Assistant 
installation. 

• If you are an Administrator user, then the Runs pane can display all the runs submitted by 
all users to your Geneticist Assistant database. By default, when the tab first opens, only 
the 30 most recently submitted runs are displayed and the runs are sorted based on the Run 
ID. 

• If you are a standard user, then the Runs pane can display all the runs that you have 
submitted to your Geneticist Assistant database as well as all the runs that have been 
submitted by other users and for which you have been granted at least the Can Read 
permission. By default, when the tab first opens, only the 30 most recently added runs that 
fit one of these two criteria are displayed and the runs are sorted based on the Run ID. 

Figure 6-1:  Runs tab

You can do the following on the Runs tab:

• Change the display of the Runs tab. See “To change the Runs tab display” on page 180.

• Edit certain values that are displayed for a run. See “To edit values for a selected run” on 
page 180.

• Open a context menu with a variety of options for working wit h and displaying  
run-specific data. See “The Runs Tab Context Menu” on page 181.

You can also open the Runs tab from the Tabs option on the Geneticist Assistant 
main menu: Tabs > Runs.
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To change the Runs tab display
You can do the following for the display on the Runs tab:

• Limit the runs that are displayed by number. The default value is 30.

• Limit the runs that are displayed by a range for the run date and time. The default value 
is the last 30 days, with the ending date/timestamp set to the current day’s date and time.

To edit values for a selected run
For any run that is displayed on the Runs tab, you can:

• Click in any of the following fields—Name or Run Date/Time—to select the current 
value, and edit it as necessary, and then click out of the field.

• Select a different Chemistry and/or Instrument for the run. 

After you edit the value for Name or Run Date/Time and click out of the field, or select a 
different chemistry or instrument for the run, an Edit Run dialog box opens. The dialog 
box displays the name of the run for which you are editing a value, the current (old) run 
value, and the new run value. You can make any further changes to the new run value as 
needed, and then click OK to close the dialog box, and save the new value for the run.

Figure 6-2:  Edit Run dialog box

• Set the status for the run. When a run is first submitted, the status is set to New. You can 
change the status from New to one of three default values (QC Passed, Reviewed, or 
Complete) for the run, or if custom values have been added for the run, then you can also 
select one of these values. 

For information about adding a custom value, see “Managing Objects in the 
Geneticist Assistant” on page 51.
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The Runs Tab Context Menu
You can right-click any run entry on the Runs tab to open a context menu with the following 
options:

Table 6-1: Runs tab, Runs pane context menu 

Option Description

Run • Open – Opens the Run tab for the selected run. See Chapter 7, “Geneticist Assistant 
Data Review - Run Tab,” on page 203.

Note: You can also double-click a run entry to open the Run tab.

• Open all Samples with <Filter>: Select the appropriate filter for the samples. The 
Sample tab opens. The Sample Variant Data sub-tab is the open tab and the selected 
filter is applied to the tab. Only those sample variants that meet the filter criteria are 
displayed on the tab. The selected filter is persistent within this Geneticist Assistant 
instance and across instances. To clear the filter only for the current instance of 
Geneticist Assistant, click Clear at the bottom of the Table Filters pane. To select a 
different filter for the samples, or to permanently clear the filter for the samples, see 
“Apply Variant Filter” under “Edit Sample” on page 209.

Note: For information about setting a filter, see “To filter the data that is displayed in a tab 
pane” on page 32. For information about the Sample Variant Data sub-tab, see 
“Sample Variant Data Sub-Tab” on page 246.

Add All to Custom 
Report

Selects all the data that is displayed for the run for inclusion in a custom report. See 
Chapter 11, “Geneticist Assistant Reports,” on page 313.

Compare Samples Applicable only for runs with two or more samples. Opens the Sample Comparison dialog 
box. You use the options on this dialog box to compare the coverage, frequency, and read 
balance information for each sample that is being compared. See “To compare all the 
samples within a run from the Runs tab” on page 184.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information 
based on the panel that was used for the run. See “To calculate panel statistics (Runs tab)” 
on page 186.

Copy Copies all the information that is displayed for the selected run to your client’s clipboard. 
You can then use standard Paste commands to paste this copied information into a  
third-party application such as Notepad.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the run. If you are an Administrator user, then you can set or edit the 
permissions for a run that any user has submitted. If you are a standard user, then you can 
set or edit the permissions for only those runs that you have submitted to the Geneticist 
Assistant database, or for those runs that other users have submitted and to which you 
have been granted Can Read and Can Write permissions. See “To set or edit the Read/
Write permissions for a run” on page 191.
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Change Ownership Opens the Change Run Ownership dialog box, which displays the name of the current 
owner for the run, and an option (New Owner) for selecting a new owner for the run from a 
list of all the currently available and active users for your Geneticist Assistant instance.You 
can change the ownership for any run if you are an Administrator user, the current owner 
of the run, or if you have been granted Can Read and Can Write permissions for the run.

Figure 6-3:  Change Run Ownership dialog box

Note: If the run was added to your Geneticist Assistant prior to V1.4, then the first time the 
dialog box opens, the Current Owner field is blank.

Edit Run

Apply Variant Filter • <Filter>: Applies the selected filter for all the samples in the run. When you open the 
Sample tab for any sample in the run, the filter is automatically applied.

• Deactivate Filters: Deactivates all the filters that been applied for all the samples in the 
run.

Add Comment Opens the Add Run Comment dialog box. You add a comment for the selected run in the 
Add comment field. The comment is displayed in the Comment field on the Runs tab and 
the Comment field in the Comments pane on the Run tab. 

Figure 6-4:  Add Run Comment dialog box

Note: If multiple comments have been added for a run, then only the last added comment 
is displayed in the Comment field on the Runs tab. All the comments that have been 
added for a run, including the last added, are displayed in reverse chronological 
order in the Comments pane on the Run tab.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
182 Geneticist Assistant User’s Manual



Chapter 6
Geneticist Assistant Data Review - Runs Tab
Add Samples to Run Opens the New Run dialog box so that you can add more samples to the selected run. 
See “Adding a Run” on page 169.

Set Subpanels of 
Selected Runs

Applicable only if you select a run for which a subpanel was not selected during the setup 
of the run. CTRL-click to select multiple runs. If you select multiple runs, then all the runs 
must use the same panel. Opens the Select a Subpanel dialog box. The dialog box 
displays the samples and the panel for the selected runs and a Subpanel dropdown list 
with all the available subpanels. 

Figure 6-5:  Set Sample Subpanel dialog box

Select a different subpanel on the Subpanel dropdown list, and then click OK. The 
subpanel is applied to all the samples in all the selected runs.

Delete Run Delete the selected run from the Geneticist Assistant database.

Exports

Export to VCF Exports all the variants in the selected run to a VCF file. You must specify both the file 
name and the location in which to save the file.

Save Sample 
Reports

Applicable for one or more runs. CTRL-click to select multiple runs. Generates an 
individual sample report for each sample in all the selected runs. You must specify a 
location in which to save the reports. Each report is named the same as the sample and 
the report format is HTML, and you cannot change either of these values. 

Note: For more information about standard reports, see Chapter 11, “Geneticist Assistant 
Reports,” on page 313.

Create Batch 
Variants Report

Opens the Batch Variants Report dialog box for generating the Batch Variants report for all 
the samples in a selected run. See “To manage a Batch Variants report (Runs tab)” on 
page 193.

Create Batch 
Coverage Report

Opens the Batch Coverage Report dialog box for generating the Batch Coverage report for 
all the samples in the selected run or runs. See “To generate a Batch Coverage report 
(Runs tab)” on page 198.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description
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To compare all the samples within a run from the Runs tab

1. Right-click the appropriate run on the Runs tab, and on the context menu that opens, 
click Compare Samples.

The Sample Comparison dialog box opens. All the samples for the run are displayed in 
the dialog box. See Figure 6-6 on page 185.

Batch PDF Reports Applicable for one or more runs. CTRL-click to select multiple runs. Opens a list of all the 
custom report templates that you have created and saved, or that other users have 
created and made available to all users. Select the appropriate report template to generate 
an individual sample report for each sample in the selected run or runs. Each sample 
report is saved in a PDF format and is named the same as the sample for which it was 
generated. See “To generate a Batch PDF report (Runs tab)” on page 200.

Note: A Preview option allows you to save a single report for a selected sample and in a 
format other than PDF, including HTML and XLSX.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Runs pane. See “To filter the data that is displayed in a tab 
pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Table 6-1: Runs tab, Runs pane context menu (Continued)

Option Description

To compare only selected samples within a run, see “To compare selected sample 
data for a run from the Run tab” on page 213.
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Figure 6-6:  Sample Comparison dialog box

2. Set the comparison parameters.

     

Option Description

Show columns The data columns that are displayed for each sample on the Sample 
Comparison tab. Allele Frequency (AF) is always displayed and you 
cannot change this option. Coverage (Cov) is displayed by default, but 
you can clear this selection. Read Balance (RB) is not displayed by 
default, but you can select this option.

Filter variants by panel Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that are contained within the selected panel.

Shared by Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that meet the required number of samples as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found in a number of samples 
that does not meet this criteria, then the variant is not displayed in the 
results.

AF difference Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that have a difference in allele frequency as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found with an allele frequency 
difference that does not meet this criteria, then the variant is not 
displayed in the results. 

• Exclude missing 
variants 

Selected by default. Regardless of the allele frequency difference, 
always display variants that are not found in one or more samples.

AF between Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with an allele frequency that falls within the indicated 
range in at least one of the compared samples.
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3. Click OK.

The Sample Comparison dialog box closes. The Sample Comparison results are 
displayed on the Sample Comparison tab. A distinct gray vertical line separates the two 
sides of the tab. The left side of the tab shows the sample-specific information for each 
variant, with each sample identified as 1, 2, and so on. If you hover your cursor over the 
column heading, then the full sample name is displayed. The right side of the tab shows 
the variant details. 

Figure 6-7:  Sample Comparison tab

To calculate panel statistics (Runs tab)
The Panel Statistics tab has options for displaying specific information based on a selected 
panel and panel group as well as any or all of the following criteria: 

• All panel samples, or selected panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

To display data on the Panel Statistics tab

1. Select the appropriate run, or CTRL-click to select multiple runs on the Runs tab.

2. Right-click any selected run, and on the context menu that opens, click Panel Statistics. 

     

If you select multiple runs for different panels, then a Select Panel dialog box 
opens. You must first select the appropriate panel before the statistics can be 
calculated.
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The Panel Statistics tab opens. The Coverage Regions sub-tab is the open tab. The panel 
and panel group that were used for the run are selected. You can select a different panel 
from the Panel dropdown list to view statistics for a different panel. You can also select a 
different panel to change the panel group, but you cannot change the panel group 
directly. By default, the statistics are calculated for all the samples in the selected run 
that have been added to the panel. 

Figure 6-8:  Coverage Regions sub-tab (Panel Statistics tab)

3. Optionally, edit any or all of the calculation criteria as needed, and then click OK to 
recalculate the panel statistics and update the display accordingly. 

If the run contains a small number of samples, such as two to four, then, by 
default, the panel statistics are calculated based only on the samples for the run. 
Before the statistics are calculated, a Very few samples message dialog box opens, 
warning you of this and asking you if you want to continue. You can click Yes, or 
you can click Cancel to return to the Runs tab.

Option Description

All panel samples If you select this option, then all samples that have been added to the panel 
are displayed. To specify a custom date range, select added between, and 
then change one or both dates as needed. To change the dates, you can do 
either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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4. Optionally, after calculating the panel statistics, continue to any of the following needed 
to view information on any of the five sub-tabs that are available for the Panel Statistics 
tab:

• Coverage Regions sub-tab. See “Coverage Regions sub-tab (Panel Statistics tab)” on 
page 189.

• Samples sub-tab. See “Samples sub-tab (Panel Statistics tab)” on page 189.

• Variants sub-tab. See “Variants sub-tab (Panel Statistics tab)” on page 190.

Selected runs Selected by default. To select specific runs for the panel, choose Selected 

runs, and then click the Browse button  that is next to Selected runs to 

open the Select Runs dialog box. All the runs for the selected panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 6-9:  Select Runs dialog box

Selected samples To select only specific samples for the panel, choose Selected samples and 

then click the Browse button  that is next to Selected samples to open 

the Select Samples dialog box. All the samples for the selected panel are 
displayed in the dialog box. Select the appropriate sample, or CTRL-click to 
select multiple samples, and then click OK.

Figure 6-10:  Select Samples dialog box

Option Description
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• Patients sub-tab. See “Patients sub-tab (Panel Statistics tab)” on page 190.

• Reports sub-tab. See “Reports sub-tab (Panel Statistics tab)” on page 191.

Coverage Regions sub-tab (Panel Statistics tab)

The Coverage Regions sub-tab has a single pane, the Coverage Regions pane, that lists by 
default, the coverage information across all the samples for the selected run or runs for every 
region in the selected panel and panel group. See “Coverage Regions tab” on page 217 for a 
detailed discussion of the information that is displayed on this sub-tab.

Figure 6-11:  Coverage Regions sub-tab (Panel Statistics tab)

Samples sub-tab (Panel Statistics tab)

The Samples sub-tab has a single pane, the Samples pane, that lists by default, all the 
samples that were imported in the selected run or runs for the selected panel and panel group. 
You can double-click a sample on this sub-tab to open the Sample tab. (See Chapter 8, 
“Geneticist Assistant Data Review - Sample Tab,” on page 243.) You can also right-click a 
sample on the sub-tab to open a context menu that has options that are identical to options 
that are on the context menu for the Samples pane on the Run tab. See “The Samples Pane 
(Run tab) Context Menu” on page 207.

Figure 6-12:  Panel Statistics tab, Samples sub-tab
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Variants sub-tab (Panel Statistics tab)

The Variants sub-tab has a single pane, the Variants pane, that lists by default, all the variants 
that were detected in all the samples that were imported in the selected run or runs for the 
selected panel and panel group. The information that is displayed on this sub-tab is identical 
to the information that is displayed on the Variants sub-tab on the Patient tab. You can 
double-click a variant on this sub-tab to open the Variant tab. (See Chapter 10, “Geneticist 
Assistant Data Review - Variant Tab,” on page 291.) You can also right-click a variant on 
this sub-tab to open a context menu that has options that are identical to options that are on 
the context menu for the variant on the Sample Variant Data sub-tab. (See “Sample Variant 
Data Sub-Tab” on page 246.) 

Figure 6-13:  Panel Statistics tab, Variants sub-tab

Patients sub-tab (Panel Statistics tab)

The Patients sub-tab has a single pane, the Patients pane, that lists by default, all the patients 
who were associated with all the samples for the selected run or runs that were imported for 
the selected panel and panel group. You can double-click a patient in the pane to open the 
corresponding Patient tab. You can also right-click a patient on this sub-tab to open a context 
menu with options that are identical to options that are on the context menu for the Patients 
tab. See “Accessing and Reviewing Patient Records” on page 128.

Figure 6-14:  Panel Statistics tab, Patients sub-tab
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Reports sub-tab (Panel Statistics tab)

The Reports sub-tab contains a single pane, the Reports pane, that lists by default, all the 
reports that were generated for the selected run or runs for the selected panel/panel group and 
saved to the Geneticist Assistant database. 

Figure 6-15:  Panel Statistics tab, Reports sub-tab

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 146.

To set or edit the Read/Write permissions for a run 
1. If you have not already done so, open the Runs tab.

2. Select the run, or CTRL-click to select the multiple runs for which the permissions are 
being set.

3. Right-click any selected run, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the names of all the users 
and/or groups and their assigned permissions for the runs. See Figure 6-16 on page 192.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving Panel Statistics reports, see 
Chapter 11, “Geneticist Assistant Reports,” on page 313.
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Figure 6-16:  Permissions dialog box (Runs tab)

4. Edit the Read and Write run permissions for any user or group as needed and then go to 
Step 8; otherwise, to add run permissions for a new user or group, go to Step 5.

5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the run. They cannot edit it.

7. Optionally, if the user or group must be able to edit the run as well, then select the Can 
Write permission.

8. Optionally, if all users and groups are to have their same run permissions applied to all 
the samples in all the selected runs, then select Apply the permission settings to 
Samples; otherwise, leave this option cleared, or clear it if necessary.

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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9. Click OK.

A Permission Updated message opens. 

10. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the runs.

To manage a Batch Variants report (Runs tab)
A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to create multiple reports for multiple samples in a single step. If you 
generate a Batch Variants report from the Runs tab, then a separate report is saved for each 
sample of the selected run. A Batch Variants report configuration determines the data that is 
to be included in the report. You choose if the configuration is to be available only to the user 
who created it, or to all users. The configuration does not include the report format (PDF, 
HTML and so on), or the location in which the report is to be saved. Instead, you must 
specify the format and location in which to save the report every time you generate a report 
for a new or saved configuration. You can generate a Batch Variants report according to a 
new or saved configuration, edit a Batch Variants report configuration, or delete a Batch 
Variants report configuration. See:

• “To generate a Batch Variants report based on a new configuration” on page 194.

• “To generate a Batch Variants report based on a saved configuration” on page 195.

• “To edit a Batch Variants report configuration” on page 196.

• “To delete a Batch Variants Report configuration” on page 197.

Figure 6-17:  Batch Variants Report dialog box

You can assign Read and Write permissions for the samples in a run on a per 
sample basis. See “To set or edit the Read/Write permissions for the samples in a 
run on a per sample basis” on page 227.
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To generate a Batch Variants report based on a new configuration
 

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for the first sample in the list of samples for which you are 
generating the report (for example, 76_800458.variants.filter) and you cannot change this. 
You must select a location in which to save the report.

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

To generate the report for all variants in only selected samples for the run, see “To 
manage a Batch Variants report (Run tab)” on page 229.

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
194 Geneticist Assistant User’s Manual



Chapter 6
Geneticist Assistant Data Review - Runs Tab
8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

9. Click OK.

The Batch Variants report is generated for each of the samples in the selected run. After 
the report is successfully generated, a Batch Variants Report Finished dialog box with a 
message that indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved 
configuration
  

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public. 
See Figure 6-18 on page 196.
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Figure 6-18:  Load Configuration dialog box

8. Select a configuraiotn, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

11. Click OK.

The Batch Variants report is generated for for each of the samples in the selected run. 
After the report is successfully generated, a Batch Variants Report Finished dialog box 
with a message that indicates that the report was generated and where the report was 
saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To edit a Batch Variants report configuration
 

When you edit a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 
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5. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. To edit the report configuration, see “To create/edit a pane configuration” on page 39.

8. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

9. Click OK.

The Batch Variants report is generated for each of the samples in the selected run. After 
the report is successfully generated, a Batch Variants Report Finished dialog box opens, 
with a message that indicates where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants Report configuration
 

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. If you have not already done so, open the Runs tab.

2. Select the run or CTRL-click to select the multiple runs for which the Batch Variant 
report is to be generated.

3. Right-click any selected run, and on the context menu that opens, click Export > Create 
Batch Variants report.

4. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

5. See “To delete a pane configuration” on page 41.

6. Click Close (x) to close the Batch Variants Report dialog box.

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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To generate a Batch Coverage report (Runs tab)
The Batch Coverage report saves a coverage report for each of the samples for a selected run 
or runs in a specific panel or panels and panel group. The report also includes coverage 
statistics for the panel that are calculated based on one of the following options: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

1. If you have not already done so, open the Runs tab.

2. Select a single run, or CTRL-click to select multiple runs.

3. Right-click on any selected run, and on the context menu that opens, click Export > 
Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the samples in the selected run are 
displayed in the bottom pane of the dialog box. If multiple runs are selected with 
different panels, then a separate tab is displayed for each panel. 

Figure 6-19:  Batch Coverage Report dialog box (Runs tab)

4. Leave the report type set to the default value of HTML, or select a different report type.

5. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the reports.
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6. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options by which to calculate the panel coverage 
statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.

Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. All the runs for the panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 6-20:  Select Runs dialog box
Geneticist Assistant User’s Manual 199



Chapter 6
Geneticist Assistant Data Review - Runs Tab
After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved for each sample in the selected run or runs in the 
specified format and the specified location. 

To generate a Batch PDF report (Runs tab)
A Batch PDF report is a report that includes information for all the samples in a selected run 
or runs. When you generate a Batch PDF report from the Runs tab, then a separate report is 
saved for each sample of the selected run or runs. The custom report template that you select 
for the Batch PDF report determines the data that is to be included in the sample report as 
well as the layout of the report. The template does not specify the report names, the report 
formats, or the location in which the reports are to be saved. Instead, each report is named the 
same as the sample for which it was generated, and each report is saved as a PDF. You 
cannot change the report name, nor can you select a different report format for any report. 
You must specify the location in which to save the sample reports every time you generate a 
Batch PDF report.

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. All the samples 
for the panel are displayed in the dialog box. Select the appropriate sample, 
or CTRL-click to select multiple samples, and then click OK.

Figure 6-21:  Select Samples dialog box

If the panel coverage statistics are to be calculated based on only a small number 
of samples, such as two to four, then, before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and asking you if you 
want to continue. You can click Yes, or you can click Cancel to return to the Runs 
tab.

Option Description
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1. If you have not already done so, open the Runs tab.

2. Select a single run, or CTRL-click to select multiple runs.

3. Right-click on any selected run, and on the context menu that opens, click Batch PDF 
Reports.

A sub-menu opens with a list of all the available custom report templates that have been 
designed for Sample data. 

4. Select the appropriate custom report template.

The Save <Custom Report Template Name> dialog box opens. The dialog box displays 
all the samples for the selected run or runs. 

Figure 6-22:  Save <Custom Report Template Name> dialog box

5. Optionally, to filter the report results before generating the reports, on the Filters 
dropdown list, select the appropriate filter.

     

For information about designing and saving a custom report template, see 
“Designing a Custom Report Template” on page 322.

A Preview option is available to view a single selected sample report onscreen and 
you can save this single report with a name of your choosing and in a format of 
your choosing as well (PDF, HTML, or XLXS).

For information about creating and saving filters for the data in your Geneticist 
Assistant database, see “To filter the data that is displayed in a tab pane” on page 
32.
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6. Optionally, to preview a single report onscreen before generating and saving the final 
sample reports, click Preview.

7. To save all the sample reports in PDF format to a location of your choice, click Save As.

The Choose Report Directory dialog box opens. 

8. In the Choose Report Directory dialog box, browse to and select the directory in which 
to save the sample reports, and then click Select Folder.

The Choose Report Directory dialog box closes, and a report is generated for each 
sample. After the sample reports are successfully generated, a PDF Report Finished 
message dialog box opens indicating this.

Figure 6-23:  PDF Report Finished dialog box
‘

9. Click OK.

The message dialog box and the Save <Custom Report Template Name> dialog box 
close. The sample reports are now available in the specified location in PDF format.

The toolbar of the onscreen preview contains a variety of options for working with 
the report, including printing the report, and saving the report with a name of your 
choosing in a format of your choosing, including PDF, HTML, and XLSX file.
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Many options are available from the Run tab for reviewing your data in Geneticist Assistant.

This chapter covers the following topics:

• “Overview of the Run Tab” on page 205.

• “Samples pane (Run tab)” on page 206.

• “Coverage Regions tab” on page 217.

• “The Samples Pane (Run tab) Context Menu” on page 207.

• “Status Changes pane (Run tab)” on page 239.

• “Reports pane (Run tab)” on page 242.
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Overview of the Run Tab
The Run tab displays information for a selected run. To open the Run tab, do one of the 
following:

• Right-click a run on the Runs tab, and on the context menu that opens, select Run > Open.

• Double-click a run on the Runs tab. 

Figure 7-1:  Run tab

The Run tab has four panes. From top to bottom, these panes are the following:

• The Samples pane. See “Samples pane (Run tab)” on page 206.

• The Run’s Status Changes pane. See “Status Changes pane (Run tab)” on page 239.

• The Comments pane. See “Comments pane (Run tab)” on page 240.

• The Reports pane. See “Reports pane (Run tab)” on page 242.
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Samples pane (Run tab)
The Samples pane on the Run tab displays an entry for each sample (VCF/BAM file 
combination or single VCF file) that was loaded for the run. The following options are 
available for a sample in the Samples pane on the Run tab:

• Setting the sample status. See “To set the sample status” on page 206.

• Using the context menu. See “The Samples Pane (Run tab) Context Menu” on page 207.

To set the sample status
By default, after a sample is initially submitted, the status of the sample is set to New on the 
Run tab. 

1. If you have not done so already, open the Run tab. (See “Overview of the Run Tab” on 
page 205.)

2. On the Samples pane, on the Status dropdown list, select a different sample status.

The Update Sample Status dialog box opens. The dialog box displays the Current status 
and the New status, which is the status that you are changing the sample to.

Figure 7-2:  Update Sample Status dialog box

3. Optionally, in the Comment field, enter an explanation/reason for changing the sample 
status.

The status change and the comment for the status change are displayed in the Status 
Changes pane on the Sample tab. See “Status Changes pane (Sample tab, Sample Data 
sub-tab)” on page 268.

4. Click OK.

The Update Sample Status dialog box closes. The Run tab remains open. The newly 
selected sample status is displayed in the Status field on the tab.

You can select a different value from one of the available default values (New, QC 
Passed, Reviewed, or Complete), or if needed, you can create custom statuses, and 
then select one of these custom statuses instead. See “Managing Objects in the 
Geneticist Assistant” on page 51. 
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The Samples Pane (Run tab) Context Menu
You can right-click a sample (CTRL-click to select multiple samples) in the Samples pane on 
the Run tab to open a context menu with the following options:

Table 7-1: Run tab, Samples pane context menu 

Option Description

Open with Select the appropriate filter for the sample. The Sample tab opens for the selected sample. 
The Sample Variant Data sub-tab is the open tab and the selected filter is applied to the 
tab. Only those sample variants that meet the filter criteria are displayed on the tab. The 
selected filter is persistent within this Geneticist Assistant instance and across instances. 
To clear the filter only for the current instance of Geneticist Assistant, click Clear at the 
bottom of the Table Filters pane. To select a different filter for the sample, or to 
permanently clear the for the sample, see “Apply Variant Filter” under “Edit Sample” on 
page 209.

Note: For information about setting a filter, see “To filter the data that is displayed in a tab 
pane” on page 32. For information about the Sample Variant Data sub-tab, see 
“Sample Variant Data Sub-Tab” on page 246.

Compare Samples Displayed only after two or more samples are selected. Opens the Sample Comparison 
dialog box. You use the options on this dialog box to compare the coverage, frequency, 
and read balance information for each sample that is being compared. See “To compare 
selected sample data for a run from the Run tab” on page 213.

Family Comparison Displayed only if three or more samples are selected. At a minimum, you must select two 
parent samples and one child sample. You can always select more than one child sample. 
Opens the Family Comparison dialog box, in which you can specify the options to compare 
the variant calls in family (relation and phenotype) data. See “To compare family data” on 
page 215.

Sample Details Displayed only if a single sample is selected. Opens the Sample tab, which contains 
detailed information about the sample, including the variant list. See Chapter 8, “Geneticist 
Assistant Data Review - Sample Tab,” on page 243.

Coverage Regions Displayed only if a single sample is selected. Opens the Coverage Regions tab, which lists 
the coverage information for every region in your panel. The Status indicates whether the 
region passed or failed the Quality Control (coverage) settings that were set for the run. 
See “Coverage Regions tab” on page 217.

Panel Statistics Opens the Panel Statistics tab. The tab has options for displaying specific information for 
the panel that was used for the run. See “To calculate panel statistics (Run tab)” on page 
222.

Add All to Custom 
Report

Selects all the data that is displayed for all the samples in the run for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.
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Show Sample 
Variants Filtered by 
Panel

Displays all the variants in the selected sample filtered by a selected panel or panels. If 
you select this option, then the Select Panel to Filter Variants dialog box opens. You must 
select a panel or panels in this dialog box by which to filter the variants for the selected run.

Figure 7-3:  Select Panel to Filter Variants dialog box

Copy Copies all the information that is displayed for the selected sample to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the sample. If you are an Administrator user, then you can set or edit the 
permissions for any sample in any run that any user has submitted. If you are a standard 
user, then you can set or edit the permissions for only those samples that are contained in 
runs that you have submitted to the Geneticist Assistant database, or for those samples 
that are contained in runs that were submitted by other users and to which you have been 
granted Can Read and Can Write permissions. See “To set or edit the Read/Write 
permissions for the samples in a run on a per sample basis” on page 227.

Change Ownership Opens the Change Sample Ownership dialog box, which displays the name of the current 
owner for the associated sample, and an option (New Owner) for selecting a new owner 
for the sample. You can change the ownership for any sample if you are an Administrator 
user, the current owner of the sample, or if you have been granted Can Read and Can 
Write permissions for the sample.

Figure 7-4:  Change Sample Ownership dialog box

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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External

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist Assistant 
settings. (See “To configure Geneticist Assistant directories” on page 55.) If selected, then 
Geneticist Assistant browses for the folder where the VCF file for the sample is located. If 
the NextGENe project file is found in the same directory as the VCF file, then the 
NextGENe project is opened in the NextGENe Viewer. 

View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project file) in the 
same folder as the VCF file for the sample. Opens the BAM file in the third-party 
Integrative Genomics Viewer (IGV).

Edit Sample

Apply Variant Filter • <Filter>: Select a different filter for the sample. The Sample tab opens for the selected 
sample. The Sample Variant Data sub-tab is the open tab and the selected filter is 
applied to the tab. Only those sample variants that meet the filter criteria are displayed 
on the tab. The selected filter is persistent within this Geneticist Assistant instance and 
across instances. To clear the filter only for the current instance of Geneticist Assistant, 
click Clear at the bottom of the Table Filters pane. 

• Deactivate Filters: Permanently clears all applied filters for the selected sample for all 
instances of Geneticist Assistant. All variants for the selected sample are again 
displayed on the Sample Variant Data sub-tab.

Add Comment Opens the Add Sample Comment dialog box. You add a comment for the associated 
sample in the Add Comment field. The comment is displayed in the Comments field on the 
Samples sub-tab on the Patient tab, the Comments field in the Samples pane on the Run 
tab, and in the Comments pane on the Sample Data sub-tab on the Sample tab. 

Figure 7-5:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then with the exception of the 
Comments pane on the Sample Data sub-tab on the Sample tab, only the last added 
comment is displayed in all the locations detailed above. All the comments that have 
been added for a sample, including the last added, are displayed in reverse 
chronological order in the Comments pane on the Sample Data sub-tab for the 
Sample tab.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Set Subpanel You must select a sample or samples for which a subpanel was not selected during the 
setup of the run. Opens the Select a Subpanel dialog box. The dialog box displays the 
selected sample or samples, the panel for the currently selected sample, and a Subpanel 
dropdown list with all the available subpanels. 

Figure 7-6:  Set Sample Subpanel dialog box

Select a subpanel on the Subpanel dropdown list, and then click OK. The subpanel is 
applied to sample or samples.

Set Patient Opens the Set Patient dialog box. Select the patient that is to be associated with the 
sample, and then click OK.

Figure 7-7:  Set Patient dialog box

Note: You also have the option of associating a patient with a sample from the Sample 
tab. See “To associate a patient with a sample” on page 272.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Edit Sample Groups Opens the Edit Sample Group dialog box. You use the options on this dialog box to add a 
sample to a selected sample group, or to remove a sample from a selected sample group.

Note: If the appropriate sample group is not available, you can add it. See “Managing 
Objects in the Geneticist Assistant” on page 51.

Figure 7-8:  Edit Sample Group dialog box

Move Samples to 
Run

Applicable for one or more samples. CTRL-click to select multiple samples. Opens the 
Move Selected Samples to Run dialog box. Enter a search string to search for the existing 
run in your Geneticist Assistant database that you are moving the samples to. As you enter 
the search string, a dynamically updated list of runs that meet your search criteria opens. 
You can select the appropriate run from this list.

Figure 7-9:  Move Selected Samples to Run dialog box

Note: The search string is not case-sensitive, but the string must begin with the run name. 
For example, a search string of “May” or “ma” returns a run named Mayo Clinic Run 
II, but a search string of “clinic” does not.

Delete Sample Applicable for one or more samples. CTRL-click to select multiple samples. Deletes the 
selected samples from the run. The samples are NOT deleted from the Geneticist 
Assistant database.

Exports

Export to VCF Exports all the variants in the selected sample to a VCF file. You must specify both the file 
name and the location in which to save the file.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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Save Sample 
Reports

Applicable for one or more samples. CTRL-click to select multiple samples. Generates an 
individual sample report for each selected sample. If a single sample is selected, then a 
default location, report name, and report type (HTML) are provided, but you can change 
any or all of these values. If multiple samples are selected, then you can select only the 
location in which to save the report. Each report is named the same as the sample and the 
report format is HTML, and you cannot change either of these values.

Note: For more information about standard reports, see Chapter 11, “Geneticist Assistant 
Reports,” on page 313.

Create Batch 
Variants Report

Opens the Batch Variants Report dialog box for generating the Batch Variants report for 
the selected sample or samples. (CTRL-click to select multiple samples.) See “To manage 
a Batch Variants report (Run tab)” on page 229.

Create Batch 
Coverage Report

Opens the Batch Coverage Report dialog for generating the Batch Coverage report the 
selected sample or samples. (CTRL-click to select multiple samples.). See “To generate a 
Batch Coverage report (Run tab)” on page 233.

PDF Reports Applicable for one or more samples. CTRL-click to select multiple samples. Opens a list of 
custom report templates that you created and saved, or that other users created and made 
available to all users. Select the appropriate report template to generate an individual 
sample report for each sample. Each sample report is saved in a PDF format and is 
named the same as the sample for which it was generated. See “To generate a PDF report 
(Run tab)” on page 236.

Note: A Preview option allows you to save a single report for a selected sample and in a 
format other than PDF, including HTML and XLSX.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Samples pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description
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To compare selected sample data for a run from the Run tab

1. If you have not already done so, open the Run tab. (See “Overview of the Run Tab” on 
page 205.)

2. For the appropriate run, CTRL-click to select the samples that are to be compared, and 
then right-click on any selected sample and on the context menu that opens, click 
Compare Samples.

The Sample Comparison dialog box opens. All the selected samples for the run are 
displayed in the dialog box. 

Figure 7-10:  Sample Comparison dialog box

3. Set the comparison parameters.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Samples pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 7-1: Run tab, Samples pane context menu (Continued)

Option Description

To compare all samples within a run, see “To compare all the samples within a 
run from the Runs tab” on page 184.

Option Description

Show columns The data columns that are displayed for each sample on the Sample 
Comparison tab. Allele Frequency (AF) is always displayed and you 
cannot change this option. Coverage (Cov) is displayed by default, but 
you can clear this selection. Read Balance (RB) is not displayed by 
default, but you can select this option.
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4. Click OK.

The Sample Comparison dialog box closes. The Sample Comparison results are 
displayed on the Sample Comparison tab. A distinct gray vertical line separates the two 
sides of the tab. The left side of the tab shows the sample-specific information, 
identifying each sample as 1, 2, and so on. If you hover your cursor over the column 
heading, then the full sample name is displayed. The right side of the tab shows the 
variant details. 

Figure 7-11:  Sample Comparison tab

     

Filter variants by panel Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that are contained within the selected panel.

Shared by Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that meet the required number of samples as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found in a number of samples 
that does not meet this criteria, then the variant is not displayed in the 
results.

AF difference

• Exclude missing 
variants

Limits the variants that are displayed on the Sample Comparison tab to 
only those variants that have a difference in allele frequency as 
specified by the operator that is selected on the dropdown list (>, <. or =) 
and the number of samples. If a variant is found with an allele frequency 
difference that does not meet this criteria, then the variant is not 
displayed in the results. 

Selected by default. Regardless of the allele frequency difference, 
always display variants that are not found in one or more samples.

AF between Limits the variants that are displayed on the Sample Comparison tab to 
only those variants with an allele frequency that falls within the indicated 
range in at least one of the compared samples.

Option Description
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To compare family data
If the samples for a run are from a family, then you can use the Family Comparison option to 
compare the samples based on the relationships and phenotypes for each sample. At a 
minimum, you must select two parent samples and one child sample. You can always select 
more than one child sample. 

1. If you have not done so already, open the Run tab. 

2. In the Samples pane, CTRL-click to select the family data that is to be compared. 

3. Right-click any selected sample, and on the context menu that opens, click Family 
Comparison.

The Family Comparison dialog box opens. If a patient is associated with a selected 
sample, then patient Relationship (Father, Mother, or so on) is displayed on the 
Relationship dropdown list; otherwise, you must select the appropriate relationship for 
the patient. Likewise, if the phenotype was included with the patient information, then 
the phenotype is automatically displayed on the Phenotype dropdown list for the sample, 
where Affected indicates that the patient has the phenotype and Unaffected indicates that 
the patient does not have the phenotype. If the phenotype is not automatically displayed 
for a sample, then you must select the appropriate value.

Figure 7-12:  Family Comparison dialog box

4. Do any or all of the following as needed:

• On the Phenotype dropdown list at the top of the dialog box, select a different 
phenotype.

• On the Inheritance pattern dropdown list, select the appropriate value for the family, 
and if applicable, based on the selected Inheritance pattern, select Compound 
heterozygous.

At a minimum, you must select two parent samples and one child sample. You can 
always select more than one child sample.
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• Indicate which columns to show or hide in addition to the default columns that are 
displayed for the family data comparison results: AF (Allele Frequency), Cov 
(Coverage), and/or RB (Read Balance).

• To display all the variants in each sample filtered by a selected panel, select Filter 
variants by panel, and then on the Panels dropdown list, select the appropriate panel.

5. Click OK.

The family data comparison is carried out. The Family Comparison tab opens. A distinct 
gray vertical line divides the two sides. The left side of the Family Comparison Results 
pane shows sample-specific information. The results are shown using standard pedigree 
symbols. If the patient that is associated with a sample is affected, then the pedigree 
symbol is shaded; otherwise, the symbol is not shaded. You can hover your cursor over a 
column header to view specific details for the selected sample. The right side of the tab 
shows variant detail information. See Figure 7-13 below and Figure 7-14 on page 217.

Figure 7-13:  Viewing information for a family comparison result

Select Compound heterozygous to carry out compound heterozygous filtering. The 
filtering results are displayed in the Family Data Comparison Results pane. the 
results show all possible combinations of two heterozygous variants in a gene if 
the variants meet the relationship and phenotype settings for the parent samples. 
For example, if a Mother is Unaffected and a Father is Unaffected, but a Son is 
Affected, then one heterozygous variant in the affected son must come from each 
parent.

After you select an Inheritance pattern, the zygosity for each sample is 
automatically adjusted based on the selected inheritance pattern and the 
relationship and phenotype for the sample. If you select an incorrect Inheritance 
pattern based on the relationships and phenotypes, then “Error” is displayed 
instead of a valid zygosity value.

Comparison of family data can take 30 minutes or more depending on a variety of 
factors, including the number of the samples that are being compared and the 
number of variants for each sample.
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Figure 7-14:  Family Comparison Results pane

Coverage Regions tab
The Coverage Regions tab has a single pane, the Coverage Regions pane, that displays the 
coverage information for every region in your panel. The Status column indicates whether 
the panel region passed or failed the Quality Control (coverage) settings that were set for the 
run’s panel. 

Figure 7-15:  Coverage Regions tab

Table 7-2: Coverage Regions tab 

Column Description

ID System-generated ID for the region.

Region Name The region description from Column 4 of the BED file.

Chrom The chromosome on which the region is located.

ChromRegionStart The starting chromosome position for the region.

ChromRegionEnd The ending chromosome position for the region.

Note: Together, the ChromRegionStart and ChromregionEnd make up the chromosome position range.

Chrom:Start-End The chromosome position range appended to the chromosome number.
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% Covered The percentage of the region that has reads aligned to it.

Average Coverage The average coverage (average number of aligned reads) for the region.

Minimum Coverage The minimum coverage (number of reads aligned) for any position within the region.

% Covered 
Threshold

The percentage of the region that must have reads aligned to it, or the region does not 
pass the Quality Control settings that have been set for the run’s panel. See “To specify the 
global Quality Control settings” on page 60.

Average Coverage 
Threshold

The average coverage (average number of aligned reads) required for the region, or the 
region does not pass the Quality Control settings that have been set for the run’s panel. 
See “To specify the global Quality Control settings” on page 60..

Minimum Coverage 
Threshold

The minimum coverage (number of reads aligned) that is required for any position within 
the region, or the region does not pass the Quality Control settings that have been set for 
the run’s panel. See “To specify the global Quality Control settings” on page 60.

Status Indicates if the region passed or failed the Quality Control (coverage) settings that were 
specified for the run’s panel. You can manually change the status for a region. If you 
manually change the status for a region, then the Update Panel Region dialog box opens. 
The dialog box lists the new status for the region, and you have the option of adding 
comments for the status change. The comments are displayed in the Status Comment 
field.

Figure 7-16:  Update Panel Region Status dialog box

Note: By default, only two statuses, Passed or Failed, are available, and one of these two 
statuses is always automatically selected for the region. You have the option of 
adding custom Panel Region statuses and manually selecting a status for a region. 
See “Managing Objects in the Geneticist Assistant” on page 51.

Table 7-2: Coverage Regions tab (Continued)

Column Description
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The context menu for the Coverage Regions tab title bar has the Manage Sample Group 
Statistics option which you can select if you used sample groups for a run and you want to 
calculate statistics for the run. (This option is also available on the tab title bar context menu 

Status Comment Displays any comments that were added when the region status is manually changed. You 
can double-click in this field to add a new comment or edit an existing comment. After you 
add or edit a comment, and then click out of the field, the Update Region Status Comment 
dialog box opens. 

Figure 7-17:  Update Status Region Comment dialog box

The dialog box displays the status and region positions for the selected region, the current 
(old) comment, and the new comment. You can make any additional edits to the new 
comment as needed, and then click OK to close the dialog box and add the new or 
modified comment for the region.

Average % Covered Average of the percent covered for the region across all samples for the panel.

Average Average 
Coverage

The average of the average coverage values for the region across all samples for the 
panel.

Average Minimum 
Coverage

The average minimum coverage for the region across all samples for the panel.

Passed The total number of samples for the panel for which the status of the region is Passed.

Passed Percent The percent of the samples for the panel for which the status of the region is Passed.

Failed The total number of samples for the panel for which the status of the region is Failed.

Total The total number of samples that were submitted for the panel.

Gene The gene on which the region is located.

Transcript The accession number for the mRNA transcript.

Protein The accession number for the protein transcript.

Exon Number The coding exon number for the region.

SD % Covered The standard deviation for the “% Covered” value across all samples for the panel.

SD Average 
Coverage

The standard deviation for the “Average Coverage” value across all samples for the panel.

SD Minimum 
Coverage

The standard deviation for the “Minimum Coverage” value across all samples for the 
panel.

Table 7-2: Coverage Regions tab (Continued)

Column Description
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for the Sample Variant Data sub-tab on the Sample tab. See “Sample Variant Data Sub-Tab” 
on page 246.) You can also right-click anywhere on the Coverage Regions tab to open a 
context menu with the following options:
 

To add selected panel regions or variants to an Action List

 An Action list is a list of items that require some type of follow up. You can create multiple 
action lists relative to the type of follow up that is needed. You can create an Action List for 
panel regions on the Coverage Regions tab or the Coverage Regions sub-tab on the Coverage 
QC tab or for variants on the Variants sub-tab on the Coverage QC tab or the Sample Variant 
Data sub-tab on the Sample tab. For example, if several panel regions failed the coverage 
settings for a run sample, then you can make an Action List that consists of these regions and 

Table 7-3: Coverage Regions tab context menu 

Option Description

Add Selected 
Regions to Action 
List

Adds the selected panel region to an Action List. CTRL-click to select multiple regions. 
See “To add selected panel regions or variants to an Action List” on page 220.

Add Selected 
Regions to Custom 
Report

Selects all the data that is displayed for the selected panel region for inclusion in a custom 
report. CTRL-click to select multiple regions. See Chapter 11, “Geneticist Assistant 
Reports,” on page 313.

Add All to Custom 
Report

Selects all the data that is displayed for all the panel regions for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Coverage Regions pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Coverage Regions pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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indicate that you want to review the coverage values for these regions.

1. Do one of the following:

• To select a single panel region for the Action list, right-click the appropriate panel 
region on the Coverage Regions tab or the Coverage Regions sub-tab on the 
Coverage QC tab, and on the context menu that opens, click Add Selected Regions 
to Action List.

• To select multiple panel regions, press and hold the CTRL key as you select the 
appropriate panel regions on the Coverage Regions tab or the Coverage Regions 
sub-tab on the Coverage QC tab, and then right-click any selected panel region, and 
on the context menu that opens, click Add Selected Regions to Action List.

• To select a single variant for the Action list, right-click on the appropriate variant on 
the Variants sub-tab on the Coverage QC tab or the Sample Variant Data sub-tab on 
the Sample tab, and on the context menu that opens, click Add Selected Variants to 
Action List.

• To select multiple variants, press and hold the CTRL key as you select the 
appropriate variants on the Variants sub-tab on the Coverage QC tab or the Sample 
Variant Data sub-tab on the Sample tab, and then right-click on any selected variant, 
and on the context menu that opens, click Add Selected Variants to Action List.

The Add To Action List dialog box opens. If the Action Type that you want to use is 
already available on the Action type dropdown list, then go to Step 5; otherwise, if this is 
the first time that you are creating an Action List for the pane or the Action Type that you 
want to use is not available on the Action Type dropdown list, then you must add at least 
one type to the list. Go to Step 2.

Figure 7-18:  Add To Action List dialog box

2. Click New Type.

The Add To Action List dialog box is refreshed with an option for adding an action type.

3. In the New Type field, enter an action type (for example, Review Coverage), and then 
click Add.

The action type is added to the Action Type list. The Add to Action List dialog box is 
refreshed to show the full Action Type dropdown list and Comment field.
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4. Repeat Step 2 and Step 3 as needed to add more action types.

5. On the Action Type dropdown list, select the appropriate action type.

6. Optionally, in the Comment field, enter a comment that explains/supports your decision 
for adding the selected panel regions or variants to an Action list.

7. Click OK.

The Add To Action List dialog box closes. The Action List tab for the sample opens. 
Different panes (grouped by Action Type) list any panel regions for the sample that have 
been selected for an Action list and any variants for the sample that have been selected 
for an Action list.

Figure 7-19:  Action List tab

To calculate panel statistics (Run tab)
The Panel Statistics tab has options for displaying specific information based on a selected 
panel and panel group as well as any or all of the following criteria: 

• All panel samples, or selected panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

If you are creating an Action List for panel regions, then only the action types that 
were created specifically for panel regions are available. Likewise, if are creating 
an Action List for variants, then only the action types that were created 
specifically for variants are available. 

To save an Action List, you can generate a standard Action List Report. If multiple 
panes are included on the Action List tab, then by default, all these panes are 
included in the report. To remove a pane from the report, before generating the 
report, right-click the pane that you want to remove, and then click Remove. See 
“Generating a Standard Report” on page 315.
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To display data on the Panel Statistics tab

1. If you have not already done so, open the Run tab for the appropriate run. (See 
“Overview of the Run Tab” on page 205.)

2. In the Samples pane, select a sample or CTRL-click to select multiple samples, and then 
right-click on any selected sample and on the context menu that opens, click Panel 
Statistics. 

The Panel Statistics tab opens. The Coverage Regions sub-tab is the open tab. The panel 
and panel group that were used for the run are selected. You can select a different panel 
from the Panel dropdown list to view statistics for a different panel. You can also select a 
different panel to change the panel group, but you cannot change the panel group 
directly. By default, the statistics are calculated for all the samples in the selected run 
that have been added to the panel. 

Figure 7-20:  Coverage Regions sub-tab (Panel Statistics tab)

3. Optionally, edit any or all of the calculation criteria as needed, and then click OK to 
recalculate the panel statistics and update the display accordingly. 

If you select a small number of samples, such as two to four, then, by default, the 
panel statistics are calculated based only on the selected samples and before the 
statistics are calculated, a Very few samples message dialog box opens, warning 
you of this and asking you if you want to continue. You can click Yes, or you can 
click Cancel to return to the Run tab and select more samples.

Option Description

All panel samples If you select this option, then by default, all samples that have been added to 
the panel are displayed. To specify a custom date range, select added 
between, and then change one or both dates as needed. To change the 
dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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4. Optionally, after calculating the panel statistics, continue to any of the following needed 
to view information on any of the five sub-tabs that are available for the Panel Statistics 
tab:

Selected runs To select specific runs for the panel, choose Selected runs, and then click the 

Browse button  that is next to Selected Runs to open the Select Runs 

dialog box. All the runs for the selected panel are displayed in the dialog box. 
Select the appropriate run, or CTRL-click to select multiple runs, and then 
click OK.

Figure 7-21:  Select Runs dialog box

Selected samples To select only specific samples for the panel, choose Selected samples and 

then click the Browse button  that is next to Selected samples to open 

the Select Samples dialog box. All the samples for the selected panel are 
displayed in the dialog box. Select the appropriate sample, or CTRL-click to 
select multiple samples, and then click OK.

Figure 7-22:  Select Samples dialog box

Option Description
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• Coverage Regions sub-tab. See “Coverage Regions sub-tab (Panel Statistics tab)” 
below.

• Samples sub-tab. See “Samples sub-tab (Panel Statistics tab)” below.

• Variants sub-tab. See “Variants sub-tab (Panel Statistics tab)” on page 226.

• Patients sub-tab. See “Patients sub-tab (Panel Statistics tab)” on page 190.

• Reports sub-tab. See “Reports sub-tab (Panel Statistics tab)” on page 191.

Coverage Regions sub-tab (Panel Statistics tab)

The Coverage Regions sub-tab has a single pane, the Coverage Regions pane, that lists by 
default, the coverage information across all the samples of the selected run for every region 
in the selected panel and panel group. See “Coverage Regions tab” on page 217 for a detailed 
discussion of the information that is displayed on this sub-tab.

Figure 7-23:  Coverage Regions sub-tab (Panel Statistics tab)

Samples sub-tab (Panel Statistics tab)

The Samples sub-tab has a single pane, the Samples pane, that lists by default, all the 
samples for the selected run that were imported for the selected panel and panel group. (See 
Figure 7-24 on page 226.) You can double-click a sample on this sub-tab to open the Sample 
tab. (See Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 243.) You 
can also right-click a sample on the sub-tab to open a context menu that has options that are 
identical to options that are on the context menu for the Samples pane on the Run tab. See 
“The Samples Pane (Run tab) Context Menu” on page 207.
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Figure 7-24:  Panel Statistics tab, Samples pane

Variants sub-tab (Panel Statistics tab)

The Variants sub-tab has a single pane, the Variants pane, that lists by default, all the variants 
that were detected in all the samples for the selected run that were imported for the selected 
panel and panel group. The information that is displayed on this sub-tab is identical to the 
information that is displayed on the Variants sub-tab on the Patient tab. You can double-click 
a variant on this sub-tab to open the Variant tab. (See Chapter 10, “Geneticist Assistant Data 
Review - Variant Tab,” on page 291.) You can also right-click a variant on this sub-tab to 
open a context menu that has options that are identical to options that are on the context 
menu for the Sample Variant Data sub-tab on the Sample tab. See “Sample Variant Data Sub-
Tab” on page 246.

Figure 7-25:  Panel Statistics tab, Variants sub-tab

Reports sub-tab (Panel Statistics tab)

The Reports sub-tab contains a single pane, the Reports pane, that lists by default, all the 
reports that were generated for the samples for the selected run that were imported for the 
selected panel and panel group and saved to the Geneticist Assistant database. See Figure 7-
26 on page 227.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.
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Figure 7-26:  Panel Statistics tab, Reports sub-tab

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 146.

To set or edit the Read/Write permissions for the samples in a run 
on a per sample basis

1. If you have not already done so, open the Run tab. (See “Overview of the Run Tab” on 
page 205.)

2. In the Samples pane, select the samples, or CTRL-click to select the multiple samples for 
which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the names of all the users 
and/or groups and their assigned permissions for the run. See Figure 7-27 on page 228.

For detailed information about generating and saving Panel Statistics reports, see 
Chapter 11, “Geneticist Assistant Reports,” on page 313.

You can assign Read and Write permissions for all the samples in a run in a single 
step. See “To set or edit the Read/Write permissions for a run” on page 191.
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Figure 7-27:  Permissions dialog box (Run tab, Samples pane)

4. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the sample record. They cannot edit it.

7. Optionally, if the user or group must be able to edit the sample record as well, then select 
the Can Write permission.

8. Click OK.

A Permission Updated message opens.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample record.

To manage a Batch Variants report (Run tab)
A Batch Variants report is a report that includes information for variants in a selected 
sample, and allows you to create multiple reports for multiple samples in a single step. If you 
generate a Batch Variants report from the Run tab, then a separate report is saved for each of 
the selected samples in the run. A Batch Variants report configuration determines the data 
that is to be included in the report. You choose if the configuration is to be available only to 
the user who created it, or to all users. The configuration does not include the report format 
(PDF, HTML and so on), or the location in which the report is to be saved. Instead, you must 
specify the format and location in which to save the report every time you generate a report 
for a new or saved configuration. 

Figure 7-28:  Batch Variants Report dialog box

In Geneticist Assistant, you can generate a Batch Variants report according to a new or saved 
configuration, edit a Batch Variants report configuration, or delete a Batch Variants report 
configuration. See:

• “To generate a Batch Variants report based on a new configuration” below.

• “To generate a Batch Variants report based on a saved configuration” on page 231.

• “To edit a Batch Variants report configuration” on page 232.

• “To delete a Batch Variants report configuration” on page 233.

To generate the report for all variants in all the samples for the run, see “To 
manage a Batch Variants report (Runs tab)” on page 193.)
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To generate a Batch Variants report based on a new configuration
 

The name for a Batch Variants report is automatically assigned based on the sample ID 
number and sample name for the first sample in the list of samples which you are generating 
the report (for example, 76_800458.variants.filter) and you cannot change this. You must 
select a location in which to save the report.

1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, on the Report Type dropdown list, select the 
report type. (The default value is PDF.)

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave this location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Optionally, to filter the data that is to be displayed in the report, click Filter, and then 
from the Filter dropdown list, select the appropriate pre-configured filter.

7. Optionally, to set the display preferences for the report, do any of the following as 
needed:

• Rearrange the data columns.

• Rename a column header.

• Show/hide columns (manually or by loading a configuration).

8. Optionally, to view an onscreen preview of the report before it is generated and saved, 
click Preview.

     

For detailed information about filtering the data that is displayed in a report, see 
“To filter the data that is displayed in a tab pane” on page 32.

For detailed information about working with data columns, including moving and 
renaming columns, or showing/hiding columns, see “Setting Display Preferences 
in the Geneticist Assistant Main Window” on page 31.
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9. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box with a message 
that indicates that the report was generated and where the report was saved.

10. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To generate a Batch Variants report based on a saved 
configuration
  

1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

4. On the Batch Variants Report dialog box, select the output format for the report.

5. If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. Do one of the following:

• Leave the location as-is, and then go to Step 6.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

6. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

7. Click Load Configuration.

The Load Configuration dialog box opens. The dialog box displays all your private and 
public configurations as well as all the configurations that other users have made public.

Figure 7-29:  Load Configuration dialog box
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8. Select a configuration, and then click Load.

The Load Configuration dialog box closes. The Select Columns dialog box remains 
open. The dialog box now reflects the columns that are to be included in the report based 
on the selected configuration.

9. Click Close (x) to close the Select Columns dialog box.

10. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

11. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box with a message 
that indicates that the report was generated and where the report was saved.

12. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To edit a Batch Variants report configuration
 

When you edit a Batch Variants report configuration, any reports that were generated 
according to the “old” (previous) configuration are not affected. Going forward, the report is 
generated based on the “new” configuration. 

1. If you have not already done so, open the Run tab.

2. In the Samples pane, select the sample or CTRL-click to select the multiple samples for 
which the Batch Variant report is to be generated.

3. Right-click any selected sample, and on the context menu that opens, click Export > 
Create Batch Variants report.

If a Batch Variants report has previously been generated and saved, then the location in 
which the report was saved is displayed in the Save To field when the Batch Variants 
Report dialog box opens; otherwise, this field is blank. 

4. Do one of the following:

• Leave this location as-is, and then go to Step 5.

• To change this location, then next to the Save To field, click the Browse button , 

and then browse to and select the location in which the report is to be saved.

5. Right-click on any heading in the Input Format pane, and then choose Select Columns.

The Select Columns dialog box opens. 

6. To edit the report configuration, see “To create/edit a pane configuration” on page 39.
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7. Optionally, to preview an onscreen preview of the report before it is generated and 
saved, click Preview.

8. Click OK.

The Batch Variants report is generated for each of the selected samples. After the report 
is successfully generated, a Batch Variants Report Finished dialog box opens, with a 
message that indicates where the report was saved.

9. Click OK.

The dialog box closes. You return to a blank Current Jobs tab on the Geneticist Assistant 
main window.

To delete a Batch Variants report configuration
 

You can delete a Batch Variants report configuration only if you created the report 
configuration. When you delete a Batch Variants report configuration, any reports that were 
generated according to the “old” (previous) configuration are not affected. Going forward, 
the “old” configuration is simply not available for selection.

1. On the Batch Variants Report dialog box, right-click on any heading in the Input Format 
pane, and then choose Select Columns.

The Select Columns dialog box opens. 

2. See “To delete a pane configuration” on page 41.

3. Click Close (x) to close the Batch Variants Report dialog box.

To generate a Batch Coverage report (Run tab)
The Batch Coverage report generates a coverage report for each of the selected samples in a 
run in a specific panel or panels and panel group. The report also includes coverage statistics 
for the panel that are calculated based on one of the following options: 

• All panel samples.

• Samples that have been added to the panel within the last 30 days of the current day’s date, 
or a custom date range.

• Selected runs for the panel.

• Selected panel samples.

1. If you have not already done so, open the Run tab.

     

You are not prompted about confirming the deletion of a Batch Variants report 
configuration, so be very sure that the deletion must be deleted before doing so.
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2. In the Samples pane, right-click a sample (CTRL-click to select multiple samples), and 
on the context menu that opens, click Export > Create Batch Coverage report.

The Batch Coverage Report dialog box opens. All the selected samples for the run are 
displayed in the bottom pane of the dialog box. If multiple samples are selected with 
different panels, then a separate tab is displayed for each panel. 

Figure 7-30:  Batch Coverage Report dialog box (Runs tab)

3. Leave the report type set to the default value of HTML, or select a different report type.

4. Next to the Save To field, click the Browse button  to open the Save To dialog box, 
and then browse to and select the location in which to save the report.

5. To calculate the panel coverage statistics for the report based on all panel samples, click 
OK; otherwise, specify the different options by which to calculate the panel coverage 
statistics, and then click OK. 

Option Description

All panel samples 
added between

To specify a custom date range for calculating the panel coverage statistics, 
select added between, and then change one or both dates as needed. To 
change the dates, you can do either of the following:

• You can select any part of the date that you want to change, or the entire 
date, and then manually enter the new value. (The default date range is 
the last 30 days).

• You can select any part of the date that you want to change, and then use 
the Up/Down arrows to change the date accordingly.
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Selected runs To select specific runs for calculating the panel coverage statistics, choose 

Selected runs, and then click the Browse button  that is next to Selected 

runs to open the Select Runs dialog box. All the runs for the panel are 
displayed in the dialog box. Select the appropriate run, or CTRL-click to select 
multiple runs, and then click OK.

Figure 7-31:  Select Runs dialog box

Selected samples To select only specific samples for calculating the panel coverage statistics, 

choose Selected samples and then click the Browse button  that is next 

to Selected samples to open the Select Samples dialog box. All the samples 
for the panel are displayed in the dialog box. Select the appropriate sample, 
or CTRL-click to select multiple samples, and then click OK.

Figure 7-32:  Select Samples dialog box

Option Description
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After you click OK to generate the report, the Current Jobs tab opens. The tab displays 
the progress of calculating the coverage information for every sample that was selected 
for the report. A report file is saved for each selected sample in the specified format and 
the specified location. 

To generate a PDF report (Run tab)
A PDF report is a report that includes information for one or more selected samples in a run. 
When you generate a PDF report from the Run tab, then a separate report is saved for each 
selected sample. The custom report template that you select for the PDF report determines 
the data that is to be included in the sample report as well as the layout of the report. The 
template does not specify the report names, the report formats, or the location in which the 
reports are to be saved. Instead, each report is named the same as the sample for which it was 
generated, and each report is saved as a PDF. You cannot change the report name, nor can 
you select a different report format for any report. You must specify the location in which to 
save the sample reports every time you generate a PDF report.

1. If you have not already done so, open the Run tab for the appropriate run.

2. Select a single sample, or CTRL-click to select multiple samples.

3. Right-click on any selected run, and on the context menu that opens, click PDF Reports.

A sub-menu opens with a list of all the available custom report templates that have been 
designed for Sample data. 

4. Select the appropriate custom report template.

The Save <Custom Report Template Name> dialog box opens. The dialog box displays 
all the samples that have been selected for the run. See Figure 7-33 on page 237.

If the panel coverage statistics are to be calculated based on only a small number 
of samples, such as two to four, then, before the statistics are calculated, a Very 
few samples message dialog box opens, warning you of this and asking you if you 
want to continue. You can click Yes, or you can click Cancel to return to the Runs 
tab.

For information about designing and saving a custom report template, see 
“Designing a Custom Report Template” on page 322.

A Preview option is available to view a single sample report onscreen. This single 
report contains all the samples, and you can save this single report with a name of 
your choosing and in a format of your choosing as well (PDF, HTML, or XLXS).
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Figure 7-33:  Save <Custom Report Template Name> dialog box

5. Optionally, to filter the report results before generating the reports, on the Filters 
dropdown list, select the appropriate filter.

6. Optionally, to preview a single report onscreen before generating and saving the final 
sample reports, click Preview.

7. To save all the sample reports in PDF format to a location of your choice, click Save As.

The Choose Report Directory dialog box opens. 

8. In the Choose Report Directory dialog box, browse to and select the directory in which 
to save the sample reports, and then click Select Folder.

The Choose Report Directory dialog box closes, and a report is generated for each 
sample. After the sample reports are successfully generated, a PDF Report Finished 
message dialog box opens indicating this.

Figure 7-34:  PDF Report Finished dialog box
‘

     

For information about creating and saving filters for the data in your Geneticist 
Assistant database, see “To filter the data that is displayed in a tab pane” on page 
32.

The toolbar of the onscreen preview contains a variety of options for working with 
the report, including printing the report, and saving the report with a name of your 
choosing in a format of your choosing, including PDF, HTML, and XLSX file.
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9. Click OK.

The message dialog box and the Save <Custom Report Template Name> dialog box 
close. The sample reports are now available in the specified location in PDF format.
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Status Changes pane (Run tab)
The Run’s Status Changes pane shows the history of all the status changes that have been 
made for the run in chronological order. A New status entry is always displayed for a run. 
You can right-click anywhere on this pane to open a context menu with the following 
options:

Option Description

Add All to Custom 
Report

Selects all the information that is displayed for all the statuses for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Run Status Changes pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Comments pane (Run tab)
The Comments pane on the Run tab shows all the comments that have been added for the run 
in reverse chronological order. You can right-click anywhere on this pane to open a context 
menu with the following options:

Option Description

Add Run Comment Opens the Add Comment dialog box. You add a comment for the selected run in the Add 
comment field. The comment is displayed in the Comment field on the Runs tab and the 
Comment field in the Comments pane on the Run tab. 

Figure 7-35:  Add Run Comment dialog box

Note: If multiple comments have been added for a run, then only the last added comment 
is displayed in the Comment field on the Runs tab. All the comments that have been 
added for a run, including the last added, are displayed in reverse chronological 
order in the Comments pane on the Run tab.

Delete Run 
Comment

Opens the Delete Comment dialog box. The dialog box displays the name of the selected 
run and the comment that is being deleted. Click OK to delete the selected comment.

Figure 7-36:  Delete Comment dialog box
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Add All to Custom 
Report

Selects all the information that is displayed for all the statuses for inclusion in a custom 
report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Run Status Changes pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Run Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Option Description
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Reports pane (Run tab)
The Reports pane displays all the reports that were generated for the selected run and saved 
to the Geneticist Assistant database.

You can right-click anywhere on this pane to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 146.

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 11, “Geneticist Assistant Reports,” on page 313.
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Many options are available from the Sample tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Sample Tab” on page 245.

• “Sample Variant Data Sub-Tab” on page 246.

• “Sample Data Sub-Tab” on page 268.

• “Variant Interpretation Data Sub-Tab” on page 276.

• “Case Data Sub-Tab” on page 277.

• “Submission Sub-Tab” on page 278.
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Overview of the Sample Tab
The Sample tab displays information for a sample that was selected from the Run tab. To 
open the Sample tab, do one of the following:

• Right-click a sample on the Run tab, and on the context menu that opens, select Sample 
Details.

• Double-click a sample on the Run tab.

Figure 8-1:  Sample tab, Sample Variant Data sub-tab

The Sample tab has five sub-tabs:

• The Sample Variant Data sub-tab. See “Sample Variant Data Sub-Tab” on page 246.

• The Sample Data sub-tab. See “Sample Data Sub-Tab” on page 268.

• The Variant Interpretation sub-tab. See “Variant Interpretation Data Sub-Tab” on page 
276.

• The Case Data sub-tab. See “Case Data Sub-Tab” on page 277.

• The Submission sub-tab. See “Submission Sub-Tab” on page 278.
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Sample Variant Data Sub-Tab
The Sample Variant Data sub-tab is the sub-tab that opens after you open the Sample tab 

Figure 8-2:  Sample tab, Sample Variant Data sub-tab

The Sample Variant Data sub-tab has a single pane, the Variants pane, that displays 
information about all the variants that were identified in the selected sample. By default, two 
types of information are always displayed on the sub-tab: variant annotation information and 
global variant count and frequency information. The pane also displays statistical 
information if a sample group was used for the run and statistics were calculated for the 
sample group. A variety of options are available for working with a variant that is displayed 
on this sub-tab, and a context menu is also available. See:

• “Variant annotation information” on page 247.

• “Global variant count and frequency information” on page 252.

• “Sample group statistical information” on page 253.

• “Variant options on the Sample Variant Data sub-tab” on page 254.

• “Sample Variant Data sub-tab context menu” on page 257.

The information that is displayed on the Sample Variant Data sub-tab was divided 
into three separate tables simply for ease of reading in this manual and locating 
and identifying the information on the sub-tab. There is no visible division of this 
information on the sub-tab itself.
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Variant annotation information
The following table lists the variant annotation information that is displayed on the Sample 
Variant Data sub-tab.

• Remember, you can select which columns to show and which columns to hide in 
a pane. See “To show/hide columns in a tab pane” on page 37. 

• Remember, you can specify how the information about the variants is displayed 
on the sub-tab. See “To specify variant preferences” on page 65. 

• Selected columns from the various reference information panes on the Variant 
tab can also be displayed here. See Chapter 10, “Geneticist Assistant Data 
Review - Variant Tab,” on page 291.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information 

Column Description

ID System-generated value that identifies the variant. 

Chromosome The chromosome on which the variant is located.

Chromosome 
Position

The chromosome position where the variant is located.

Chr:ChrPos The chromsome:chromosome position for the variant location.

Rs The dbSNP database identification for the variant. 

Note: If a value other than N/A is displayed, then it is a hyperlink to the NCBI dbSNP web 
page for the variant.

Ref The reference nucleotide at the variant position.

Ref AA The reference amino acid coded for by the codon that includes the variant position.

Alt The variant nucleotide at the variant position.

Alt AA The variant amino acid coded for by the codon that includes the variant position.

Type The type of variant based on the amino acid change that the variant caused. Values are 
Missense, Synonymous, Frameshift, or Nonsense.

Coverage The coverage (number of reads) aligned to the variant location in the sample.
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Pathogenicity The pathogenicity of the variant, which is the potential for the variant to cause disease. By 
default, the pathogenicity is always set to an initial value of Unassigned. You must review 
the information for the variant and then decide what the pathogenicity should be; for 
example, Deleterious. (If you cannot determine the pathogenicity of the variant even after 
reviewing all the relevant information, you can set the status to Unknown.) After you set 
the pathogenicity for a variant, the next time that the variant is detected in another sample, 
this is the pathogenicity that is displayed for the variant. To open the Submit Pathogenicity 
Status dialog box, double-click in this column for the selected variant. You can update the 
pathogenicity for the selected variant and/or the status of the pathogenicity in this dialog 
box. You can also add a comment about the pathogenicity change and/or pathogenicity 
status change

Note: The option to update the pathogenicity and/or pathogenicity status (“Update 
Pathogenicity”) is also available on the context menu for the sub-tab. 

Figure 8-3:  Submit Pathogenicity dialog box

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely Benign, 
and Benign—are available. You have the option of adding custom pathogenicities. See 
“Managing Objects in the Geneticist Assistant” on page 51.

• Optionally, you can add supporting information for this pathogenicity change. See “To 
add supporting information for a variant” on page 303.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Pathogenicity Status” below.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Pathogenicity Status The status of the selected pathogenicity. You must manually set this value.To open the 
Update Variant Pathogenicity Status dialog box, double-click in this column for the 
selected variant. You can set just the pathogenicity status for the variant in this dialog box. 
You can also add a comment about the status change.

Note: The option to update just the status (“Update Pathogenicity Status”) is also available 
on the context menu for the sub-tab. 

Figure 8-4:  Update Variant Pathogenicity Status dialog box

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Artifact Type The artifact type for the selected variant. You must manually set this value. Double-click in 
this column for the selected variant to open the Update Artifact Type dialog box. You 
specify the artifact type (for example, Sequencing) for the variant in this dialog box. If the 
appropriate artifact type is not available, then an option is provided to create a new type.

Note: The option to update the artifact type (“Update Artifact Type”) is also available on 
the context menu for the sub-tab.

Figure 8-5:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of the 
sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the same 
time.

• You can also define artifact types and set the artifact type for a variant on the Variants 
sub-tab on the Patient tab, on the Variants sub-tab on the Panel Statistics tab from the 
Runs tab or the Run tab, or on the Sample Variant Data sub-tab on the Sample tab.

• By default, only a single artifact type, None, is available. You have the option of adding 
custom artifact types. See “Managing Objects in the Geneticist Assistant” on page 51.

Variant Frequency The frequency at which the variant was detected in the sample. Any value < 1 is allowed, 
with 1 = 100%, 0.5 = 50%, and so on.

Zygosity Indicates whether the variant is heterozygous or homozygous.

Note: The selected zygosity is based on the Zygosity settings that you have specified on 
the Variant Preferences tab of the Settings dialog box. See “To specify variant 
preferences” on page 65.

Read Balance The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Gene The gene on which the variant is located.

Gene Strand The strand (+ or -) for the gene in which the variant is located.

Exon Number The exon within the gene in which the variant is located. Includes non-coding exons. 
“Intron” is displayed for intronic variants. 

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Transcript The accession number for the preferred mRNA transcript that is used for the HGVS 
nomenclature columns.

Protein The accession number for the protein transcript that is associated with the preferred 
mRNA transcript and is used for the HGVS nomenclature columns.

Coding Base The position in the coding regions for the gene where the variant is located.

Codon Position The position within the codon where the variant is located (1, 2, or 3).

AA Position The amino acid number within the gene for the amino acid coded for by the codon that 
includes the variant position.

HGVS Genomic The HGVS genomic nomenclature for the variant. (www.hgvs.org/mutnomen).

HGVS Coding The HGVS coding DNA nomenclature for the variant relative to the reference accession 
that is shown in the Transcript column. (www.hgvs.org/mutnomen).

HGVS Protein The HGVS protein nomenclature for the variant relative to the reference accession that is 
shown in the Protein column. (www.hgvs.org/mutnomen).

Variant Comment The last added comment for the variant. You can also double-click in this field, and then 
add or edit a comment as needed. After you click out of the field, the Update Variant 
Comment dialog box opens. 

Figure 8-6:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or modified 
comment for the variant.

Note: You can also add comments for a variant with an option on the context menu for this 
sub-tab. See “Add Variant Comment” on page 258.

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed here and on the Variants sub-tab on the Patient tab, the Sample Variant 
Data sub-tab in the Sample tab, the Variant pane on the Variant tab, and the Variant 
Comments pane on the Variant tab. All the comments that have been added for a 
variant, including the last added, are displayed in reverse chronological order in the 
Variant Comments pane on the Variant tab.

Times Observed Per 
Run

The number of times that the variant was detected across all samples in the run.

Panel The panel that was used for the run.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description
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Global variant count and frequency information
The following table lists the global variant count and frequency information that is displayed 
on the Sample Variant Data sub-tab.

Panel Group The panel group to which the panel is assigned.

Trans Indicates whether the variant is Transition (Ti) or Transversion (Tv).

Sample The sample name.

HGMD Mutation The amino acid changes that was caused by the variant as recorded in HGMD.

HGMD HGVS The HGVS code relative to HGMD.

HGMD ID The ID for the variant in HGMD.

CDS number The coding exon number. 

Note: If you have not specified your login settings for the HGMD database (see “To specify HGMD settings” on 
page 70), then these last three columns are not displayed.

Table 8-1: Sample Variant Data sub-tab: Variant Annotation information (Continued)

Column Description

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information 

Column Description

Samples Per Panel The total number of samples submitted per panel.

Coverage Region 
Status

Indicates whether the region passed or failed the Quality Control (coverage) settings that 
were specified for the run’s panel. 

Note: Any of the following values that can also be reported as real or related to the artifact type for the variant are 
marked with an asterisk. For example, for Times Observed Per Panel, two additional columns are also 
displayed—Times Observed As Real Per Panel and Times Observed As Artifact Per Panel, where the 
number of samples for which the Artifact Type is set to None is reported for any Observed as Real value and 
the number of samples for which the Artifact Type is set to any other value, such as Sequencing, is reported 
for any Observed as Artifact value.

Times Observed Per 
Panel*

The number of times that the variant was detected across all samples per panel.

Frequency Observed 
Per Panel*

The frequency at which the variant was detected across all samples per panel.

Samples Per Patient 
Per Panel

The number of samples that are included in the Geneticist Assistant database for the 
patient who is associated with the selected sample relative to the panel that is assigned for 
the selected sample.

Times Observed Per 
Patient Per Panel*

The number of times that the variant was detected for the patient who is associated with 
the selected sample relative to the panel that is assigned for the selected sample.

Frequency Observed 
Per Patient Per 
Panel*

The frequency at which the variant was detected for the patient who is associated with the 
selected sample relative to the panel that assigned for the selected sample.

Samples Per Panel 
Group

The number of samples that are included in the panel group that include the panel that is 
assigned to the selected sample.

Times Observed Per 
Panel Group*

The number of samples that include the variant and that are assigned to any panel that is 
included in the same panel group as the panel for the selected sample.
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Sample group statistical information
The following table lists the sample group statistical information that is displayed on the 
Sample Variant Data sub-tab.

Frequency Observed 
Per Panel Group*

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample.

Patient Variant 
Frequency

The frequency of the variant found in the patient sample. If multiple samples for a patient 
have been loaded, then all samples are considered.

Samples With 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
panel region in which the variant is located has a status of Passed for the sample.

Times Observed In 
Passed Regions Per 
Panel

The number of samples that are assigned to the panel for the selected sample where the 
variant is reported and the panel region in which the variant is located has a status of 
Passed for the sample.

Frequency Observed 
In Passed Regions 
Per Panel

The frequency at which the variant was detected considering only those samples that are 
assigned to the same panel as the selected sample and where the panel region in which 
the variant is located has a status of Passed.

Samples With 
Passed Regions Per 
Patient Per Panel

The number of samples that are assigned to the patient and panel that are assigned to the 
current sample where the panel region in which the variant is located has a status of 
Passed.

Times Observed In 
Passed Regions Per 
Patient Per Panel

The number of samples that are assigned to the patient and panel that are assigned to the 
current sample where the variant is found and the panel region in which the variant is 
located has a status of Passed.

Frequency Observed 
In Passed Regions 
Per Patient Per 
Panel

The frequency at which the variant was detected in all samples that are assigned to the 
patient and panel that are assigned to the current sample, and the panel region has a 
status of Passed.

Samples With 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the panel region in which the variant is 
located has a status of Passed.

Times Observed In 
Passed Regions Per 
Panel Group

The number of samples that are assigned to any panel that is included in the same panel 
group as the panel for the selected sample where the variant is found and the panel region 
in which the variant is located has a status of Passed.

Frequency Observed 
In Passed Regions 
Per Panel Group

The frequency at which the variant was detected in all samples that are assigned to any 
panel that is included in the same panel group as the panel for the selected sample where 
the panel region in which the variant is located has a status of Passed.

Table 8-2: Sample Variant Data sub-tab: Global Variant Count and Frequency information (Continued)

Column Description

To calculate the statistics for the sample group, use the Manage Sample Group 
Statistics option on the column header context menu for the sub-tab. See “Sample 
Variant Data sub-tab context menu” on page 257.
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Variant options on the Sample Variant Data sub-tab
You can do the following for a variant that is displayed on the Sample Variant Data sub-tab 
on the Sample tab:

• You can specify how the information about the variants is to be displayed on this sub-tab. 
See “To specify variant preferences” on page 65.

• If the variant is located where there are overlapping genes, then you can select a different 
gene for the variant on the Gene dropdown list. If you select a different gene, then the 
gene that is used on the current tab for the current Geneticist Assistant session is 
temporarily changed. After you close and then re-open Geneticist Assistant, the selected 
gene is reset to the preferred gene. To permanently change the gene that is used for 

Table 8-3: Sample Group Statistics Columns on the Sample Variant Data sub-tab 

Column Description

Number of Samples Number of samples that.have been submitted for the sample group to which this sample is 
assigned.

Number of Samples 
Having the Variant

Number of samples in the group that contained the variant.

Coverage Min The minimum coverage (number of reads) for the variant in the sample group.

Coverage Max The maximum coverage (number of reads) for the variant in the sample group.

Coverage Median The median coverage (number of reads) for the variant in the sample group.

Coverage Standard 
Deviation

The variation from the Coverage mean for the variant in the sample group.

Variant Frequency 
Min

The minimum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Max

The maximum frequency at which the variant was detected in the sample group. Any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Median

The median frequency at which the variant was detected in the sample group. Any value < 
1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Mean

The mean frequency at which the variant was detected in the sample group. Any value < 1 
is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Frequency 
Standard Deviation

The variation from the Frequency mean for the variant in the sample group.

Read Balance Min The minimum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance Max The maximum value for the balance in forward and reverse oriented reads with the variant 
in the sample group as reported in the VCF file.

Read Balance 
Median

The median value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance Mean The mean value for the balance in forward and reverse oriented reads with the variant in 
the sample group as reported in the VCF file.

Read Balance 
Standard Deviation

The variation from the Read Balance mean for the variant in the sample group.
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variant, you can add a preferred gene for the panel. See “To set or delete a preferred gene 
for a panel” on page 108.

• You can select a different transcript for the variant on the Transcript dropdown list. If you 
select a different transcript, then the transcript that is used on the current tab for the 
current Geneticist Assistant session is temporarily changed. After you close and then re-
open Geneticist Assistant, the selected transcript is reset to the preferred transcript. 

• You can single click twice in the Variant Comment field to select the current comment in 
the field and edit it, or if the field is blank, enter a new comment. After you add or edit a 
comment, and then click out of the field, the Update Variant Comment dialog box opens. 

Figure 8-7:  Update Variant Comment dialog box

The dialog box displays the variant for which you are adding or editing the comment, the 
current (old) comment, and the new comment. You can make additional edits to the new 
comment needed, and then click OK to close the dialog box and save the new or 
modified comment for the variant.

• You can click once in the Type field, the Zygosity field, the HGVS Genomic field, the 
HGVS Coding field, the HGVS Protein field, and/or the Read Balance field to select the 
current value in the field and edit it, or if the field is blank, enter a new value.

To permanently change the transcript that is used for a gene or genes, you can do 
one of two things: You can right-click the variant, and on the context menu that 
opens, click Edit Variant > Update Preferred Transcript (see “Sample Variant 
Data sub-tab context menu” on page 257), or you can add a preferred transcript 
list for the panel. See “To set or delete a preferred transcript list for a panel” on 
page 106.

You can also use the Add Variant Comment option that is available on the context 
menu for the variant to add a new variant comment. See “Add Variant Comment” 
on page 258. 
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If you make a change to any of these values for the variant, then these changes are 
recorded for the variant on the Variant Changes pane on the Variant tab. See 
“Variant Changes pane” on page 299. These changes are also reflected in the 
appropriate fields on all the variant tabs, sub-tabs, and panes in Geneticist 
Assistant.
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Sample Variant Data sub-tab context menu
You can right-click any column header on the Sample Variant Data sub-tab to open a context 
menu that, in addition to the standard column header context menu options, contains a 
Manage Sample Group Statistics Columns option. This option opens the Select Sample 
Groups dialog box. 

Figure 8-8:  Select Sample Groups dialog box

• If you used sample groups for a run, then you can indicate the date range for which to 
calculate statistics based on the added samples.

• If you did not use sample groups for a run, you can clear the options for selected sample 
groups, which hides the corresponding Sample Group Statistics columns from the sub-tab 
display. 

You can also right-click a variant in the Variants pane on the sub-tab to open a context menu 
with the following options:

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu 

Option Description

Variant Details Opens the Variant tab, which displays detailed information about the variant. See 
Chapter 10, “Geneticist Assistant Data Review - Variant Tab,” on page 291.

Show Variants Filtered 
by Panel

Displays all the variants in the selected sample filtered by a selected panel or panels. If 
you select this option, then the Select Panel to Filter Variants dialog box opens. You 
must select a panel or panels in this dialog box by which to filter the variants for the 
selected run.

Figure 8-9:  Select Panel to Filter Variants dialog box
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Show Samples with 
Selected Variants

Opens the Samples with variants pane, which displays a list of all the samples in your 
Geneticist Assistant database that contain the selected variant. You can right-click a 
sample in the list to open a context menu with sample-specific options. See “The 
Samples Pane (Run tab) Context Menu” on page 207.

Edit Variant - Contains all the sub-menu options for editing and deleting a variant.

Add Variant Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in 
the Add Comment field, and then click OK. You can also CTRL-click to select multiple 
variants and add the same comment to all the selected variants in a single step. The 
comment is displayed in the Variant Comment field in the Variants pane on the Search 
Results tab, the Variant Comment field on the Sample Variant Data sub-tab on the 
Sample tab, the Variant Comment field in the Variant pane on the Variant tab, and the 
Variant Comments pane on the Variant tab.

Figure 8-10:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of 
the Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Add Variant 
Interpretation

Applicable when two or more variants with any pathogenicity (Benign, Unknown, or so 
on) are selected. CTRL-click to select multiple variants. Opens the Add Variant 
Interpretation dialog box. You can use the options on this dialog box to define an 
interpretation for a specific selection of variants that are found in the sample. The 
selected variants can be designated as included variants or excluded variants. If any 
other sample includes variants that match the defined variant interpretation, then this 
interpretation is displayed in the Variant Interpretation pane on the Sample data  
sub-tab on the Sample tab. “Variant Interpretations pane” on page 274.

Figure 8-11:  Add Variant Interpretation dialog box

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity Opens the Submit Pathogenicity dialog box. You can update the pathogenicity for the 
selected variant and/or the status of the pathogenicity in this dialog box. You can also 
add a comment about the pathogenicity change and/or pathogenicity status change. By 
default, the pathogenicity is always set to an initial value of Unassigned. You must 
review the information for the variant and then decide what the pathogenicity should be; 
for example, Deleterious. (If you cannot determine the pathogenicity of the variant even 
after reviewing all the relevant information, you can set the status to Unknown.) After 
you set the pathogenicity for a variant, the next time that the variant is detected in 
another sample, this is the pathogenicity that is displayed for the variant. 

Figure 8-12:  Submit Pathogenicity dialog box

Note: You can also double-click in the Pathogenicity column to open the Submit 
Pathogenicity dialog box.You can also CTRL-click to select multiple variants for 
updating the pathogenicities and the pathogenicity statuses at the same time. 

Note: You can also update the Pathogenicity and the Pathogenicity Status for a variant 
on the Variants sub-tab on the Patient tab.

The following information is relevant to updating the pathogenicity and/or pathogenicity 
status for a variant:

• By default, only five statuses—Deleterious, Likely Deleterious, Unknown, Likely 
Benign, and Benign—are available. You have the option of adding custom 
pathogenicities. See “Managing Objects in the Geneticist Assistant” on page 51.

• Optionally, you can add supporting information for this pathogenicity change. See 
“To add supporting information for a variant” on page 303.

• You always have the option of updating just the pathogenicity status for a variant at a 
later date. See “Update Pathogenicity Status” below.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Pathogenicity 
Status

Opens the Update Variant Pathogenicity Status dialog box. You can update the 
pathogenicity status for the variant in this dialog box. You can also add a comment for 
the variant. 

Figure 8-13:  Update Variant Pathogenicity Status dialog box

Note: By default, only two statuses, Pending or Confirmed, are available. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects in the 
Geneticist Assistant” on page 51.

Note: You can also update the Pathogenicity Status for a variant on the Variants sub-
tab on the Patient tab.

Note: You can also double-click in the Pathogenicity Status column for a variant to 
open the Update Variant Pathogenicity Status dialog box. You can also CTRL-
click to select multiple variants for updating the pathogenicity statuses at the 
same time.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Artifact Type Opens the Update Artifact Type dialog box. You can specify the artifact type (for 
example, Sequencing) for the variant in this dialog box. If the appropriate artifact type is 
not available, then an option is provided to create a new type.

Figure 8-14:  Update Variant Artifact Type dialog box

When you specify the artifact type, you can set the artifact type as the following:

• Set globally—Selected by default. Set this artifact type for the variant, regardless of 
the sample in which the variant is detected.

• Set for Sample—Set this artifact type for this variant only for the indicated sample.

You also have the option of adding comments for the variant artifact type.

The following information is relevant to updating the artifact type for a variant:

• You can CTRL-click to select multiple variants for updating the artifact type at the 
same time.

• You can also define artifact types and set the artifact type for a variant on the 
Variants sub-tab on the Patient tab, or on the Variants sub-tab on the Panel Statistics 
tab from the Runs or the Run tab.

• By default, only a single artifact type, None, is available. You have the option of 
adding custom artifact types. See “Managing Objects in the Geneticist Assistant” on 
page 51.

Update Variant Preferred 
Transcript

Opens the Update Preferred Transcript dialog box. You can select a different preferred 
transcript for the variant on the Change Transcript To dropdown list. 

Figure 8-15:  Update Preferred Transcript dialog box

Note: To temporarily change the preferred transcript for a gene or genes, you simply 
select the transcript on the Transcript dropdown list on a tab or sub-tab.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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Update Panel Preferred 
Transcript 

Opens the Update Preferred Gene Transcript dialog box.You can select a different 
preferred transcript for a panel that is used for a gene. 

Figure 8-16:  Update Panel Preferred Transcript

Note: When you select a different transcript here, then the preferred transcript that is 
used for a gene is permanently changed for the panel. You can also permanently 
change the preferred transcript by adding a preferred transcript list for the panel. 
See “To set or delete a preferred transcript list for a panel” on page 106.

Delete Variant Deletes the selected variant from the sample.

External - Contains all the sub-menu options for viewing a variant in a tool that outside Geneticist Assistant.

View in NextGENe Requires you to have your NextGENe installation specified in your Geneticist Assistant 
settings. (See “To configure Geneticist Assistant directories” on page 55.) If selected, 
then Geneticist Assistant browses for the folder where the VCF file for the sample is 
located. If the NextGENe project file is found in the same directory as the VCF file, then 
the NextGENe project is opened in the NextGENe Viewer, with the focus set to the 
position for the selected variant. 

View in IGV Applicable if there is a corresponding BAM file (and not a NextGENe project file) in the 
same folder as the VCF file for the sample. Opens the BAM file in the third-party 
Integrative Genomics Viewer (IGV) with the focus set to the selected variant.

View in Alamut Opens the variant for viewing in Alamut.

Note: To view a variant in Alamut, your Alamut settings must be specified. See “To 
specify Alamut settings” on page 67.

View in UCSC Opens the variant for viewing in the UCSC Genome Browser. 

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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View PubMed Abstract Searches PubMed for the variant and displays the appropriate abstract in the PubMed 
window. 

Figure 8-17:  PubMed window

You can do the following for the abstract:

• In the Link field, enter a different PubMed URL, and then click the Go To icon  to 

navigate to abstract.

• Click Save As to save the abstract as a PDF with a name and in a location of your 
choosing.

• Click Print to print the abstract.

Export - Contains all the sub-menu options for exporting a variant.

Export Selected Variants 
to VCF

Exports the selected variants to a VCF file. CTRL-click to select multiple variants. You 
must specify both the file name and the location in which to save the file.

Export All Variants to 
VCF

Exports all the variants to a VCF file. You must specify both the file name and the 
location in which to save the file.

Reports - Contains all the sub-menu options for generating a report that includes the variant.

Add Selected Variants to 
Action List

Adds the selected variant to an Action List. CTRL-click to select multiple variants. See 
“To add selected panel regions or variants to an Action list” on page 265.

Add Selected Variants to 
Custom Report

Selects all the data that is displayed for the selected variants for inclusion in a custom 
report. CTRL-click to select multiple variants. See Chapter 11, “Geneticist Assistant 
Reports,” on page 313.

Add All Variants to 
Custom Report

Selects all the data that is displayed for all the variants for inclusion in a custom report. 
See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Copy Copies all the information that is displayed for the selected variant to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into 
a third-party application such as Notepad.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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To add selected panel regions or variants to an Action list

 An Action list is a list of items that require some type of follow up. You can create multiple 
action lists relative to the type of follow up that is needed. You can create an Action List for 
panel regions on the Coverage Regions tab or the Coverage Regions sub-tab on the Coverage 
QC tab or for variants on the Variants sub-tab on the Coverage QC tab or the Sample Variant 
Data sub-tab on the Sample tab. For example, if several panel regions failed the coverage 
settings for a run sample, then you can make an Action List that consists of these regions and 
indicate that you want to review the coverage values for these regions.

1. Do one of the following:

• To select a single panel region for the Action list, right-click the appropriate panel 
region on the Coverage Regions tab or the Coverage Regions sub-tab on the 
Coverage QC tab, and on the context menu that opens, click Add Selected Regions 
to Action List.

• To select multiple panel regions, press and hold the CTRL key as you select the 
appropriate panel regions on the Coverage Regions tab or the Coverage Regions 
sub-tab on the Coverage QC tab, and then right-click any selected panel region, and 
on the context menu that opens, click Add Selected Regions to Action List.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a 
configuration from the list of available column configurations. This option is also 
available on the column header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/
hide columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared 
preferences or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the 
display, click Compact as needed.

<Saved Pane 
Configuration Name> - 
Saved by <User Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Variants pane. See “To filter the data that is displayed in 
a tab pane” on page 32.

<Filter Template Name> 
- Saved by <User 
Name>

Opens the saved Filter template for the Variants pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-4: Sample tab, Sample Variant Data sub-tab context menu (Continued)

Option Description
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• To select a single variant for the Action list, right-click on the appropriate variant on 
the Variants sub-tab on the Coverage QC tab or the Sample Variant Data sub-tab on 
the Sample tab, and on the context menu that opens, click Add Selected Variants to 
Action List.

• To select multiple variants, press and hold the CTRL key as you select the 
appropriate variants on the Variants sub-tab on the Coverage QC tab or the Sample 
Variant Data sub-tab on the Sample tab, and then right-click on any selected variant, 
and on the context menu that opens, click Add Selected Variants to Action List.

The Add To Action List dialog box opens. If the Action Type that you want to use is 
already available on the Action type dropdown list, then go to Step 5; otherwise, if this is 
the first time that you are creating an Action List for the pane or the Action Type that you 
want to use is not available on the Action Type dropdown list, then you must add at least 
one type to the list. Go to Step 2.

Figure 8-18:  Add To Action List dialog box

2. Click New Type.

The Add To Action List dialog box is refreshed with an option for adding an action type.

3. In the New Type field, enter an action type (for example, Review Coverage), and then 
click Add.

The action type is added to the Action Type list. The Add to Action List dialog box is 
refreshed to show the full Action Type dropdown list and Comment field.

4. Repeat Step 2 and Step 3 as needed to add more action types.

5. On the Action Type dropdown list, select the appropriate action type.

6. Optionally, in the Comment field, enter a comment that explains/supports your decision 
for adding the selected panel regions or variants to an Action list.

     

If you are creating an Action List for panel regions, then only the action types that 
were created specifically for panel regions are available. Likewise, if are creating 
an Action List for variants, then only the action types that were created 
specifically for variants are available. 
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7. Click OK.

The Add To Action List dialog box closes. The Action List tab for the sample opens. 
Different panes (grouped by Action Type) list any panel regions for the sample that have 
been selected for an Action list and any variants for the sample that have been selected 
for an Action list.

Figure 8-19:  Action List tab

To save an Action List, you can generate a standard Action List Report. If multiple 
panes are included on the Action List tab, then by default, all these panes are 
included in the report. To remove a pane from the report, before generating the 
report, right-click the pane that you want to remove, and then click Remove. See 
“Generating a Standard Report” on page 315.
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Sample Data Sub-Tab
The Sample Data sub-tab contains six panes—Status Changes, Comments, Patient, Related 
Patients, Variant Interpretations, and Reports—that provide different information about the 
selected sample. 

Figure 8-20:  Sample tab, Sample Data sub-tab

A context menu is available for each pane. See:

• “Status Changes pane (Sample tab, Sample Data sub-tab)” below.

• “Comments pane (Sample Data sub-tab on the Sample tab)” on page 270.

• “Patient pane (Sample Data sub-tab for the Sample tab)” on page 271.

• “Related Patients pane (Sample Data sub-tab for the Sample tab)” on page 273.

• “Variant Interpretations pane” on page 274.

• “Reports pane (Sample data sub-tab on the Sample tab)” on page 274.

Status Changes pane (Sample tab, Sample Data sub-tab)
The Status Changes pane lists an entry for each time the status was changed for the sample. 
Each entry details the value for the sample status, the name of the user who changed the 
sample status, the date and time of the status change, and any comments that the user entered 
in support of the change. The pane always contains an entry for the initial submission of the 
sample with the status of the sample set to New. 

Remember, you can change the status for a sample on the Run tab. See “To set the 
sample status” on page 206.
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You can-right click a status change in the pane to open a context menu with the following 
options:

     

Table 8-5: Sample tab, Sample Data sub-tab, Status Changes pane context menu 

Option Description

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Copy Copies all the information that is displayed for the selected sample to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Status Changes pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Status Changes pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.
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Comments pane (Sample Data sub-tab on the Sample tab)
The Comments pane displays all the comments that have been added for the sample in 
reverse chronological order. You can-right click a comment in the pane to open a context 
menu with the following options:

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu 

Option Description

Add Sample 
Comment

Opens the Add Sample Comment dialog box. You add a comment for the sample in the 
Add Comment field.

Figure 8-21:  Add Sample Comment dialog box

Note: If multiple comments have been added for a sample, then these comments are 
displayed in reverse chronological order in the Comments pane on this tab. Only the 
last added comment is displayed in the Comments field in the Samples pane on the 
Samples data sub-tab on the Patient tab and in the Samples pane on the Run tab.

Delete Sample 
Comment

Opens the Add Delete Comment dialog box. Click OK to delete the comment for the 
sample and close the dialog box.

Figure 8-22:  Delete Comment dialog box
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Patient pane (Sample Data sub-tab for the Sample tab)
The Patient pane displays information about the patient who is associated with the sample. If 
a patient is not associated with the sample, then Set Patient is available on the context menu 
for the pane and you can associate one. You can also right-click anywhere on the information 
for the associated patient to open a context menu with the following options:

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Copy Copies all the information that is displayed for the selected sample to your client’s 
clipboard. You can use standard Paste commands to paste this copied information into a 
third-party application such as Notepad.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Comments pane. See “To filter the data that is displayed in a 
tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Comments pane. Limits the display in the pane to 
only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-6: Sample tab, Sample Data sub-tab, Comments pane context menu (Continued)

Option Description

Table 8-7: Sample tab, Sample Data sub-tab, Patient pane context menu

Option Description

Set Patient Opens the Set Patient dialog box in which you can associate a patient with a sample. See 
“To associate a patient with a sample” below.

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Add Patient External 
ID to Custom Report

Selects only the External ID for the patient for inclusion in a custom report. See Chapter 
11, “Geneticist Assistant Reports,” on page 313.
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To associate a patient with a sample

1. If you have not already done so, do one of the following to open the Sample tab for the 
sample:

• Right-click a sample entry on the Run tab, and on the context menu that opens, 
select Sample Details.

• Double-click a sample entry on the Run tab.

2. Open the Sample Data sub-tab.

3. Right-click in the Patient pane, and on the context menu that opens, click Set Patient.

The Set Patient dialog box opens. The dialog box lists all the patients in your Geneticist 
Assistant database.

Figure 8-23:  Set Patient dialog box

4. Select the patient, and then click OK.

The Set Patient dialog box closes. The patient information is displayed in the Patient 
pane.

     

View Details Opens the Variants sub-tab on the Patient tab for the selected patient. See “Patient tab, 
Variants sub-tab” on page 159.

Table 8-7: Sample tab, Sample Data sub-tab, Patient pane context menu

Option Description
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Related Patients pane (Sample Data sub-tab for the Sample tab)
The Related Patients pane displays all the relatives of the patient who is associated with the 
sample. You can right-click anywhere on a related patient record to open a context menu 
with the following options for working with the patient record:

Table 8-8: Sample tab, Sample Data sub-tab, Related Patients pane context menu 

Option Description

Patient Details Opens the Patient tab for the selected related patient. All the options on the Patient tab are 
now available for the related patient. See “Accessing and Reviewing Patient Records” on 
page 128.

Note: You can also double-click a patient entry to open the Patient tab.

Add New 
Relationships

The Add New Patient dialog box opens. By default, the Is Related to Existing Patient 
option is selected and unavailable. Add the needed relationships for the patient. See Step 
3 of “To add new patients one at a time” on page 123.

Remove Selected 
Relationship

Deletes the selected relationship for the patient. To remove multiple relationships,  
CTRL-click as you select the relationships.

Add All To Custom 
Report

Selects all the information that is displayed for the selected patient for inclusion in a 
custom report. See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the patient record. If you are an Administrator user, then you can set or edit the 
permissions for a patient record that any user has added. If you are a standard user, then 
you can set or edit the permissions for only those patient records that you have added to 
the Geneticist Assistant database, or for those patient records that other users have added 
and to which you have been granted Can Read and Can Write permissions. See “To set or 
edit the Read/Write permissions for a patient record (Patient tab)” on page 138.

Change Ownership Opens the Change Patient Ownership dialog box, which displays the name of the current 
owner for the patient, and an option (New Owner) for selecting a new owner for the patient 
from a list of all the currently available and active users for your Geneticist Assistant 
instance. You can change the ownership for any patient if you are an Administrator user, 
the current owner of the patient, or if you have been granted Can Read and Can Write 
permissions for the patient.

Figure 8-24:  Change Patient Ownership dialog box

Copy Copies all the information that is displayed for the selected patient to your client’s 
clipboard. You can then use standard Paste commands to paste this copied information 
into a third-party application such as Notepad.
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Variant Interpretations pane
If multiple variants that are found in the sample match a variant interpretation that has been 
defined in your Geneticist Assistant database, then this variant interpretation is displayed by 
name in the Variant Interpretations pane. Multiple variant interpretations can be applicable 
for a given sample. To refresh the pane with the most recent matching interpretations at any 
time, click Reload. To view the details for all the variants that define a variant interpretation, 
double-click the interpretation to open the Variant Interpretation Data sub-tab. See “Variant 
Interpretation Data Sub-Tab” on page 276.

Reports pane (Sample data sub-tab on the Sample tab)
The Reports pane displays all the reports that were generated for the selected sample and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the Related Patients pane. See “To filter the data that is 
displayed in a tab pane” on page 32.

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the Related Patients pane. Limits the display in the 
pane to only the data (fields) that are defined by the template. See “To filter the data that is 
displayed in a tab pane” on page 32.

Table 8-8: Sample tab, Sample Data sub-tab, Related Patients pane context menu (Continued)

Option Description

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Sample Reports tab that includes these same reports.
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on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 146.

For detailed information about generating and saving both standard and custom 
Sample reports, see Chapter 11, “Geneticist Assistant Reports,” on page 313.
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Variant Interpretation Data Sub-Tab
If multiple variants that are found in the selected sample match a variant interpretation that 
has been defined in your Geneticist Assistant database, then this variant interpretation is 
displayed by name in the Variant Interpretations pane on the Sample Data sub-tab on the 
Sample tab. Multiple variant interpretations can be applicable for a given sample. To view 
the details for all the variants that were used to define the variant interpretation, double-click 
the interpretation to open the Variant Interpretation Data sub-tab. 

Figure 8-25:  Variant Interpretations sub-tab on the Sample tab

The Variant Interpretation Data sub-tab has the exactly the columns as the Sample Variant 
Data sub-tab and an identical context menu, but instead of displaying all the variants in the 
sample, it displays only those variants that define the variant interpretation. (See “Sample 
Variant Data Sub-Tab” on page 246.)
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Case Data Sub-Tab
If the selected sample has been included in any cases, then these cases are displayed on the 
Case Data sub-tab. The information that is displayed on this tab for a case is identical to the 
information that is displayed for the case on the Cases tab. See “The Cases Tab” on page 283.

Figure 8-26:  Sample tab, Case Data sub-tab

You can right-click any case on the Case Data sub-tab to open a context menu with options 
that are identical to many of the options that are available on the context menu for the Cases 
tab. See “Cases tab context menu” on page 283.
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Submission Sub-Tab
If the selected sample was part of a submission to the Geneticist Assistant customer portal, 
then the details of the submission are displayed on the Submission sub-tab. The information 
that is displayed on the Submission sub-tab and the options that are available such as 
Download Packing Slip are identical to the information that is displayed for the submission 
and the options that are available on the Submission tab that is accessed from the 
Submissions tab. 

Figure 8-27:  Submission sub-tab on the Sample tab

For detailed information about the Geneticist Assistant customer portal and the 
Submissions tab, see Chapter 13, “The Geneticist Assistant Customer Portal and 
Submissions,” on page 351.
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Cases Tab

You create a case to group and track related data, for example, family data that consists of 
the affected patient data and both the parents’ data. Many options are available from the 
Cases tab for reviewing your data in Geneticist Assistant.

This chapter covers the following topics:

• “Creating a Case” on page 281.

• “The Cases Tab” on page 283.

• “Overview of the Case Tab” on page 289.
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Creating a Case
You create a case to group and track related data, for example, family data that consists of 
the affected patient data and both the parents’ data. 

To create a case
1. On the Geneticist Assistant main menu, click File > New Case.

The Add New Case dialog box opens. 

Figure 9-1:  Add New Case dialog box

2. Enter the information for the new case.

     

Option Description

Case Name The identifying name for the case. Maximum of 21 characters. Special 
characters and spaces allowed.

Owner The owner for the case. By default, the owner is the user who first 
added the case to the Geneticist Assistant database, but this value can 
be changed. See “Change Ownership” in “Cases tab context menu” on 
page 283.

Workflow For informational purposes only. The workflow that applies for the case. 
See “Creating Workflow Models” on page 71.

Priority For informational purposes only. The priority for the case.

Note: If the appropriate value is not available for the case priority, then 
you can add the value. See “Managing Objects in the Geneticist 
Assistant” on page 51.

Due Date Optional. For informational purposes only. By default, the date is set to 
the current day’s date, but you can edit this value. To edit the date, 
select any part of the date that is to be changed, and then use the Up/
Down arrows on your keyboard to change the date accordingly. Also by 
default, the Due Date is not selected. To include a due date for a case, 
select Due date. To clear the display of the due date for a case, clear 
Due date.
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3. Click OK.

The Add New Case dialog box closes. You can now view the case on the Cases tab. See 
“The Cases Tab” on page 283.
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The Cases Tab
The Case tab has a single pane, the Cases pane, that displays the following:

• If you are an Administrator user, then the Cases tab displays all the cases that have been 
added to the Geneticist Assistant database by all users. 

• If you are a standard user, then the Cases tab displays all the cases that you have added to 
your Geneticist Assistant database as well as all the cases that have been added by other 
users and for which you have been made the owner.

To open the Cases tab, on the Geneticist Assistant main menu, click Tabs > Cases.

Figure 9-2:  Cases tab

You can right-click any case on the Cases tab to open a context menu with many options for 
working with the selected case. See “Cases tab context menu” below. You can also  
double-click any case to open the corresponding Case tab which has two sub-tabs: the Case 
Summary sub-tab and the Workflow sub-tab. See “Case Summary sub-tab” on page 289 and 
“Workflow sub-tab” on page 290.

Cases tab context menu
You can right-click any case on the Cases tab to open a context menu with the following 
options: 

If you add a new case, and you do not see immediately displayed on the Cases tab, 
click Refresh.

Table 9-1: Cases tab, Cases pane context menu 

Option Description

Case Detail Opens the Case tab for the selected case. The Case tab has a Case Summary sub-tab 
and Workflow sub-tab. See “Case Summary sub-tab” on page 289 and “Workflow sub-tab” 
on page 290.
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Add All to Custom 
Report

Selects all the data that is displayed for the case for inclusion in a custom report. See 
Chapter 11, “Geneticist Assistant Reports,” on page 313.

Add Comment Opens the Add Case Comment dialog box. You add a comment for the selected case in 
the Add Comment field. The comment is displayed in the Comment field on the Cases tab.

Figure 9-3:  Add Case Comment dialog box

Note: If multiple comments have been added for a case, then only the last added 
comment is displayed in the Comment field on the Cases tab. All the comments that 
have been added for a case, including the last added, are displayed in reverse 
chronological order in the Comments pane on the Case Summary sub-tab on the 
Case tab.

Change Ownership Opens the Change Case Ownership dialog box, which displays the name of the current 
owner for the case, and an option (New Owner) for selecting a new owner for the case 
from a list of all the currently available and active users for your Geneticist Assistant 
instance. You can change the ownership for any case if you are an Administrator user, the 
current owner of the case, or if you have been granted Can Read and Can Write 
permissions for the case.

Figure 9-4:  Change Case Ownership dialog box

Table 9-1: Cases tab, Cases pane context menu (Continued)

Option Description
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View Workflows Opens the Workflow Viewer dialog box, which displays the model of the workflow that 
applies for the case.

Figure 9-5:  Workflow Viewer dialog box

Note: To change the workflow, you must edit the case on the Cases tab. See “Cases tab 
context menu” on page 283.

Edit Case Opens the Add New Case dialog box, which displays all the current information for the 
case. You can edit the following information for the selected case:

• Owner: If you are an Administrator user, then you can assign a new owner to any case 
in the Geneticist Assistant database. If you are a standard user, then you can assign a 
new owner to a case only if you are the owner of the case.

Note: You can also change the owner for a case using the “Change Ownership” option 
that is also available on the Cases tab context menu. See “Cases tab context menu” 
on page 283.

• Workflow: You can select a different workflow. If the correct workflow model is not 
available, you can add it. See “Creating Workflow Models” on page 71.

• Priority: If the appropriate value is not available for the case priority, then you can add 
the value. See “Managing Objects in the Geneticist Assistant” on page 51.

• Due Date: For informational purposes only. Initially, the selection/deselection and date 
are based on the current setting for the case. To edit the date, select any part of the 
date that is to be changed, and then use the Up/Down arrows on your keyboard to 
change the date accordingly. Also by default, the Due Date is not displayed on the 
Cases tab. To display the due date for a case on the Cases tab, select Due date. To 
clear the display of the due date for a case, clear Due date.

Table 9-1: Cases tab, Cases pane context menu (Continued)

Option Description
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Manage Samples Opens the Manage Samples dialog box so that you can add samples to or remove 
samples from the selected case. The Samples To Add (left) pane displays all the samples 
that are saved in your Geneticist Assistant database. You can select a single sample at a 
time, or CTRL-click to select multiple samples, and then click Add to add all the samples to 
the case. You can also select a single sample, or CTRL-click to select multiple samples, in 
the Samples Added (right) pane, and then click Remove to remove the samples from the 
case.

Figure 9-6:  Manage Samples dialog box

User Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for the case. If you are an Administrator user, then you can set or edit the 
permissions for a case that any user has added. If you are a standard user, then you can 
set or edit the permissions for only those cases that you have added to the Geneticist 
Assistant database, or for those cases that other users have added and to which you have 
been granted Can Read and Can Write permissions. See “To set or edit the Read/Write 
permissions for a case and its samples” on page 287.

Copy Copies all the information that is displayed for the selected case to your client’s clipboard. 
You can then use standard Paste commands to paste this copied information into a  
third-party application such as Notepad.

Select Columns Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Table 9-1: Cases tab, Cases pane context menu (Continued)

Option Description
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To set or edit the Read/Write permissions for a case and its 
samples

1. If you have not done so already, open the Cases tab.

2. Right-click the appropriate case, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the name of all the users 
and/or groups and their assigned permissions for the case. 

Figure 9-7:  Permissions dialog box (Cases tab)

3. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 4.

4. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect. If the same Can Read and/or Can Write permission settings are to apply 
to the case samples, then select Apply permission settings to Samples; otherwise, 
leave this option cleared.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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5. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Can 
Read permission is already assigned for the selected user or group. If just this permission 
is selected, then the user or group can simply view the case. They cannot edit it.

6. Optionally, do one or both of the following as needed:

• If the user or group must be able to edit the case as well, then select the Can Write 
permission.

• If the same Can Read and/or Can Write permission settings are to apply to the case 
samples, then select Apply permission settings to Samples; otherwise, leave this 
option cleared

7. Click OK.

A Permission Updated message opens. 

8. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the patient record.
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Overview of the Case Tab
The Case tab displays information for a case that was selected from the Cases tab. To open 
the Case tab, do one of the following:

• Right-click a case on the Cases tab, and on the context menu that opens, select Case 
Details.

• Double-click a case on the Cases tab.

The Case tab has two sub-tabs. See:

• Case Summary sub-tab. See “Case Summary sub-tab” below.

• Workflow sub-tab. See “Workflow sub-tab” on page 290.

Case Summary sub-tab
The Case Summary sub-tab is the sub-tab that opens after you open the Case tab. 

Figure 9-8:  Case tab, Case Summary sub-tab

The following information is displayed for the case at the top of the Case Summary sub-tab: 
Workflow, Owner, Due Date, Creator, Priority, Add Date, and the last added comment for the 
case. The sub-tab also has two panes: the Samples pane and the Comments pane. The 
Samples pane shows all the samples that have been added to the case. The options on the 
context menu for the Samples pane are identical to many of the options that are on the 
context menu for the Samples pane on the Run tab with the following exception: the Delete 
Sample from Case option. (See “The Samples Pane (Run tab) Context Menu” on page 207.) 
The Comments pane shows all the comments that have been added for the case in reverse 
chronological order.
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Workflow sub-tab
The Workflow sub-tab on the Case tab displays the workflow model that is associated with 
the case. (A workflow is the progression of steps that comprise an NGS-based analysis in 
your lab.)

Figure 9-9:  Case tab, Workflow sub-tab
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Many options are available from the Variant tab for reviewing your data in Geneticist 
Assistant.

This chapter covers the following topics:

• “Overview of the Variant Tab” on page 293.

• “Working with Reference Information Panes on the Variant Tab” on page 303.
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Overview of the Variant Tab
The Variant tab displays detailed information for a selected variant. To open the Variant tab, 
do one of the following:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on the 
context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

Figure 10-1:  Variant tab

By default, the Variant tab displays 16 panes when it first opens. The panes are of two types: 
variant information panes, which display user-specified information for a variant such as its 
pathogenicity, any comments, its artifact type, and so on, and reference information panes, 
which display information about the variant that has been culled from a specific reference 
database such as the dbSNP database. Every pane has a context menu associated with it. 
Some of the menu commands that are available are common to all the pane context menus, 
and some are pane-specific. See:

• “Variant information panes” on page 294.

• “Reference information panes” on page 301.

If any of the reference information panes are not displayed, contact SoftGenetics 
to download the latest reference files.
Geneticist Assistant User’s Manual 293



Chapter 10
Geneticist Assistant Data Review - Variant Tab
Variant information panes
Variant information panes display user-specified information for a variant such as its 
pathogenicity, any comments, its artifact type, and so on. By default, the following eight 
variant information panes are displayed on the Variant tab when it first opens:

• “Variant pane” on page 295.

• “Supporting Information pane” on page 297.

• “Variant Comments pane” on page 298.

• “Pathogenicity Changes pane” on page 299.

• “Artifact Changes pane” on page 299.

• “Variant Changes pane” on page 299.

• “Associated Samples pane” on page 299.

• “Variant’s Reports pane” on page 301.

The following commands are displayed on the context menu for every variant information 
pane:

Option Description

Add All To Custom 
Report

Selects all the information that is displayed in the pane for inclusion in a custom report. 
See Chapter 11, “Geneticist Assistant Reports,” on page 313.

Load Columns

Manually Opens the Select Columns dialog box in which you can select columns that are to be 
shown and clear the columns that are to be hidden dynamically, or select a configuration 
from the list of available column configurations. This option is also available on the column 
header context menu for the sub-tab.

Note: For information about showing and hiding columns dynamically, see “To show/hide 
columns in a tab pane” on page 37.

Note: If you set column display preferences here, then you can display preferences for 
variants in all the variant sub-tabs and panes (with the exception of the Sample 
Group columns on the Sample Variant Data sub-tab on the Sample tab and the 
Variant pane on the Variant tab) in a single step. See “To apply shared preferences 
or to clear all tab preferences” on page 63.

Compact Displays the data columns on the sub-tab in a more condensed view. To toggle the display, 
click Compact as needed.

<Saved Pane 
Configuration Name> 
- Saved by <User 
Name>

Publicly available pane configurations. The name of the user who created a pane 
configuration is displayed next to the configuration name.

Load Filters

Manually Opens the Filters table for the pane. See “To filter the data that is displayed in a tab pane” 
on page 32.
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Variant pane

The Variant pane is a read-only pane that lists all the same information that is displayed by 
default for the variant on the Sample Variant Data sub-tab. (See “Sample Variant Data Sub-
Tab” on page 246.) You can right-click in the pane to open a context menu that, in addition to 
the command pane commands, has the following pane-specific commands: 

<Filter Template 
Name> - Saved by 
<User Name>

Opens the saved Filter template for the pane. Limits the display in the pane to only the 
data (fields) that are defined by the template. See “To filter the data that is displayed in a 
tab pane” on page 32.

Option Description

Option Description

Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 10-2:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 303.
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Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 
Add Comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 10-3:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Option Description
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Supporting Information pane

The Supporting Information pane displays all the reference information and/or links that you 
have submitted as supporting information for a variant. (See “To add supporting information 
for a variant” on page 303.) You can right-click in the pane to open a context menu that, in 
addition to the command pane commands, has the following pane-specific commands: 

     

Option Description

Submit Supporting 
Hyperlink

Opens the Add Supporting Info dialog box, which, by default, displays the dbSNP web 
page for the variant. You can use the browser in this dialog box to select this web page as 
supporting information for the variant, or navigate to a different page. 

Figure 10-4:  Add Supporting Info dialog box

Note: See Step 9 of “To add supporting information for a variant” on page 303.

Delete Deletes the supporting information. The deleted information is stored in the Geneticist 
Assistant database log. See “Reviewing the Database Log” on page 48.
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Variant Comments pane

The Variant Comments pane displays all the comments that have been added for the variant 
in reverse chronological order. You can right-click in the pane to open a context menu that, in 
addition to the command pane commands, has the following pane-specific commands: 

Option Description

Add Comment Opens the Add Variant Comment dialog box. You can add a comment for the variant in the 
Add comment field, and then click OK. The comment is displayed in the Variant Comment 
field in the Variant pane on the Variant tab, the Variant Comments pane on the Variant tab, 
the Variant Comment field in the Variants pane on the Search Results tab, the Variant 
Comment field on the Variants sub-tab on the Patient tab, and the Variant Comment field 
on the Sample Variant Data sub-tab on the Sample tab.

Figure 10-5:  Add Variant Comment dialog box

Note: If multiple comments have been added for a variant, then with the exception of the 
Variant Comments pane on the Variant tab, only the last added comment is 
displayed in all the locations that are detailed above. All the comments that have 
been added for a variant, including the last added, are displayed in reverse 
chronological order in the Variant Comments pane on the Variant tab.

Delete Comment Opens the Delete Comment dialog box. Click OK to delete the comment for the variant 
and close the dialog box.

Figure 10-6:  Delete Comment dialog box
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Pathogenicity Changes pane

The Pathogenicity Changes pane displays the history of the changes that have been made to 
the pathogenicity for the variant in reverse chronological order. When a variant is first added 
to the Geneticist Assistant database, the Pathogenicity is set to Unassigned and the 
Pathogenicity Status does not have a value. If the Pathogenicity is changed to Deleterious, 
and the Status is set to Confirmed, for example, then this change and the name of the user 
who made the change, and the date and the time of the change are recorded and displayed in 
this pane. For a description of the context menu options for the pane, see “Variant 
information panes” on page 294.

Artifact Changes pane

The Artifact Changes pane displays the history of the changes that have been made to the 
artifact type for the variant in reverse chronological order. When a variant is first added to 
the Geneticist Assistant database, the Artifact Type is set to None. If the Artifact Type is set 
to Sequencing, for example, then this change and the name of the user who made the change, 
and the date and the time of the change are recorded and displayed in this pane. For a 
description of the context menu options for the pane, see “Variant information panes” on 
page 294.

Variant Changes pane

The Variant Changes pane displays the history of the changes that have been made to the 
variant in reverse chronological order, for example, a change in the zygosity of the variant 
from heterozygous to homozygous. The value that was changed for the variant, the name of 
the user who made the change, and the date and the time of the change are recorded and 
displayed in this pane. For a description of the context menu options for the pane, see 
“Variant information panes” on page 294.

Associated Samples pane

The Associated Samples pane lists all the samples in which the variant has been identified. 
You can right-click in the pane to open a context menu that, in addition to the command pane 
commands, has the following pane-specific commands: 

Option Description

Sample Detail Opens the Sample tab for the sample. See Chapter 8, “Geneticist Assistant Data Review - 
Sample Tab,” on page 243.

Permissions Opens the Permissions dialog box.You use the options on this dialog box to set or edit the 
permissions (Can Read or Can Read and Can Write) that the specified users or groups are 
to have for selected samples. If you are an Administrator user, then you can set or edit the 
permissions for a sample that any user has submitted. If you are a standard user, then you 
can set or edit the permissions for only those samples that you have submitted to the 
Geneticist Assistant database, or for those samples that other users have submitted and to 
which you have been granted Can Read and Can Write permissions. See “To set or edit 
the Read/Write permissions for the samples in which a selected variant was found” on 
page 300.
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To set or edit the Read/Write permissions for the samples in which a selected 
variant was found

1. If you have not already done so, open the Variant tab for the appropriate variant.

2. In the Associated Samples pane, select the sample, or CTRL-click to select multiple for 
which the permissions are being set.

3. Right-click any selected sample, and on the context menu that opens, click Permissions.

The Permissions dialog box opens. The dialog box displays the names of all the users 
and/or groups and their assigned permissions for the samples

Figure 10-7:  Permissions dialog box (Variant tab, Associated Samples pane)

4. Edit the permissions for any user or group as needed and then click OK; otherwise, to 
add permissions for a new user or group, go to Step 5.

5. Enter a user name (the login name for the user), or to assign the same permissions to 
multiple users in a single step, enter a group name.

As you enter a user name or a group name, a dropdown list opens. The list is 
dynamically updated with user names or group names that are in your Geneticist 
Assistant database and that match the search string that you are entering.

     

You can add or remove the Can Write permission for a user or group, or you can 
remove both the Can Read and Can Write permissions. Removing the Can Read 
permission but leaving the Can Write permission selected for a user or group has 
no effect.

The search string is not case-sensitive, but the string must begin with the user or 
group name. For example, a search string of “Ja” or “ja” returns a user with the 
name of Jane Doe, but a search string of “Doe” does not.
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6. Select the appropriate user name or group name from the list, and then click Add.

The user name or group name is displayed in the lower pane of the dialog box. The Read 
permission is already assigned for the selected user or group. If just this permission is 
selected, then the user or group can simply view the sample records. They cannot edit 
them.

7. Optionally, if the user or group must be able to edit the sample records as well, then 
select the Can Write permission.

8. Click OK.

A Permission Updated message opens. 

9. Click OK. 

Both the message and the Permissions dialog box close. The specified permissions are 
set for the sample records.

Variant’s Reports pane

The Reports pane displays all the reports that were generated for the selected variant and 
saved to the Geneticist Assistant database.

You can right-click anywhere on this sub-tab to open a context menu with options that are 
identical to the options that are on context menu for the Reports pane on the Patient sub-tab 
on the Patient tab. See “Patient tab, Patient sub-tab, Reports pane” on page 146.

Reference information panes
By default, the following eight reference information panes are always displayed when the 
Variant tab first opens:

You can also select Reports > Saved Reports on the Geneticist Assistant main 
menu to open a Reports tab that includes these same reports.

For detailed information about generating and saving both standard and custom 
Run reports, see Chapter 11, “Geneticist Assistant Reports,” on page 313.

Database Description

OMIM Data pane Displays the information for the variant from the OMIM (Online Mendelian Inheritance in 
Man) database. 

Note: To view OMIM data, OMIM settings must be configured for your Geneticist Assistant 
installation. See “Backing up the Geneticist Assistant Database” on page 79.) 

LOVD Data pane Displays the information for the variant from the LOVD (Leiden Open Variation Database) 
database. 

World-Wide LOVD 
Data pane

Displays information for the variant from the LOVD (Leiden Open Variation Database) 
world-wide database. 
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You can right-click any information in any of these reference information panes to open a 
context menu with the following options:

dbSNP (*/00-All.vcf) 
pane

Displays the information for the variant from the dbSNP database.

Exome Variant 
Server (*/ESP*.vcf) 
pane

Displays the information for the variant from the Exome Variant Server database for the 
NHLBI GO Exome Sequencing Project (ESP).

Exome Aggregation 
Consortium 
(ExAC.r*.*.sites.vep.
vcf) pane

Displays the information for the variant from the Exome Aggregation Consortium database 
for selected global sequencing projects.

ClinVar (*/clinvar_00-
latest.vcf) pane

Displays the information for the variant from the ClinVar database.

dbNSFP pane Displays the information for the variant from the dbNSFP database.

Database Description

Option Description

Submit as 
Supporting Info

Submits the information in the field as supporting information for a variant. See “To add 
supporting information for a variant” on page 303.

Add Values to Variant 
Table

Adds values from a selected field in the Reference database to the Variant pane and the 
Variants pane on the Sample Variant Data sub-tab on the Sample tab. You can also create 
a custom formula based on multiple fields and add the resulting value to the these same 
variant panes and tables. See “To add fields from a reference database to variant tables 
and panes” on page 306 or “To add a custom field to variant tables and panes” on page 
308.
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Working with Reference Information Panes on 
the Variant Tab

A variety of options are available for working with the information that is displayed in the 
various reference information panes on the Variant tab. You can do the following:

• Add supporting information for a variant. See “To add supporting information for a 
variant” below.

• Add fields from a reference database to variant tables and panes. See “To add fields from 
a reference database to variant tables and panes” on page 306.

• Add a custom field to variant tables and panes. See “To add a custom field to variant 
tables and panes” on page 308.

To add supporting information for a variant
You can add supporting information for a variant. Typically, this is information that you used 
to determine the appropriate pathogenicity for the variant. You can reference information 
from an external database or from a web page as supporting information. The supporting 
information is displayed in the Supporting Information pane on the Variant tab. (See 
“Supporting Information pane” on page 297.) 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Do one of the following:

• To reference information from any reference track, go to Step 3. 

• To reference a specific web page, go to Step 8.

3. In the appropriate reference information pane, review the information that is to be used 
for supporting information. See “Reference information panes” on page 301.

 

     

This information is included in the References folder. Use the scroll bar at the 
bottom of the pane to view the available reference information for the variant. 
Note that all reference information is not available for all variants. 
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4. Right-click any information in a pane, and on the context menu that opens, click Submit 
As Supporting Info.

The Supporting Info Submit dialog box opens. The dialog box lists all the reference 
information and the corresponding values that can be selected from the pane as 
supporting information. 

Figure 10-8:  Supporting Info Submit dialog box

5. Select the information that is to be used as supporting information, and then click OK.

The Add Supporting Info dialog box closes. The information is displayed in the 
Supporting Information pane. See “Supporting Information pane” on page 297.

6. Repeat Step 3 through Step 5 for each piece of reference information that is to be added 
as supporting information.

7. Optionally, continue to Step 8 to also add supporting information for the variant from a 
web page.
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8. Right-click anywhere on the Variant pane or the Supporting Information pane, and on 
the context menu that opens, click Submit Supporting Hyperlink.

The Add Supporting Info (for a web page) dialog box opens. By default, the dialog box 
displays the dbSNP page for the variant. 

Figure 10-9:  Add Supporting Info dialog box

9. Do one of the following:

• Click the Use This Link icon  to accept the NCBI dbSNP page. The URL is 

added under Supporting Info on the dialog box.

• Enter a new URL, click the Go To icon  to navigate to the web page, and then 

click the Use This Link icon  to accept the web page. The URL is added under 

Supporting Info on the dialog box.

10. Click OK.

The Add Supporting Info dialog box closes. The URL is displayed in the Supporting 
Information pane on the Variant tab. See “Supporting Information pane” on page 297.

     

You can also use the Add Supporting Info dialog box like a standard web browser 
and search for the necessary URL.
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To add fields from a reference database to variant tables and 
panes

You can add fields from a reference database to the Variant pane and the Variants pane on the 
Sample Variant Data sub-tab on the Sample tab. Fields in the reference database can contain 
single values, or they can contain multiple values. For example, the Allele Frequency (AF) 
field in the ExAC Reference database contains a frequency value for the variant nucleotide 
and a frequency value for the reference nucleotide. Depending on the options that you 
specify, the field can be added with a just a single value (for example, the value for just the 
variant nucleotide), or the field can be added with multiple values (the values for both the 
variant nucleotide and the reference nucleotide). 

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in the appropriate reference information pane, for example, the ExAC Data 
pane, and on the context menu that opens, click Add Values to Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field.

Figure 10-10:  Add Values to Variant Table dialog box
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3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify which values in the selected field are to be added to the various variant panes and 
tables. 

Figure 10-11:  Field Configuration dialog box

4. Select the values in the field that are to be added to the various panes and tables.

     

Value Description and Options

R (one value for each possible 
allele including the reference)

The field contains multiple values, with one value for each 
possible allele, including the reference allele.

• All alleles - Add all values for all possible alleles (multiple 
values)

• Matching Alt allele - Add the value only for the matching 
alternate allele (single value)

• Ref allele - Add the value only for the reference allele (single 
value)

A (one value per alternate allele The field can contain multiple values, with one value for each 
alternate allele.

• All alt alleles - Add all values for all alternate alleles (multiple 
values possible if more than one alternate allele exists)

• Match Alt allele - Add the value only for the matching 
alternate allele (single value)

Fixed Value • All - Add all values (multiple values)

• Fixed - Add only the specified number of fixed values. If 1 is 
specified, then this is a single value; otherwise, 2 or greater 
adds multiple values.

. (number of possible values 
varies, is unknown, or is 
unfounded)

Based on different variants, the number of values in the field can 
vary. 
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5. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open.

6. Optionally, to change the name of a Field tab, select the tab to make it the active tab, and 
then in the Column Name field, enter a new name.

7. Optionally, to add another field, click the (+) tab to open a new blank Field tab, and then 
repeat Step 3 through Step 6 to add the field to the various panes and tables for the 
selected variant. Repeat these steps as many times as needed to add all the necessary 
fields.

8. Click OK on the Add Values to Variant Table dialog box.

The selected field is added to the various variant tables and panes. The dialog box closes. 
The Variant tab remains open.

To add a custom field to variant tables and panes
You can combine multiple fields in a reference database to create a custom field, and then 
add the custom field and its value to the Variant pane and the Variants pane on the Sample 
Variant Data sub-tab on the Sample tab. When you select a reference database field to use for 
creating a custom field, if the field contains multiple values, then you can select only a single 
value from the field. For example, the Allele Frequency (AF) field in the ExAC Reference 
database contains a frequency value for the variant nucleotide and a frequency value for the 
reference nucleotide. If you select the AF field, then you must select either the frequency 
value for the variant nucleotide or the frequency value for the reference nucleotide. You 
cannot select both values.

1. If you have not done so already, do one of the following to open the Variant tab:

• Double-click a variant on the Variants sub-tab on the Patient tab.

• Double-click a variant on the Variant sub-tab on the Panel Statistics tab.

• Right-click a variant on the Sample Variant Data sub-tab on the Sample tab, and on 
the context menu that opens, select Variant Details.

After you select the values that are to be added, the following happens:

• A tab that is named the same as the selected field, a Field tab, opens below the 
list of available fields.

• A preview of the selected field and its values is displayed in the Work Area of the 
dialog box (the blank area below the Field tab).

• A preview of the selected field and its values is also displayed in the Preview 
pane (the bottom pane of the dialog box).

If you add a field in error, then right-click it in the Work Area, and on the context 
menu that opens, click Remove. 
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• Double-click a variant on the Sample Variant Data sub-tab on the Sample tab.

2. Right-click in a Reference pane, and on the context menu that opens, click Add Values to 
Variant Table.

The Add Values to Variant Table dialog box opens. The dialog box lists all the fields in 
the selected Reference database. It also provides a description of the value that is 
contained in each field. 

Figure 10-12:  Add Values to Variant Table dialog box

3. Do one of the following to select a field:

• Double-click the field.

• Right-click the field, and on the context menu that opens, click Add Value(s).

The Field Configuration dialog box opens. You use the options on the dialog box to 
specify the field value that is to be used for the custom formula.

Figure 10-13:  Field Configuration dialog box

4. Select the value in the field that is to be used in the formula for the custom field.
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5. Click OK.

6. Do one of the following:

• Click in the Add Text field, enter the needed text (for example, if you are creating a 
field to show a ratio, you might select a forward slash), and then click Add Text.

The text is displayed on the Field tab and in the Work Area and the Preview pane.

• To create a formula, select Formula, and then select the operator for the formula. 
Parentheses are also available for setting the order of operations in the formula.

As you create the formula, the following happens:

• A preview of the formula, including the selected fields, their values, and the 
operators, is displayed on the Field tab and in the Work area of the dialog box 
(the blank area below the tabs).

• The Preview pane displays the current value for the formula. 

Value Description and Options

R (one value for each 
possible allele 
including the 
reference)

The field contains multiple values, with one value for each possible allele, 
including the reference allele. Therefore, the values that you can select 
are the following:

• Matching Alt allele - Add the value only for the matching alternate allele 
(single value)

• Ref allele - Add the value only for the reference allele (single value)

A (one value per 
alternate allele

The field can contain multiple values, with one value for each alternate 
allele. Therefore, the values that you can select are the following:

• All alt alleles - Add all values for all alternate alleles (A single value if 
only one alternate allele exists; however, multiple values possible if 
more than one alternate allele exists)

• Match Alt allele - Add the value only for the matching alternate allele 
(single value)

Fixed Value • Fixed - Add only the specified number of fixed values. If 1 is specified, 
then this is a single value

After you select the value that is to be added, the following happens:

• A tab that is named the same as the selected field, a Field tab, opens below the 
list of available fields.

• A preview of the selected field and its value is displayed in the Work area of the 
dialog box (the blank area below the Field tab).

• A preview of the selected field and its value is also displayed in the Preview 
pane (the bottom pane of the dialog box).

If you add a field, a text separator, or an operator in error, then right-click it in the 
Work Area, and on the context menu that opens, click Remove. 
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7. Repeat Step 3 through Step 6 as needed to produce the final custom field.

As you select multiple fields for the custom field, the display on the Field tab and in the 
Work Area and the Preview pane are dynamically updated.

8. Optionally, to add another custom field, click the (+) tab to open a new blank tab, and 
then repeat Step 3 through Step 7. Repeat these steps as many times as needed to add all 
the necessary custom fields.

9. Optionally, to change the name of the Field tab, select the tab to make it the active tab, 
and then in the Column Name field, enter a new name for the tab.

10. Click OK.

The Field Configuration dialog box closes. The Add Values to Variant Table dialog box 
remains open. 

11. Click OK on the Add Values to Variant Table dialog box.

The custom fields are added to the various variant tables and panes. The dialog box 
closes. The Variant tab remains open.
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As discussed in the various data review chapters in this manual, after a run is successfully 
completed, many options are available for reviewing the data on the various tabs and panes 
on the Geneticist Assistant main window. Two options are available for generating an output 
file of the data: you can generate a standard report, or you can select some or all of the data 
for inclusion in a custom report. You can also use the Report Designer to create a custom 
report template. A custom report template not only specifies the data that Batch PDF or PDF 
reports are to contain, but also the layout of the reports.

This chapter covers the following topics:

• “Generating a Standard Report” on page 315.

• “Generating a Custom Report” on page 319.

• “Designing a Custom Report Template” on page 322.
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Generating a Standard Report
To generate an output file of the data after a run is successfully completed, you generate a 
standard report. A standard report includes all the data that is displayed in a selected pane or 
panes on a data tab, for example, the Samples pane on the Run tab. Six different standard 
reports are available in Geneticist Assistant:

• Run report—You generate the standard Run report from the Run tab. The report includes 
all the information that is displayed in the Samples pane and/or the Run's Status Changes 
pane on the tab.

• Coverage Regions report—You generate the Coverage Regions report from the Coverage 
Regions tab. The report includes all the information that is displayed on the tab.

• Panel Statistics reports—You generate a standard Panel Statistics report from the Panel 
Statistics tab. The report includes all the information that is displayed in any of the 
following four sub-tabs that you specify—Coverage Regions, Samples, Variants, and/or 
Patients.

• Sample report—You generate a standard Sample report from the Sample tab. The report 
includes all the information that is displayed in the panes that you specify— the Variants 
pane on the Sample Variant Data sub-tab and/or any of the four panes (Status Changes, 
Patient, Related Patients, or Comments) on the Sample Data sub-tab.

• Variant report—You generate a standard Variant report from the Variant tab. The report 
includes all the information that is displayed in any of the following five panes that you 
specify—Variant, Pathogenicity Changes, Artifact Changes, Variant Changes, Variant 
Comments, Supporting Information, and/or Associated Samples.

• Action List report—You generate the Action List report from the Action List tab. The 
report includes all the information that is displayed in the panes that you specify—the 
Variants pane and/or the Coverage Regions pane.

To generate a standard report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 203.

• “Coverage Regions tab” on page 217.

• The Panel Statistics tab: See “Reviewing Panel Statistics” on page 114, “To calculate 
panel statistics (Runs tab)” on page 186 or “To calculate panel statistics (Run tab)” 
on page 222. 

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 243.

• Chapter 10, “Geneticist Assistant Data Review - Variant Tab,” on page 291.
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2. Do one of the following:

The appropriate report dialog box, for example, the Run Report or Sample dialog box, 
opens. All the data that can be selected for inclusion in the report is displayed in the 
Sections and Tables pane of the dialog box. 

Figure 11-1:  Run Report dialog box

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “To add selected panel regions or variants to an Action List” 
on page 220 or “To add selected panel regions or variants to an Action list” on 
page 265.

Table 11-1: Available standard reports

Report to be Generated Action

Run On the Geneticist Assistant main menu, click Reports > Run 
Report.

Coverage Regions On the Geneticist Assistant main menu, click Reports > 
Coverage Regions Report.

Panel Statistics On the Geneticist Assistant main menu, click Reports > Panel 
Statistics Report.

Sample On the Geneticist Assistant main menu, click Reports > Sample 
Report.

Variant On the Geneticist Assistant main menu, click Reports > Variant 
Report.

Action List On the Geneticist Assistant main menu, click Reports > Action 
List report.
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3. Optionally, to remove a sub-tab or pane from the report, right-click the row for the  
sub-tab or pane, and then click “Remove Selected Row” to remove the data from the 
indicated pane or sub-tab from inclusion in the report.

4. Select the report type.

5. Optionally, for reports that contain variants, such as the Sample report, the Variant 
report, or the Action List report, select one or both of the following:

• HGVS Coding/Translation: separate row, separate columns: If multiple transcripts 
are shown for the HGVS Coding or HGVS Protein for a variant, then select this 
option to create a separate row for each transcript and two separate columns—one 
for the transcript ID and one for the actual call—within each row.

• Report Supporting Info For Variants: If supporting information has been added for 
any of the variants for which you are generating the report, then select this option to 
include this supporting information in a separate Supporting Information section in 
the report.

6. Do any or all of the following as needed:

Only the data columns that are shown in the selected sub-tabs or panes at the time 
that the report is generated are included in the report. Hidden data columns are 
not included. See “To show/hide columns in a tab pane” on page 37.

Four formats are available—PDF (the default value), HTML, XML, or CSV, which 
is a comma-separated values file.

Table 11-2: Standard report options 

Option Description

Click Preview To preview the report in the Preview pane on the Report dialog box before you 
print it and/or save it. After you click Preview, two new options become available:

• Close Preview—Close the Preview and leave a blank Report dialog box 
open.

• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.
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7. Click Close to close the Report dialog box.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected for the report, the same default name is displayed for the report. For 
example, if you generate a standard Sample report, then the default report name 
is always the sample name.

Figure 11-2:  Report Name dialog box

Note: If you have previously saved a report with the default name, then you can 
enter a new name to distinguish the new report from the previously saved 
report.

Note: If filters were applied to the data for which you are generating the report, then these filters 
are explicitly displayed in a separate Filters Applied section in the report. 

Table 11-2: Standard report options (Continued)

Option Description
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Generating a Custom Report
If you want to generate a custom output file of the data after a run is successfully completed, 
you can generate a custom report. A custom report contains only selected data that you 
specify from a data tab or tabs. 

To generate a custom report
1. Open the appropriate tab. See:

• Chapter 7, “Geneticist Assistant Data Review - Run Tab,” on page 203.

• “Coverage Regions tab” on page 217.

• The Panel Statistics tab: See “Reviewing Panel Statistics” on page 114, “To calculate 
panel statistics (Runs tab)” on page 186 or “To calculate panel statistics (Run tab)” 
on page 222. 

• Chapter 8, “Geneticist Assistant Data Review - Sample Tab,” on page 243.

• Chapter 10, “Geneticist Assistant Data Review - Variant Tab,” on page 291.

2. Right-click the data that are you including in a custom report, and then select an 
appropriate option: 

• Add Selected < > to Custom Report—Adds only the data that you select to the 
custom report. You must CTRL-click to select multiple items for inclusion in the 
report.

• Add All to Custom Report—Adds all the data that is currently displayed in the pane 
to the custom report.

     

When you generate custom report, you specify the data that is to be included in the 
report, but the report is generated according to a standard layout and format. You 
also have the option of using the Report Designer to generate a custom PDF 
report for which you not only select the data, but also specify the layout and 
format. See “Designing a Custom Report Template” on page 322.

To generate an Action List report, you must first create the Action List to open the 
Action List tab. See “To add selected panel regions or variants to an Action List” 
on page 220 or “To add selected panel regions or variants to an Action list” on 
page 265.

For both options, only the columns that are shown in the pane can be selected for 
inclusion in the report. Hidden data columns cannot be selected. See “To show/
hide columns in a tab pane” on page 37.
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3. On the Geneticist Assistant main menu, click Reports > Custom Report.

The Custom Report dialog box opens. All the data that is to be included in the report is 
displayed in the Sections and Tables pane of the dialog box. See Figure 11-3 on page 
320.

Figure 11-3:  Custom Report dialog box

4. Optionally, if data has been selected in error for the custom report, or you want to 
remove some selected data before you generate the report, right-click the entry in the 
Sections and Tables pane, and on the context menu that opens, click Remove Selected 
Row.

5. Select the report type.

     

If you previously generated a custom report, and you did not click Clear All before 
you clicked Cancel, or closed the report dialog box, then any new information that 
you select on any tab for inclusion in a custom report is simply appended to this 
existing report. 

Four formats are available—PDF (the default value), HTML, XML, or CSV, which 
is a comma-separated values file.
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6. Do any or all of the following as needed:

7. Click Clear All.

8. Click Close to close the Report dialog box.

Table 11-3: Custom report options 

Option Description

Click Preview To preview the report in the Preview pane on the Report dialog box before you 
print it and/or save it. After you click Preview, two new options become available:

• Close Preview—Close the Preview and leave a blank Report dialog box 
open.

• Refresh—Refresh the preview in real time.

Click Save As To save the report. You must specify the name of the report and the location for 
the saved report.

Click Print To print the report.

Save to 
Database

To save the report to the Geneticist Assistant database. When you select this 
option, a Report Name dialog box opens. Regardless of the options that were 
selected, the report name is always given the same default name, 
Custom_Report.

Figure 11-4:  Report Name dialog box

1. Rename the report.

2. Click OK.

Note: You should rename the report, even though you are not required to do so. 
Each custom report is saved at its own entry with a unique date and 
timestamp in the Geneticist Assistant database; however, if you do not 
change the report name, then each entry is also displayed with the same 
name in the appropriate Reports pane and therefore, one entry is not 
distinguishable from another.

This ensures that information that is selected for a new custom report is not simply 
appended to an existing report.
Geneticist Assistant User’s Manual 321



Chapter 11
Geneticist Assistant Reports
Designing a Custom Report Template
A custom report template specifies not only the data that Batch PDF or PDF reports are to 
contain, but also the layout of the reports. The Report Designer provides a user-friendly 
interface for building and saving a robust custom report template.You can then select this 
template to generate the corresponding Batch PDF reports or PDF reports for specific data in 
your Geneticist Assistant database.

The Report Designer user interface
To open the Report Designer, on the Geneticist Assistant main menu, select Reports > Report 
Designer. When the Report Designer first opens, all panes other than the Data Sources pane 
and Formatting pane are blank. Panes are populated only after you begin creating a new 
custom report template or you select and load an existing custom report template. See Table 
11-1 on page 323 for a detailed description of the Report Designer user interface.

Figure 11-5:  Report Designer User Interface

The topics referenced in this section provide only a high-level overview of the 
Report Designer user interface and building a custom report template. For a 
detailed discussion of the Report Designer user interface, including an example of 
using the designer to build a custom report template, see the following video: 
https://www.youtube.com/watch?v=03frFV9tJ54.
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5

Table 11-1: Report Designer user interface components

# Description

1 Title bar. When a report template is open, the title bar displays the full directory path to the 
report, including the report name.

2 Main menu. 

3 Ribbon Bars. The Ribbon Bars contain many options that are similar to the options that are 
available in multiple third party programs such as Microsoft Word or PowerPoint. Hold your 
mouse pointer over an option on a Ribbon Bar to open a tooltip that explains the function/
purpose of the option.

4 Report Component toolbar. Hold your mouse pointer over an icon on the toolbar to open a 
tooltip that explains the function/purpose of the icon.

5 Formatting pane. The pane is divided into two sub-panes. 

• The Report Formatting (top) sub-pane displays the fields that are found in the custom 
report template, with the fields organized by the report component (Page Header, Master 
Data Band, and so on). 

• The Report Field Formatting (bottom) sub-pane displays the name and the current 
formatting characteristics such as height, horizontal alignment, and so on for a field that 
is selected in the Report Formatting sub-pane and the Work Area. To change the name 
and/or formatting for a field, double-click in a value field to select the current value, and 
then edit the value accordingly. 

6 Work Area. You build the custom report template in the Work Area. See “Custom report 
template layout” on page 324.

7 Data Sources pane. The Data Sources pane has two views: the Add Table view and the 
Save/Load view. To open the Add Table view, click Add Table. To open the Save/Load view, 
click Save/Load. 

• In the Add Table view, the top half of the Data Sources pane displays all the data sources 
(fields) that are stored in the Geneticist Assistant database that you can include in a 
custom report template. The data sources are organized by data type (tabs), with each 
data source further organized based on the data level for the data source (sub-tabs).

Note: Currently, only a single data type (Sample) is available in the Report Designer, with 
four associated data levels: Sample, Patient, Run, and Variant.

The bottom half of the Data Sources pane is used to stage table elements when you are 
adding the Master Data table component and its required fields in a single step. See Step 
3 of “To add database fields to a report band” on page 326.

• In the Save/Load view, the following information is displayed:

• All the saved custom report templates that you have saved or that other users have 
saved as and made available to all users are displayed in the Report Templates pane. 

• All the custom report bands that you have saved as templates or that other users have 
saved as templates and made available to all users are displayed in the Band 
Templates pane. You can select any of these report band templates as needed when 
you are building a custom report template.

• All the custom report text fields that you have saved as templates or that other users 
have saved as templates and made available to all users are displayed in the Saved 
Text pane. You can select any of these saved text templates as needed when you are 
building a custom report template.

Note: If you click Close in the Data Sources pane to close the pane, then you can click the 

Data Source icon  to restore the pane. 
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Custom report template layout
A custom report template is built around a single table that is referred to as the Master Data 
component. A Master Data component is comprised of three sub-components, or bands, 
which from top to bottom are a Master Header, a Master band, and optionally, a Master 
Footer. 

• The Master Header contains the column headers for the data that is found in the Master 
band. When you preview or print the report, if the Master Data component spans several 
pages, then the Master Header is displayed above the Master band on every report page. 

• The Master band is the table body component. It contains the table rows that contain the 
report data. The Master band can span one or more pages. 

• The Master Footer contains user-defined information. When you preview or print the 
report, if the Master Data component spans several pages, then the Master Footer is 
displayed below the Master band on every report page.

Other optional components, or bands, of a custom report template include the following: 
Report Title, Page Header, Data Grouping Header, Data Grouping Footer, Page Footer, and 
Report Summary. One band of each type is allowed per page of a custom report template.

Figure 11-6:  Custom report template in the Work Area of the Report Designer
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After you add the bands for a custom report template, you then specify the fields that are to 
be included in each band. You can leave a field label as-is, which is the name of the field in 
the Geneticist Assistant database, or you can rename the field. You can also add one or more 
images to a band, and you can save any part of a report (the text in a band or a band itself) as 
a template, or you can save the entire report as a template. See any of the following for a  
high-level description of building a custom report template:

• “To add bands for a custom report template” below.

• “To add database fields to a report band” on page 326.

• “To add read-only text to a report band” on page 327.

• “To add an image to a report band” on page 328.

• “To save a custom report template” on page 329.

• “To save a custom report template as an XML file” on page 331.

To add bands for a custom report template

You can add all the required bands for a report template, and then add the required fields and/
or images to each band, or you can add one band at a time and then the fields and/or images 
for the band. When you are building a custom report template, you can add one type of each 
band to a report page. When you add a band, the bands are added in a pre-defined order, and 
you cannot change this order. See Figure 11-6 on page 324.

1. If you have not done so already, on the Geneticist Assistant main menu, select Reports > 
Report Designer to open the Report Designer.

When the Report Designer opens, it is blank. The Work Area displays the first page 
(Page 1) for the report.

2. For each band that is to be added to the report template, do the following: On the Report 

Component toolbar, click the Insert Band icon , and then on the Band menu that 

opens, click the appropriate band type, for example, Report Title.

The band is added to Page 1 of the report in the Work Area.

     

The topics referenced above provide only a high-level overview of the Report 
Designer user interface and building a custom report template. For a detailed 
discussion of the Report Designer user interface, including an example of using 
the designer to build a custom report template, see the following video: 
https://www.youtube.com/watch?v=03frFV9tJ54.

If you are adding the Master Data components (Master Header and Master band), 
you can add the bands and all the required fields in a single step. See Step 3 of “To 
add database fields to a report band” on page 326.)
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To add database fields to a report band

The Data Sources pane displays all the data sources (fields) that are stored in the Geneticist 
Assistant database that you can include in a custom report template. The data sources are 
organized by data type (tabs), with each data source further organized based on the data level 
for the data source (sub-tabs).

1. In the Data Sources pane, make sure that Custom DS is selected.

2. Make sure that the Add Table view is open for the Data Source pane. 

3. Open a sub-tab, and then drag a data source (field) from the Data Sources pane to a 
report band. 

After you add a field to a report band, the field is automatically selected in the band and 
the field formatting properties are displayed in the Formatting pane. You can  
double-click the selected field to open the Field editor dialog box and edit the field, 
including changing its field name (by default, a field name is set to the its database 
name), and/or you can edit its formatting properties in the Formatting pane. See Figure 
11-7 below.

Figure 11-7:  Adding and editing a field in a report band

Currently, only a single data type (Sample) is available in the Report Designer, 
with four associated data levels: Sample, Patient, Run, and Variant.

If you are adding the Master Data table components (Master Header and Master 
band), then instead of adding the individual bands and then the fields to the bands, 
you can add the bands and their required fields in a single step. To do so, drag the 
required data sources from the top half of the Data Sources pane to the Drag/Drop 
Table elements here pane, or simply double-click the data source. After you have 
selected all the required table elements, click Insert Table. The Master Header 
band and the Master band are added to the open report page. The selected fields 
are set as the headers in the Master Header band and they are displayed as 
placeholders for the report data in the Master band. See Figure 11-8 on page 327.
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Figure 11-8:  Adding Master Data (bands and fields) in a single step

To add read-only text to a report band

In addition to the database fields, you can add read-only text to a report band. You might 
want to add read-only text to a band, for example, for section headings or data labels.

1. Make sure that the required band has been added to the report template. (See “To add 
bands for a custom report template” on page 325.)

2. On the Report Component toolbar. click the Add Field icon .

The phrase “New Label” is displayed in the Report Designer, typically just below the 
icon. (The location of this phrase depends on how you have the Report Designer UI 
sized in your client window.)

3. Move your cursor to the required location in the appropriate report band, and then click 
to place the field in this location. 

The new text field is automatically selected in the band, and it is labeled “New Label.” 
The field formatting properties are displayed in the Formatting pane. 

Figure 11-9:  New free text field in a custom PDF report band

The mouse pointer might change to a set of cross-hairs and/or double-headed 
arrow as you move it to different locations in the band.
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4. Double-click the selected field.

The Field editor dialog box opens. 

5. Edit the field as needed, including entering the content for the field in place of “New 
Label,” and then click OK.

The Field editor dialog box closes and the edits are applied to the field.

To add an image to a report band

In addition to database fields and free text fields, you can add images in a PNG (.png) format 
to a custom PDF report band. 

1. Make sure that the required band has been added to the report template. (See “To add 
bands for a custom report template” on page 325.)

2. On the Report Component toolbar. click the Add Picture icon .

A placeholder image is displayed in the Report Designer, typically just below the icon. 
(The location of this image depends on how you have the Report Designer UI sized in 
your client window.)

3. Move your cursor to the required location in the appropriate report band, and then click 
to place the placeholder image in this location. 

The placeholder image is automatically selected in the band and its formatting properties 
are displayed in the Formatting pane.

Figure 11-10:  New image in a custom PDF report band

You can also edit the formatting properties for the field in the Formatting pane.

Only a PNG format is allowed. 

The mouse pointer might change to a set of cross-hairs and/or double-headed 
arrow as you move it to different locations in the band.
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4. Double-click the placeholder image. 

The Field editor dialog box opens. The placeholder image is displayed in the field.

5. On the Edit field dialog box main menu, click the Open Image icon .

6. In the Open dialog box, browse to and select the appropriate image, and then click Open.

The Open dialog box closes and you return to the Field editor dialog box. The selected 
image is displayed in the dialog box.

7. In the Field editor dialog box, click OK.

The Field editor dialog box closes and the selected image replaces the placeholder image 
in the report band. You can now click and drag the image to a new location in the report 
band and you can also resize the image.

To save a custom report template

In addition to saving an entire custom report as a template, you can save custom text fields 
and/or you can save an entire band as a template while you are building the custom report 
template. If you save a custom text field or a band as a template, then you can select this text 
or band as needed whenever you are building any other custom report template. 

To save a custom text field

1. Make sure that the Save/Load view is open for the Data Source pane.

2. Click Add Saved Text.

The Save Text dialog box opens.

Figure 11-11:  Save Text dialog box

3. In the Name field, enter an identifying name for the saved text. For example, if all your 
Patient reports are to have a standard disclaimer included, then you might title this text 
as “Standard Patient Report Disclaimer.”

4. In the Text field, enter the appropriate text.

You can also edit the formatting properties for the image, including its position, in 
the Formatting pane.
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5. If you are the only user who is to have access to this saved text when building a custom 
report template, then leave All Users blank; otherwise, select All Users. 

6. Click Save.

The Save Text dialog box closes. The Saved Text template is displayed by its name in the 
Saved Texts pane. Now, to add this text at any time to any band in a custom report 
template, you can select the saved text template (by name) and drag it to a report band. 
The field is automatically selected after you drag it to the band. You can double-click the 
selected field to open the Field editor dialog box and edit the saved text needed, and/or 
edit its formatting properties in the Formatting pane.

To save a band as a template

1. Make sure that the Save/Load view is open for the Data Source pane.

2. Add the appropriate band to the report template and format it as needed, including its 
size, color, the text that it contains and so on. See “To add bands for a custom report 
template” on page 325.

3. Right-click anywhere on the band, and on the context menu that opens, select Save 
Band.

The Save Band dialog box opens. The Band Type is automatically selected, and you 
cannot change this value.

Figure 11-12:  Save Band dialog box

4. In the Name field, enter an identifying name for the saved band. For example, if all your 
Patient reports are to have a standard header, then you might title this text as “Standard 
Patient Report Header.”

5. If you are the only user who is to have access to this saved band when building a custom 
report, then leave All Users blank; otherwise, select All Users. 

6. Click Save.

The Save Band dialog box closes. The Saved Band template is displayed by its name in 
the Band Templates pane. Now, to add this band at any time a custom report template, 
you can select the saved band template (by name) and drag it to a report page in the 
Work Area. The band is automatically selected after you drag it to the band. You can also 
edit its formatting properties in the Formatting pane.
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To save a custom report as a template

1. After building the necessary custom report template, make sure that the Save/Load view 
is open for the Data Source pane.

2. Click Save Report Template.

The Save Report Template dialog box opens. See Figure 11-13 on page 331.

Figure 11-13:  Save Report Template dialog box

3. In the Name field, enter an identifying name for the saved report template. For example, 
if your organization uses a “standard” Patient report for certain types of patient data, then 
you might title this text as “Standard Patient Report.”

4. If you are the only user who is to have access to this saved template when building a 
custom report, then leave All Users blank; otherwise, select All Users. 

5. Click Save.

The Save Report Template dialog box closes. The Saved report template is displayed by 
its name in the Report Templates pane. 

To save a custom report template as an XML file

When you save a custom report template during a Geneticist Assistant instance, the report 
template is available only to that instance. Also, the report is available only to you, or all 
users if you designate it as such. If you want to make a custom report template available to 
other instances of Geneticist Assistant and/or only specific users, then you can save the 
report template as an XML file, and then share this XML file as needed. Other users can then 
build their own custom report templates based on this XML file.

1. Build the necessary custom report template.

2. On the Report Designer main menu, click File > Save as, and then save the custom report 
template as an XML file with a name and location of your choosing,

The Type is set to Sample, and you cannot change this value. 

After you save the report template is saved, you can quickly generate the 
corresponding report in PDF format for all samples in a selected run or runs, or 
selected samples in a selected run. See “Batch PDF Reports” on page 184 
or“PDF Reports” on page 212. 
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You can now make the name and location of this XML file available to other users. When 
these users open Report Designer in their instances of Geneticist Assistant, then on the 
Report Designer main menu, they can click File >Open Report to browse to and select this 
XML file. The XML file is then loaded in to the Report Designer and can be saved as-is for a 
custom report template, or modified as needed, and then saved as a custom report template.
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Geneticist Assistant contains several tools for working with and analyzing your sample data, 
including a tool for building a BED file, a tool for converting a VCF file to a BED file, a tool 
for managing pathogenicity changes, a tool for specifying pathogenicities for specific 
variants in a panel, a tool for finding samples in your Geneticist Assistant that contain 
specific variants, and a tool for combining BAM files into a single sample.

This chapter covers the following topics:

• “Building a BED File with the BED File Builder Tool” on page 335.

• “Convert VCF File to a BED File Tool” on page 339.

• “Deleting Pathogenicity Changes with the Delete Pathogenicity Changes Tool” on page 
341.

• “Importing Variants with the Import Variants Tool” on page 343.

• “Find Samples with Variants Tool” on page 346.

• “Merging BAM Files with the Merge BAM Files Tool” on page 348.
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Building a BED File with the BED File Builder 
Tool

You use BED files to create panels for Geneticist Assistant. A BED file defines the genomic 
regions that are targeted for your particular study or test, which are referred to as panel 
regions. If do not have a BED file for a panel, you can use the BED File Builder tool to build 
one based on the information that you specify. 

To build a BED file with the BED File Builder tool
1. On the Geneticist Assistant main menu, click Tools > Build BED file.

The BED File Builder dialog box opens.

Figure 12-1:  BED File Builder dialog box

2. Do one of the following:

• To manually specify the gene name, in the Gene Name field, enter the name for the 
gene that is in the panel, and then click Add Gene. Repeat this step for each gene that 
is in the panel.

As you enter the gene name, a list of all genes in the database that meet the search 
criteria is dynamically updated. You can select the gene from this list. The search 
is not case-sensitive, but the search string must begin with the gene name. For 
example, a search string of “as” returns ASH1L-AS1 but a search string of “as1” 
does not.
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• To load the gene names from a file, click the Browse button  to open the Select a 
gene file dialog box, browse to and select the correct file, and then click Load Genes.

The following information is displayed for all the different transcripts that are available 
for the gene in the top pane of the dialog box—Region Name, Chromosome, Region 
Start position, Region End position, and Region Length.

3. Select the mode, which determines the information that is available for creating the BED 
file.

4. Do one of the following:

• For Exon mode and All Exon mode—Select the appropriate transcript, or click the 
Expand icon  next to the transcript, and then select the coding region and/or 
untranslated regions for building the BED file.

Figure 12-2:  BED File Builder tool, Exon mode

• For Transcript mode—Select the appropriate transcript.

     

The file must be a text file with one line per gene. Optionally, you can specify a 
transcript for each gene, with a tab between the gene name and the transcript.

Mode Description

Exon The default mode. You can include only the coding regions in the BED 
file, only the untranslated regions, or both. Introns are not included in 
Exon mode.

Transcript mode Adds the full transcript, including introns, to the BED file.

All Exon Mode Includes all the specified exons from all the selected transcripts in the 
BED file. You can include only the coding regions in the BED file, only 
the untranslated regions, or both. Introns are not included in Exon 
mode.

Select an entire 
transcript, or click the 
Expand icon.

Specify the coding 
region and/or 
untranslated regions. 
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5. Optionally, do any or all of the following as needed:

Option Steps

To open the Preview pane and view 
a preview of the BED file

Click Preview. The information for each region 
(Chromosome, Region Start, Region End, Region Name, 
Score, and Strand) is displayed in the preview.

Note: For detailed information about the fields that are 
displayed in the preview, see https://
genome.ucsc.edu/FAQ/FAQformat.html#format1. 

You can leave the Preview pane open, or you can close it 
after viewing the BED file. If you leave the pane open, and 
then make any changes to any of the BED file settings, you 
must click Refresh to update the preview.

To adjust the region start and end 
positions

Enter a different Region Start and/or Region End value (the 
default value is zero). For example, to include 20 bases at 
the end of each exon, enter 20 for both the Region Start 
value and the Region End value

To apply the current settings (the 
selected mode and the Start/End 
Region values) to all genes, 
including any previously added 
genes

1. Click Apply Settings to All. 

An Overwrite warning message opens, indicating that all 
your gene-specific settings will be lost and asking you if 
you want to continue.

Figure 12-3:  Overwrite warning message

2. Click Yes to close the message and overwrite all the 
current gene-specific settings with the current gene 
settings.

To immediately use the BED file as a 
panel

1. Click Import as Panel.

The Panel Name dialog box opens.

Figure 12-4:  Panel Name dialog box

2. Enter the name for the panel, and then click OK.

The Panel Name dialog box closes, and the Manage 
Panels dialog box opens. The full directory path to the 
imported panel, including the panel name, is displayed in 
the Import from Panel File field.

3. Continue to “Importing a Panel” on page 101.
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6. Click OK.

The Save As dialog box opens. By default, the BED file is named default.bed.

7. Edit the name of the BED file as needed, and save it in a location of your choosing.
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Convert VCF File to a BED File Tool
If you do not have a needed BED file for a panel, you can use the Convert VCF to BED tool 
to convert a sample VCF file to the required BED file. The BED file contains the appropriate 
regions for the variants that are found in the VCF file.

To convert a VCF file to a BED file
1. On the Geneticist Assistant main menu, click Tools > Convert VCF File to BED File.

The Convert VCF to BED dialog box opens.

Figure 12-5:  Convert VCF to BED dialog box

2. Next to the Source field, click the Browse button  to open the Open dialog box, and 
then browse to and select the appropriate VCF file.

3. Indicate how the regions are to created in the BED file.

4. Click OK.

The Save as dialog box opens.

     

Option Description

Gene Adds the entire region for the gene in which each variant is found to the 
BED file. For example, if the variant is found in the BRCA1 gene, then 
the entire BRCA1 region is added to the BED file.

Exons Coding Adds the coding exon for each variant in the VCF file as a region in the 
BED file.

Exons All Adds both the coding exons and the non-coding exons for each variant 
in the VCF file as a region in the BED file.

Region Creates a region for each variant found in the VCF file, based on the 
variant’s position. If you select Region, then you must also specify the 
total number of bps that are to be found in each region (the Group by 
Bases value) with one half of the total number of bps found on each side 
of the variant position. For example, if you specify 10,000 for Group by 
Bases, then 5000 bps are found on either side of the variant position for 
the BED file region.
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5. In the Save as dialog box, enter a name and select a location in which to save the BED 
file, and then click Save.

A Convert VCF to BED file conversion message opens, indicating that the conversion is 
completed.

Figure 12-6:  Convert VCF to BED message

6. Click OK.

The message closes. The Convert VCF to BED dialog box remains open.

7. Click “x” to close the Convert VCF to BED tool.

The default name for the BED file is default.BED and the default location in which 
to save the BED file is the same directory as the source VCF file, but you can 
change one or both of these values. The file type is .bed and you cannot change 
this.
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Deleting Pathogenicity Changes with the Delete 
Pathogenicity Changes Tool

Sometimes, you might determine that a pathogenicity change or changes might not be valid. 
You use the Delete Pathogenicity Changes tool to delete all the historical pathogenicity 
changes for all variants that were made during a certain time period. After you delete a 
historical pathogenicity change for a variant, the pathogenicity of the variant might be reset. 
For example, if the pathogenicity of a variant was changed from Unknown to Likely 
Deleterious on January 13, 2013, and you delete all the historical pathogenicity changes that 
were made from January 1, 2013 to January 31, 2013, then the pathogenicity of the variant is 
reset to Unassigned. If you changed the pathogenicity of the same variant from Likely 
Deleterious to Deleterious on February 1, 2013, and you delete all the historical 
pathogenicity changes that were made from January 1, 2013 to January 31, 2013, then the 
pathogenicity change from Unassigned to Likely Deleterious is deleted for the variant, but 
the pathogenicity of the variant remains Deleterious.

To delete historical pathogenicity changes with the Delete 
Pathogenicity Changes tool

1. On the Geneticist Assistant main menu, click Tools > Delete Pathogenicity Changes.

The Delete Pathogenicity Changes dialog box opens.

Figure 12-7:  Delete Pathogenicity Changes dialog box

2. Change the From value, the To value, or both values as needed. To change the value, 
select the value that is to be changed, for example, the month, and then you can manually 
enter the new value, or you can use the Up/Down field arrows to change the value. 

     

You must select each value that is to be changed one at a time. If you need to 
confirm the time period, remember that the Pathogenicity Changes pane on the 
Variant tab displays the date and time that a pathogenicity change was made. See 
“Pathogenicity Changes pane” on page 299.
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3. Click OK.

A Confirm Deleting Pathogenicity Changes message opens, asking you if you are sure 
that you want to delete “x” number of pathogenicity changes within the date range.

Figure 12-8:  Confirm Deleting Pathogenicity Changes message

4. Click Yes.

All the historical pathogenicity changes that were made during the specified time period 
are deleted from the Geneticist Assistant database. If applicable, the pathogenicities for 
some variants are reset. 
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Importing Variants with the Import Variants Tool
You can use the Import Variant tool to import all the variants that are contained in a VCF file 
into your Geneticist Assistant database. If the VCF file contains the pathogenicity and 
pathogenicity status for the variants and/or comments for the variants, then you can also 
import this information. If the VCF file’s INFO fields do not contain this information, then 
you can still use the tool to import the variants that are contained in the file, but then you can 
manually set the pathogenicity and/or pathogenicity status for the variants, as well as add a 
comment for the variants. For either situation, this means that if multiple variants have the 
same pathogenicity for a panel group, you do not have to set the pathogenicity of each 
variant individually. Instead, you can set the same pathogenicity for all the variants at once 
using this tool.

To import variants with the Import Variants tool
1. On the Geneticist Assistant main menu, click Tools > Import Variants.

The Import Variants dialog box opens.

Figure 12-9:  Import Variants dialog box

2. Next to the Sample File field, click the Browse button  to open the Select a Variant 
File dialog box, and then browse to and select the appropriate VCF file.

3. On the Reference dropdown list, select the appropriate reference.

4. On the Panel dropdown list, select the panel for which you are settings the variants’ 
pathogenicity.

The Panel group name is displayed for Panel Group. 
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5. Continue to one of the following:

• “To automatically set the variants’ pathogenicities and statuses from the VCF file” 
below.

• “To manually set the variants’ pathogenicity and status” below.

To automatically set the variants’ pathogenicities and statuses 
from the VCF file

1. Leave Import from VCF’s INFO fields selected.

2. Do either or both of the following as needed:

• If the VCF file contains the pathogenicity and pathogenicity status for each variant, 
then to import this information, leave the Pathogenicity and Pathogenicity Status 
option selected. Otherwise, if the VCF file does not contain this information, or you 
do not want to import this information, then clear this option.

• If the VCF file contains comments for the variants, then to import this information, 
leave the Variant Comment option selected. Otherwise, if the VCF file does not 
contain this information, or you do not want to import this information, then clear 
this option.

3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants will now be displayed with the imported information (such as 
the pathogenicity) in any samples that contain these variants.

To manually set the variants’ pathogenicity and status

When you manually set the pathogenicity and status for the variants in the VCF file, then the 
pathogenicity and status are set to the same values for all the variants in the file. If you add a 
comment, then the same comment is added for all the variants.

1. Select the Select Manually option.

The Import Variants dialog box is updated with options for setting the pathogenicity and 
the pathogenicity status for the variants as well entering a common comment for the 
variants. See Figure 12-10 on page 345.
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Figure 12-10:  Import Variants dialog box, Select manually option

2. Do any or all of the following as needed:

• On the Pathogenicity dropdown list, select the pathogenicity for the variants.

• On the Pathogenicity Status dropdown list, select the pathogenicity status for the 
variants.

• In the Pathogenicity Comment field, enter a common comment for all the variants.

3. Click OK.

The Import Variants dialog box closes. A Current Jobs tab opens that shows the progress 
of importing the VCF file. The tab remains open after the import is complete. The 
variants with the selected information are now imported into the Geneticist Assistant 
database. These variants will now be displayed with the specified information (such as 
the pathogenicity) in any samples that contain these variants.

Remember, you have the option of specifying custom pathogenicity types. Also, by 
default, only two statuses are available—Pending or Confirmed. You have the 
option of adding custom pathogenicity statuses. See “Managing Objects in the 
Geneticist Assistant” on page 51.
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Find Samples with Variants Tool
You can use the Find Samples with Variants tool to find all the samples in your Geneticist 
Assistant database that contain specific variants. You can search for the variants based on the 
Variant database ID (which is displayed in the ID column in the various Variant tables in 
Geneticist Assistant), the variant rs identification from dbSNP (which is displayed in the rs 
column of the various Variant tables in Geneticist Assistant), or the variant description. 

To find samples with specific variants with the Find Samples with 
Variants tool

1. On the Geneticist Assistant main menu, click Tools > Find Samples with Variants.

The Find Samples with Variants dialog box opens.

Figure 12-11:  Import Variants dialog box

2. Indicate how to search for the variants: based on the Variant database ID (which is 
displayed in the ID column in the various Variant tables in Geneticist Assistant), the 
variant rs identification from dbSNP (which is displayed in the rs column of the various 
Variant tables in Geneticist Assistant), or the variant description.

3. Click OK.

A list of all the samples that contain the specified variants is displayed on a Samples with 
Variants tab. See Figure 12-12 on page 347.

When searching for multiple variants, you must separate the variant search 
criteria by a comma or a semi-colon, or place each search criterion on its own 
line.
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Figure 12-12:  Samples with Variants tab

The context menu for this tab is identical to the context menu for the Samples pane 
on the Run tab. See “The Samples Pane (Run tab) Context Menu” on page 207.
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Merging BAM Files with the Merge BAM Files 
Tool

If you have multiple BAM files for a sample, you do not need to submit each file as an 
individual sample, and then assign each file to the same patient. Instead, you can use the 
Merge BAM Files tool to merge all the BAM files into one file and then submit the file as a 
single sample.

To merge BAM files
1. On the Geneticist Assistant main menu, click Tools > Merge BAM Files.

The Merge BAM Files dialog box opens.

Figure 12-13:  Merge BAM Files dialog box

2. At the top of the dialog box, click the Browse button  to open the Select a file to add 

dialog box, and browse to and select the BAM files that are to be merged.

3. Next to the Save As field, click the Browse button  to open the Select file to save 

dialog box, and do the following:

• In the File name, enter the name for the merged BAM file. (The extension is .bam 
and you cannot change this.

• Browse to and select the directory in which to save the merged BAM files. 

CTRL-click to select the multiple BAM files.
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4. Click Save.

The Select file to save dialog box closes, and you return to the Merge BAM files dialog 
box.

5. Click Merge.

The message “Merging files now” is displayed at the top of the Merge BAM files dialog 
box. After the BAM files are successfully merged, the message “Merge complete” is 
displayed at the top of the Merge BAM files dialog box.

6. Click Close (x) to close the Merge BAM Files dialog box and return to the Geneticist 
Assistant main window.

Be patient during the merging of the BAM files. Depending on the number of files 
selected and the sizes of the files, merging might take several minutes.
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Portal and Submissions

The Geneticist Assistant customer portal is a web-based platform that serves as a dedicated 
hub for tracking and managing your organization’s patient and sample information and the 
tests that have been carried out for each patient/sample combination (referred to as a 
submission). You designate specific users, known as web users, to have login and read/write 
permissions to this platform. These web users can enter your organization’s patient and 
sample information without ever having to log in to an instance of Geneticist Assistant. The 
patient and sample information is directly linked between the Geneticist Assistant database 
and the customer portal. Any patient that is in the Geneticist Assistant database is 
automatically available for selection in the portal, and if a new patient must be created to 
submit information, then this patient is automatically added to the Geneticist Assistant 
database. A barcode is generated for each submitted patient/sample combination, and you 
can use this barcode to validate that the correct patient and sample combination was 
submitted to the customer portal and to confirm sample identity when you are reviewing a 
sample in Geneticist Assistant. A full record of every submission that any user has ever made 
through your organization’s secure access point to the Geneticist Assistant customer portal is 
displayed on the Submissions tab.

This chapter covers the following topics:

• “Logging in to the Geneticist Assistant Customer Portal” on page 353.

• “The Geneticist Assistant Customer Portal Layout” on page 356.

• “Submitting Patient/Sample Tracking Information through the Geneticist Assistant 
Customer Portal” on page 358.

• “The Submissions Tab” on page 361.
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Logging in to the Geneticist Assistant Customer 
Portal

To log in and use the customer portal, two files are required: 

• Cert.pem file, which you must save in C:\Program Files\SoftGenetics\SoftGenetics 
Server\ga on the Geneticist Assistant server.

• Cert.pfx, which you can save anywhere on the Geneticist Assistant client. You must 
double-click this file to launch the Certificate Import Wizard and import the encryption 
key for your Geneticist Assistant installation.

By default, your Geneticist Assistant Administrator account (the Administrator role that you 
were prompted to create for the installation of Geneticist Assistant) is designated as a user of 
the customer portal. The username and password for logging in to the customer portal are 
identical to the username and password that were specified for the Administrator role. All 
other users of the customer portal must be specified as web users. (See “Managing Web 
Users” on page 94.)

Figure 13-1:  Geneticist Assistant Login dialog box with credentials for the Geneticist 
Assistant customer portal

The login URL for the Geneticist Assistant customer portal is set to the following:

https://<server name>/samplesub

where <server_name> is the name of your Geneticist Assistant server, for example, 
localhost.

     

If your organization already uses encryption for patient data, then these files 
should already be configured and available for use; otherwise, work with your 
organization’s System Administrator to create and configure these files, or you can 
contact.tech_support@softgenetics.com for assistance.

Server name

Administrator role user name

Administrator role password
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To log in to the Geneticist Assistant customer portal
1. Open a browser of your choice.

2. In the URL field, enter the login URL for your Geneticist Assistant customer portal.

The Customer Portal Login page opens.

Figure 13-2:  Customer Portal Login page

3. Enter your username and password, and then click Submit.

The Customer Portal opens. The Patients and Samples page is the open page. All the 
patients that are currently saved in your Geneticist Assistant database are listed in the 
Patients pane on the left side of the page. Any patient/sample combination that has been 
submitted to the customer portal is displayed in the Samples pane on the right side of the 
page. See Figure 13-3 on page 355.

The login URL for the Geneticist Assistant customer portal is set to the following: 
https://<server name>/samplesub, where <server_name> is the name of your 
Geneticist Assistant server, for example, localhost.

By default, your Geneticist Assistant Administrator account (the Administrator 
role that you were prompted to create for the installation of Geneticist Assistant) is 
designated as a user of the customer portal. The username and password for 
logging in to the customer portal are identical to the username and password that 
were specified for the Administrator role. If you are not the Administrator, then 
you must be specified as a web user. (See “Managing Web Users” on page 94.)
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Figure 13-3:  Geneticist Assistant Customer portal, Patients and Samples page

4. Continue to “The Geneticist Assistant Customer Portal Layout” on page 356.
Geneticist Assistant User’s Manual 355



Chapter 13
The Geneticist Assistant Customer Portal and Submissions
The Geneticist Assistant Customer Portal 
Layout

Figure 13-4:  Geneticist Assistant customer portal, Patients and Samples page

The customer portal main menu is displayed at the top of every customer portal page. The 
main menu has the following options:

Main Menu Option Description

Patients Opens the Patients and Samples page. This is the page that opens after 
you log in to the Geneticist Assistant customer portal. All the patients 
that are currently saved in your Geneticist Assistant database are listed 
in the Patients pane on the left side of the page. Any patient/sample 
combination that has been submitted to the customer portal for tracking 
purposes is displayed in the Samples pane on the right side of the page. 

Submit Opens the Submit Sample page. This is the page on which you enter 
the information for the patient and sample combination that is to be 
submitted to the Geneticist Assistant customer portal. This page has 
seven distinct sections for entering the information for the patient and 
sample combination that is to be submitted to the Geneticist Assistant 
customer portal. Your organization’s Administrator is responsible for 
customizing the fields that are displayed in these sections, including 
whether a field is enabled or disabled, and whether a field is required or 
optional. See “Admin” on page 357.

Review Opens the Review page, where you can review a patient and sample 
combination and verity that the information that has been entered for it 
is correct before you submit the information to the customer portal. 
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User Opens the User page. You use this page to enter the contact details for 
the providers and institutions that are to be available for inclusion with 
any submission including the ordering provider, the genetic counselor, 
the referring hospital or laboratory, and the institutional billing. Your 
organization’s Administrator is responsible for customizing the fields 
that are displayed in these sections, including whether a field is enabled 
or disabled, and whether a field is required or optional. See “Admin” 
below.

Admin Available only to the default Administrator user for your Geneticist 
Assistant installation. Opens the Admin page where the Administrator of 
your organization's customer portal specifies the fields that are to be 
enabled/disabled on the Submit and User pages, and whether an 
enabled field is to be required or optional. In addition to specifying the 
field rules for the Submit and User pages, an Admin can also customize 
the barcode that is automatically generated for a submission. This 
barcode can be used to validate that the correct patient and sample 
information combination was submitted to the customer portal and to 
confirm sample identity when you are reviewing a sample in Geneticist 
Assistant. “Submitting Patient/Sample Tracking Information through the 
Geneticist Assistant Customer Portal” on page 358.

Note: If you need assistance with customizing your Geneticist Assistant 
customer portal interface, contact tech_support@softgenetics.

Main Menu Option Description
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Submitting Patient/Sample Tracking Information 
through the Geneticist Assistant Customer 
Portal

You must be the Administrator of Geneticist Assistant, or designated as a web user to log in 
and submit information through Geneticist Assistant customer portal. A full record of every 
submission that any user has ever made through organization’s secure access point to the 
Geneticist Assistant customer portal is displayed on the Submissions tab. 

To submit patient/sample tracking information through the 
customer portal

1. Log in to the customer portal.

2. On the Patients and Samples page, click New Patient/Sample, or on the main menu, click 
Submit.

The Submit Sample page opens. The Patient and Specimen section is displayed. The 
Sections pane on the left side of the page lists the seven sections for the page by name in 
which you can enter the patient/sample tracking information. 

Figure 13-5:  Geneticist Assistant customer portal, Submit Sample page, Patient and 
Specimen section

By default, your Geneticist Assistant Administrator account (the Administrator 
role that you were prompted to create for the installation of Geneticist Assistant) is 
designated as a user of the customer portal. The username and password for 
logging in to the customer portal are identical to the username and password that 
were specified for the Administrator role. If you are not the Administrator, then 
you must be specified as a web user. (See “Managing Web Users” on page 94.)
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3. In the Patient and Specimen section, on the Saved Patients dropdown list, do one of the 
following:

• Leave the list set to Add New, and then enter the new patient information.

• Select a patient from your organization’s Geneticist Assistant database.

4. Continue opening each section on the page, and then enter the appropriate information 
for the patient/sample combination.

5. Optionally, after you have entered all the patient/sample tracking information, in the 
Sections pane on the Submit Samples page, click Review to open the Review 
Submission page and review the information and make any necessary changes before 
submitting it.

6. On the Submit Samples page, in the Sections pane, click Submit.

The patient/sample information is submitted to the customer portal. The submission is 
automatically recorded on the Submissions tab in Geneticist Assistant. The Submit 
Sample page remains open. A Submission Successful message is displayed on the page 
along with two options: Download Packing Slip and Download Submission Details. 

Figure 13-6:  Submission Successful message with options

     

Your organization’s Administrator is responsible for customizing the fields that are 
displayed in all the sections on the Submit Sample page, including whether a field 
is enabled or disabled, and whether a field is required or optional.

The patient and sample information is directly linked between the Geneticist 
Assistant database and the customer portal. Any patient that is in the Geneticist 
Assistant database is automatically available for selection on the Saved Patients 
dropdown list. If you add a new patient, then this new patient is automatically 
added to your organization’s Geneticist Assistant database and going forward, is 
available for selection in the portal. 
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7. Optionally, click either one or both options to download the needed information for the 
submission:

• Download a packing slip: Generates a packing slip in PDF format that includes a 
barcode.

If your organization uses barcodes, then you can scan this barcode and validate that 
the correct patient and sample combination was submitted to the customer portal and 
to confirm sample identity when you are reviewing a sample in Geneticist Assistant.

Figure 13-7:  Packing slip with barcode for patient/sample information submitted to the 
Geneticist Assistant customer portal

• Download Submission Details: Generates a full record of the submission in PDF 
format. The information that is displayed on the Submissions Detail form is identical 
to the information that is displayed on the Packing Slip form, but without the 
barcode.

The prompt that opens and the location in which the file is automatically saved is 
dependent on the browser that you are using to access the customer portal.

You can always choose to generate a packing slip with a barcode for this or any 
other submission at a later date. To do so, on the customer portal main menu, click 
Review to open the Review Sample page, select the appropriate patient/sample 
combination, and then click Download Submission Packing Slip.

You can always view the full record of any submission on the Submissions tab in 
Geneticist Assistant. See “The Submissions Tab” on page 361.
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The Submissions Tab
A full record of every submission that any user has ever made through your organization’s 
secure access point to the Geneticist Assistant customer portal is displayed on the 
Submissions tab in Geneticist Assistant. To open the Submissions tab, on the Geneticist 
Assistant main menu, click Tabs > Submissions.

Figure 13-8:  Submissions tab

To open and view all the details for an individual submission, double-click the submission on 
the Submissions tab. Each pane on the Submission tab corresponds to specific information 
that was entered for the submission, for example, Patient, Specimen, and so on. The 
information always includes the barcode for the submission, which you can use to comfirm 
sample identity.

Figure 13-9:  Submission tab
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To use the barcode to confirm sample identity
If a packing slip has been generated for a submission, then two options are available for 
using the barcode to validate that the correct patient/sample combination was submitted to 
the customer portal and to confirm sample identity when you are reviewing a sample in 
Geneticist Assistant:

• On the Submission tab, click Verify Barcode, and then use a barcode scanner to scan the 
barcode on the physical packing slip.

• On the Submission tab, click Verify Barcode, and then enter the barcode number that is 
displayed on the packing slip in the field. If the barcode number that you enter matches 
the barcode number for the submission, then “Match” is displayed in green above the 
Verify Barcode number field.

Figure 13-10:  Verifying submissions using a manually entered barcode number
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A
Action List

A list of items that require some type of follow up. In Geneticist Assistant, an Action List 
can be created for coverage regions on the Coverage Regions tab or for variants on the 
Sample tab.

Administrator user

A user of Geneticist Assistant to whom all available privileges are automatically assigned. 
Both Administrator privileges and Staff status can be assigned to the same Administrator 
user.

All Exon Mode

One of the allowed modes for the BED File Builder tool. Includes all the exons from all the 
selected transcripts in the BED file.

Artifact Type

Indicates that the variant at is not naturally present in the sample, but instead, it is formed by 
artificial means, such as during preparation of the sample; for example, a Sequencing 
artifact. A single default value, None, is supplied for artifact type. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Average Coverage

The average number of aligned reads for a region. This value is reported for all panel regions 
on the Coverage Regions tab and the Coverage Regions sub-tab on the Panel Statistics tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.

B
BED file

A BED file is a tab-delimited text file. A panel can be created from a BED file for use in 
Geneticist Assistant. Each row in the file contains a region of the reference that is to be used 
in Geneticist Assistant. At a minimum, the file contains the following information:

• Field #1 - Chromosome number for the region

• Field #2 - Chromosome start position

• Field #3 - Chromosome end position

• Field #4 - Optional comment column
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C
Case

An entity that is used to group and track related data in your Geneticist Assistant database, 
for example, family data that consists of the affected patient data and both the parents’ data.

Case Priority

The priority of a case (for example, Urgent) that has been assigned to a case in your 
Geneticist Assistant database. Values can be specified through the Add/Edit Object function 
in Geneticist Assistant.

Chemistry

Refers to the chemistry that was used to prepare the samples for sequencing. Values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

ClinVar pane

Found on the Variant tab. Displays the information for a variant from the ClinVar database. 
See http://www.ncbi.nlm.nih.gov/clinvar/intro/.

Coverage Downstream

The number of base pairs after the end of a panel region to which the quality control settings 
must apply. The quality control settings are specified on the Quality Control tab of the 
Settings dialog box.

Coverage Region Status

Indicates whether a panel region passed or failed the coverage settings that were set for the 
run. The status for every region in a panel is displayed on the Coverage Regions tab. Default 
values are Passed or Failed. Additional values can be specified through the Add/Edit Object 
function in Geneticist Assistant.

Coverage Threshold

The minimum required coverage values that a panel region must meet, or it is flagged as 
failed region for a run. Thresholds can be set globally (applies to all panel regions in all runs) 
on the Quality Control tab on the Settings dialog box, or it can set on a per panel basis.

Coverage Upstream

The number of base pairs before the start of a panel region to which the quality control 
settings must apply. The quality control settings are specified on the Quality Control tab of 
the Settings dialog box.

Custom report

Contains only user-specified data. 
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Custom report template

Specifies not only the data that Batch PDF or PDF reports are to contain, but also the layout 
of the reports. You build a custom report template in the Report Designer.

D
dbNSFP pane

Found on the Variant tab. Displays the information from the dbNSFP database for a variant. 
See https://sites.google.com/site/jpopgen/dbNSFP.

dbSNP pane

Found on the Variant tab. Displays the information from the dbSNP database for a variant. 
See http://www.ncbi.nlm.nih.gov/SNP/get_html.cgi?whichHtml=overview.

E
Ethnicity

The ethnicity (for example, Caucasian/Non-Hispanic) for a patient in your Geneticist 
Assistant database. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Exome Aggregation Consortium pane

Found on the Variant tab. Displays the information for the variant from the Exome 
Aggregation Consortium database for selected global sequencing projects. See  
http://exac.broadinstitute.org/.

Exome Variant Server pane

Found on the Variant tab. Displays the information from the Exome Variant Server database 
for the NHLBI GO Exome Sequencing project for a variant. See  
http://evs.gs.washington.edu/EVS/.

Exon Mode

The default mode for the BED File Builder tool. Allows for the inclusion of the coding 
regions in the BED file, the untranslated regions, or both.

G
Gene Direction

A display setting for sample variants’ reference alleles and observed alleles. Display the 
reference alleles and observed alleles based on the gene orientation. Set on the Variant 
Preferences tab for the Settings dialog box.
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Group

Two or more users considered a single unit for the purpose of applying the same permissions 
in a single step.

H
Heterozygosity Lower Bound (%)

The minimum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 20%.

Heterozygosity Upper Bound (%)

The maximum variant frequency for a variant to be considered heterozygous. Set on the 
Variant Preferences tab of the Settings dialog box. The default value is 80%.

I
Instrument

Refers to the instrument that was used to sequence the samples. Values can be specified 
through the Add/Edit Object function in Geneticist Assistant.

L
LOVD Data pane

Found on the Variant tab. Displays the information from the LOVD (Leiden Open Variation 
Database) for the variant. See http://www.lovd.nl/3.0/docs/.

M
Minimum Coverage

The minimum coverage depth for a region. This value is reported for all panel regions on the 
Coverage Regions sub-tab on the Panel Statistics tab and the Coverage Regions tab. A 
minimum value for the status of a region to be classified as “Passed” can be set on the 
Quality Control tab of the Settings dialog box.

O
Object

Holds a value or variable that can be applied for carrying out runs in Geneticist Assistant. 

OMIM Data pane

Found on the Variants tab. Displays the information for the variant from the OMIM (Online 
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Mendelian Inheritance in Man) database. See http://www.omim.org/.

P
Panel

A collection of genomic regions that are targeted for a specific genomic test or study. Panels 
are added to Geneticist Assistant by providing a BED file that defines the targeted regions, 
known as panel regions. Each sample that is submitted in Geneticist Assistant is assigned to 
a specific panel.

Panel Group

Separately tracks the pathogenicities of variants that might be found in multiple panels. For 
example, the pathogenicity of a selected variant might be set to Deleterious for multiple 
cancer panels; however, the pathogenicity can be set to benign for a cardiac panel. You can 
create a group for each panel, and then assign the appropriate panels to each group.

Panel Region

The regions that have been targeted for a specific panel/test as defined by the BED file that 
was used to create the panel. 

Pathogenicity

The pathogenicity for a selected variant, which is the likelihood that the variant will cause a 
disease. Default values are Deleterious, Likely Deleterious, Unknown, Likely Benign, and 
Benign. Additional values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Pathogenicity Status

Indicates the status for changing the pathogenicity for a selected variant; for example, from 
Unknown to Benign. Default values are Pending and Confirmed. Additional values can be 
specified through the Add/Edit Object function in Geneticist Assistant.

Patient

Refers to an individual from whom a sample was taken. Any sample that is submitted to 
Geneticist Assistant can be associated with a patient.

Percent Covered (%)

The percent of a panel region that has reads aligned to it. This value is reported for all panel 
regions on the Coverage Regions sub-tab on the Panel Statistics tab and the Coverage 
Regions tab. A minimum value for the status of a region to be classified as “Passed” can be 
set on the Quality Control tab of the Settings dialog box.

Phenotype

The phenotype for a patient. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.
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Preferred Transcript List

A tab-delimited text file that defines the specific transcript or isoform that is to be used for a 
gene. You can use different transcripts for different panels. The first column in the text file 
contains the gene name. The second column in the text file specifies the transcript by its 
nm_accession number.

R
Read Balance

The balance in forward and reverse oriented reads with the variant as reported in the VCF 
file.

Reference Directory

Contains the information for the reference that was used for aligning data and/or detecting 
variants.

Run

Refers to loading a BAM file and a VCF file or just a VCF file into Geneticist Assistant for 
the purposes of importing a list of variants into the Geneticist Assistant database and/or 
reviewing a list of variants. 

Run Status

The status for a run. Default values are New, QC Passed, Reviewed, and Complete. 
Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant.

S
Sample Group

Two or more samples considered a single unit for the purpose of repeated processing over a 
period of time; for example, a group of control samples for which the coverage or variant 
frequency is to be tracked. Values can be specified through the Add/Edit Object function in 
Geneticist Assistant.

Sample Group Statistics

Various statistics that can be displayed for a sample group. Displayed on the Sample Variant 
Data sub-tab for the Sample tab.

Sample Status

The status for a sample. Default values are New, QC Passed, Reviewed, and Complete. 
Additional values can be specified through the Add/Edit Object function in Geneticist 
Assistant. 
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Staff user

A user who can log into the django web administrator site. The actions that the Staff user can 
carry out depend upon the permissions assigned to him/her. Both Administrator privileges 
and Staff status can be assigned to the same user.

Standard report

A report that includes all the data that is displayed in a selected pane on a data tab, for 
example, the Samples pane on the Run tab. Six different standard reports are available in 
Geneticist Assistant—Run, Coverage Regions, Panel Statistics, Sample, Variant, and Action 
List.

Standard user

A Geneticist Assistant user who has neither Administrator privileges nor Staff status. 

Subpanel

Contains a fixed number of regions that are contained within a selected panel. To verify 
coverage for a smaller number of regions that are within the panel that has been selected for 
a run, you can use a subpanel.

Supporting Information

Reference information and/or links to the appropriate websites that have been submitted to 
support the pathogenicity that is specified for a variant. Displayed in the Supporting 
Information pane on the Variant tab.

T
Trans

A column on the Sample Variant Data sub-tab on the Sample tab. Indicates whether the 
variant is Transition (Ti) or Transversion (Tv).

Transcript mode

One of the allowed modes for the BED File Builder tool. Adds the full transcript, including 
introns, to the BED file.

U
User

A person who logs into Geneticist Assistant either to add and review content, or use 
Geneticist Assistant in a read-only capacity. Three types of users are available in Geneticist 
Assistant—an Administrator user, a Staff user, and a standard user. 
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V
Variant Frequency

The frequency at which a variant is detected in a sample. In Geneticist Assistant, any value 
< 1 is allowed, with 1 = 100%, 0.5 = 50%, and so on.

Variant Preferences

Determines how information about the variants is displayed in all the variant sub-tabs or 
panes in Geneticist Assistant. Set on the Variant Preferences tab for the Settings dialog box.

W
Web user

A person who can log in and submit information to the Geneticist Assistant customer portal. 

Z
Zygosity

Indicates whether the variant is heterozygous or homozygous. In Geneticist Assistant, the 
selected zygosity is based on the Zygosity settings that are specified on the Variant 
Preferences tab of the Settings dialog box.
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